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Preface

This manual, Using the OpenStep Desktop, is a comprehensive introduction to
the Solaris™ OpenStep™ user interface. With the help of this guide, you can
quickly get familiar with the various color, sound, graphics, and text
applications that make up the Solaris OpenStep desktop environment.

Who Should Use This Book
If you are just beginning to use the Solaris OpenStep applications, this manual
is for you. It provides step-by-step instructions for managing your workspace
and using the applications that enable you to perform everyday tasks. If you
are developing or designing OpenStep applications, some familiarity with the
content of this book would help you understand the more in-depth
information in the OpenStep User Interface Guidelines manual.

How This Book Is Organized
This manual contains the following chapters:

Chapter 1, “Starting and Ending a Work Session,” describes the day-to-day
tasks you perform in using OpenStep, such as logging in and out, using the
mouse, choosing commands, and accessing online help.

Chapter 2, “Working With Windows,” discusses how you use windows on the
OpenStep desktop. It tells you how to open, close, reorder, move, miniaturize,
and resize windows, as well as how to scroll to view a window’s contents.
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Chapter 3, “Using the File Viewer,” tells you how to use the File Viewer to
locate and use folders and files. It describes how to browse, find, list, and open
folders and files; and how to stock the File Viewer’s shelf for faster access to
folders and files you use frequently.

Chapter 4, “Working With Applications,” describes how to use applications
from the OpenStep desktop, including how to start an application both
manually and automatically, how to run several applications and switch
among them, and how to customize the application dock with applications you
use frequently.

Chapter 5, “Creating and Saving Files,” tells you how to use OpenStep tools
to create and save files.

Chapter 6, “Organizing Your Work,” discusses various tasks for organizing
your work by creating new folders; and deleting, renaming, moving, and
copying existing folders and files. It also tells you how to link and merge
folders, and how to compress files and folders to save space.

Chapter 7, “Inspecting Files and Folders,” describes how to get information
about a folder or file, as well as how to manage access to folders and files by
assigning them to appropriate groups and changing access permissions.

Chapter 8, “Working With Disks,” tells you how to use floppy disks and
CD-ROMs with OpenStep.

Chapter 9, “Typing and Editing,” describes how you can type and edit in any
OpenStep application to create documents or simply to name files and folders.
It includes instructions for using fonts and special characters. And it tells you
how to format your documents by setting margins, indentation, and tabs.

Chapter 10, “Working With Color,” discusses ways of selecting and using
color in OpenStep, using the color wheel, colors on the screen, and three color
models. It tells you how to create color lists, palettes, and a swatch bar to save
colors for use in your files and applications.

Chapter 11, “Working With Graphics,” tells you how to add graphic images to
your documents.

Chapter 12, “Receiving and Sending Mail,” discusses how to use the
OpenStep Mail application to receive and send electronic messages. It tells you
how to compose messages using text, sound, and graphic images, and how to
attach an existing file or folder to your message.
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Chapter 13, “Managing the Mail Application,” tells you how to manage
mailboxes and messages. It includes instructions for creating a mailbox;
finding, moving, and deleting messages; and tailoring how you receive new
messages and how the system notifies you of new mail.

Chapter 14, “Printing,” describes how to prepare a file for printing, and how
to print a file to a printer or a PostScript™ file.

Chapter 15, “Personalizing the Workspace,” covers how to use the Preferences
application to customize your OpenStep workspace. It includes instructions for
setting your password; setting the date and time; choosing localization options
such as an application language, units of measurement, and paper size for
printing; choosing fonts for the screen and for applications; setting global file
and folder permissions; speeding up the display of large file systems; and
displaying UNIX® system and dot files.

Chapter 16, “Managing Hardware,” covers how to use the Preferences
application to manage your hardware. It includes instructions for setting the
screen save delay on your system; changing the background color of your
display, choosing system beeps and warnings, and changing how your mouse
responds.

Chapter 17, “Using the Terminal Application,” tells you how to use the
Terminal application to run UNIX programs that you cannot run effectively in
the OpenStep workspace.

Appendix A, “Command Reference,” summarizes the menus, commands, and
buttons that are available in each OpenStep application.

Related Books
For a quick overview of the basics of using the OpenStep user interface, refer
to QuickStart to Using the OpenStep Desktop.
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What Typographic Changes Mean
Table P-1 describes the typographic changes used in this book.

Shell Prompts in Command Examples
Table P-2 shows the default system prompt and superuser prompt for the C
shell, Bourne shell, and Korn shell.

Table P-1 Typographic Conventions

Typeface or
Symbol Meaning Example

AaBbCc123 The names of commands,
files, and directories;
on-screen computer output

Edit your .login  file.
Use ls -a  to list all files.
machine_name% You have mail.

AaBbCc123 What you type, contrasted
with on-screen computer
output

machine_name% su
Password:

AaBbCc123 Command-line placeholder:
replace with a real name or
value

To delete a file, type rm filename.

AaBbCc123 Book titles, new words or
terms, or words to be
emphasized

Read Chapter 6 in User’s Guide.
These are called class options.
You must be root to do this.

Table P-2 Shell Prompts

Shell Prompt

C shell prompt machine_name%

C shell superuser prompt machine_name#

Bourne shell and Korn shell
prompt

$

Bourne shell and Korn shell
superuser prompt

#
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The Solaris™ OpenStep™ workspace is a complete environment with color,
sound, graphics, and text to support the most extraordinary tasks—as well as
your day-to-day work.

This chapter describes the tasks you will need to perform to start using
OpenStep, such as the following:

• Logging in and starting the OpenStep desktop
• Using the mouse
• Choosing commands
• Clicking for help
• Getting help by topic
• Ending your work session

Starting and Ending a Work Session 1
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Logging In and Starting the OpenStep Desktop
If your system is running the OpenWindows environment, the OpenStep
desktop starts automatically when you log in unless you or your system
administrator has configured it for manual startup (see the Solaris OpenStep
Installation Guide). If you have chosen to start the OpenStep desktop manually,
you use the openstep  command to start the OpenStep desktop after
OpenWindows is started (see the openstep  man page).

If your system is running the CDE environment, the OpenStep desktop starts
automatically when you select “OpenStep” from the CDE login menu. You can
use the openstep  command to start the OpenStep desktop with the
application dock not visible (see the openstep  man page).

Note – You can change your password using the Preferences application. See
“Setting a Password” on page 15-6.

Your Workspace
The workspace is where you do all your work on your system. It is where you
both create and organize your creations. When you first enter the workspace, it
contains the elements shown in Figure 1-1 on page 1-4.

Most icons in the application dock represent applications such as Edit—a text
processor for creating formatted documents—or the electronic Mail
application. The dock makes it easy to start up applications you use frequently.

Applications present information in windows, which open and close in your
workspace. File Viewer gives you access to your files, including all your
applications. The File Viewer has a menu, titled Workspace, that lists commands
you can choose to make the application do something.
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The shape of the pointer changes depending on what you are doing. Common
shapes are shown in Table 1-1.

Table 1-1 Standard Pointer Shapes

Shape Used For

The arrow, for pointing to objects.

The I-beam, for editing text.

The question mark, for pointing to something you want to find out about.

The copy pointer, used to indicate that a file or folder is being copied

The move pointer, used to indicate that a file or folder is being moved.

The link pointer, used to indicate that a file or folder is being linked.
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Figure 1-1 OpenStep Workspace

Screen Saver
If, when you are in the workspace, you leave the system on but you do not use
the mouse or keyboard for a while, the screen saver starts up. The screen saver
normally starts up if you do not press a key or move the mouse for 30 minutes.
You can change this delay or even turn off the screen saver completely with the
Preferences application. See “Setting the Screen Saver” on page 16-1.

Adjusting Volume
If your system can play sounds, you can adjust the volume with the
Preferences application. See “Adjusting Sound Volume” on page 16-5.

A menu lists commands
you choose to make an
application do something.

An icon is a small
pictorial representation
of something, such as a
file or application.

The File Viewer provides
access to your files.

This column of icons is
the application dock, or
dock, for short.
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Using the Mouse
Except for typing text, you do almost everything on the computer with the
mouse (or whatever pointing device you are using). The mouse controls
movement of the pointer.

A Sun™ optical mouse uses optical sensing to measure how far you slide it,
and it must be used on a Sun mouse pad. The mouse pad must be aligned
correctly; its long sides must be horizontal, like the computer screen.

1. Move the pointer by sliding the mouse over the supplied mouse pad or
over a smooth, flat surface.

2. Position the pointer on an object such as a button, slider, or icon.

3. Use a mouse button to click, press, drag, or double-click.

Note – The Sun mouse has three buttons, and an x86 mouse can have two or
three buttons. Normally, the left button performs the operations described
here—clicking, double-clicking, dragging, and so on (see Figure 1-2), but some
users, especially left-handed ones, prefer to switch these operations to the right
button. (You can do so with the Preferences application; see “Hiding Menus”
on page 15-4.) In this manual, “clicking a mouse button” and “clicking on an
object” mean pressing whichever button you are using for these operations.

Figure 1-2 Moving the Mouse

If you reach the edge of the mouse pad while sliding the mouse, you can lift it
and put it back down somewhere else without moving the pointer. No matter
how far you move the mouse, the pointer stays on the screen.

SELECT ADJUST MENU

The left mouse button is
normally used for clicking,
double-clicking, dragging,
and the other mouse
operations described in
this chapter.

The right mouse button is
normally used to open
application menus, but
some left-handed users
prefer to make it into the
Select button. When they
do, the left button
becomes the menu button.
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Basic Mouse Actions

Once the pointer is pointing to something—it is over an icon or word, for
example—you use a mouse button to perform one of these actions:

Click Without moving the mouse, press and release a mouse button.

Press Without moving the mouse, press a mouse button and hold it down.
Pressing usually has the same effect as repeated clicking.

Drag Press a mouse button and hold it down. Then move the pointer by
sliding the mouse. Finally, release the mouse button.

Double-click Click twice in quick succession. This often extends the action
caused by a single click. In text editing, for example, clicking once selects a
location between characters and clicking twice selects a word. An application
may even use triple-clicking, for example, to select a paragraph.

Note – You can use the Preferences application to reverse the mouse buttons, to
adjust the responsiveness of the computer to multiple-clicking, and to adjust
the responsiveness of the pointer to mouse movement. See “Hiding Menus” on
page 15-4 and “Changing the Responsiveness of the Mouse” on page 16-8.

Buttons, Text Fields, and Sliders
Buttons You often use the mouse to operate buttons in windows to make
something happen in an application. Buttons come in all shapes and sizes.
They are labeled with text or graphics to indicate what they do. You click on or
press a button with the mouse, and the button responds visually—it is usually
highlighted in white until its function is completed, as shown in Figure 1-3.

Figure 1-3 Compose Button Is Highlighted When Clicked

When you click on a button it is
highlighted to let you know that it
is responding to your action.
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If you decide that you do not want to click on a button after all, you can move
the cursor away from the button before releasing the mouse button.

Clicking on a button might change a setting. To change it again, you may need
to click on the button again. A visual clue tells you what the setting is, as
shown in Figure 1-4.

Figure 1-4 Mail Format Button

Clicking on a check box button places or removes a check mark in the box (see
Figure 1-5).

Figure 1-5 Check Box Button

Pressing a button with a  on it displays a pop-up list of options from which
you can choose (see Figure 1-6). For example, when printing, you can use such
a button to specify the units of measurement for the dimensions of custom
paper in your printer.

Figure 1-6 Using a Pop-up List

This is the normal
format for Mail
messages.

When you click on the
button, it changes to
indicate that you are
preparing a message in
the alternate format.

When this check box button is checked,
the size of each message is displayed. If
you click on the box, the check mark
disappears and sizes are not displayed.

The label above
the button
describes its
function.

The text on
the button is
the current
setting.

To open the list, press the
button and hold it down.

Drag through the list
until the pointer reaches
the option you want.
Release the button to
choose the option.

When you release the
button the pop-up list
closes; your selection is
displayed as the current
setting.
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Pressing a button with a  on it displays a pull-down list of commands that
cause actions to occur. You drag the pointer through the list to the option you
want and then release the mouse button, with the results shown in Figure 1-7.

Figure 1-7 Using a Pull-down List

When buttons are grouped together, as shown in Figure 1-8, clicking on one to
select it might deselect another. Often you can drag through the group and
operate one of the buttons by releasing the mouse button when the pointer is
over it. You can do this in the Preferences application, for example, when
selecting one of four rates at which character keys on the keyboard repeat
when you hold them down.

Figure 1-8 Grouped Buttons

A dimmed button—shown in gray rather than in black—is currently unavailable
for use. The button in Figure 1-9, for example, is used on a number of panels to
restore the original settings. It is dimmed when you open one of these panels
and remains dimmed until you actually change one of the settings.

Figure 1-9 Dimmed Button

The return symbol on a button, as shown in Figure 1-10 on page 1-9, means
you can operate the button (when it is not dimmed) by pressing the Return key
on the keyboard.

Only one of these buttons can be
selected. If you click on another one,
this one will be deselected.

This button appears on the font panel. It is
dimmed until you change the font setting.
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Figure 1-10 Button Operated With the Return Key

Text fields Sometimes telling an application what to do involves typing in a
white area called a text field, as shown in Figure 1-11. A label indicates the text
field’s function.

Figure 1-11 Typical Text Field

When you work in a window that contains text fields, an insertion point often
appears in the first field, indicating that you can insert text there.

To move the insertion point to another text field, click in the other field. You
can also press the Tab key to move to the next field in a window. Or hold down
the Shift key and press Tab to go to the previous field.

If you type more than can fit in a text field, text you have already typed moves
to the left, out of view, so you can see what you are typing, as shown in
Figure 1-12.

Figure 1-12 Typing Past the Edge of a Text Field

Sliders You sometimes use a slider to specify a setting in a range. Simply
move a knob back and forth in a bar by dragging it. Or click on the bar to make
the knob jump to the position under the pointer.

When this button appears, you
can start the print process by
pressing the Return key.

This is the return symbol.

This is the label
for this text field.

Click in this area to
place the insertion point,
then begin typing.

As you type, the
insertion point moves.

You can type past the
end of a text field.

Drag back to the left to
see what you have
already typed.
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Figure 1-13 Screen Saver Slider Controls

If a text field next to the slider shows a value representing the current setting,
you can type in the field to change the setting.

Choosing Commands From Menus
To tell an application what to do, you often use commands. Commands are
displayed in menus. Each application has a main menu that is displayed when
you are working in the application (see Figure 1-14 on page 1-11).

1. To choose a command, click on it, type its keyboard alternative, or drag to
it.

2. To keep a submenu open, drag it by its title bar.

3. To close a detached submenu, click on its close button.

Some commands perform an action on something you have selected, such as
text, an icon, or a window. Other commands open a panel—a small window
that may ask for more instructions—or another menu called a submenu (see
Figure 1-15 on page 1-11).

A dimmed command is shown in gray rather than in black, and is currently
unavailable.

The position of the
slider sets a value.

The value set by the slider is
displayed in this text field.
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Figure 1-14 Mail Application’s Main Menu

If you prefer to use the keyboard, you can type a command’s keyboard
alternative. Hold down the Command key and type the character shown next
to the command. For an uppercase character, hold down the Shift key too.

Note – Your keyboard’s Command key is the key to the left of the space bar. It is
usually labeled ◆ and referred to as the Meta key. The submenu stays open
until the next time you choose a command from the first menu.

Figure 1-15 Mailbox Submenu

If the command opens a submenu, the submenu is displayed next to the main
menu, as shown in Figure 1-16.

To choose a command, click on it.

This command is dimmed.
It cannot be chosen in the current situation.

The ellipsis marks a command that opens a panel.

The triangle symbol indicates a command that opens a submenu.

When you choose a command, it is highlighted in white until it
is executed.

To choose this command, hold down the Command key and the
Shift key. Press the “N” key.

To choose this command, hold down the Command key and press
the “k” key.
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Figure 1-16 Menu and Submenu Together

Note – The button that you do not use for clicking (which is normally the right
button) opens the menu at the pointer location. For more information, see
“Hiding Menus” in Chapter 20.

You can also choose a command while dragging through a menu. Start with
the pointer pointing to any command, drag to the one you want, and release
the mouse button. As you drag through a menu, each command is highlighted
in turn. If a command opens a submenu, the submenu appears until you move
to another command (see Figure 1-17 on page 1-13).

You can move a menu and its submenu
by dragging the first menu’s title bar.

Submenu
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Figure 1-17 Dragging Into the Submenu

A submenu normally closes when you choose another command from the
menu that opens it. If you do not want the submenu to close, you can detach it,
as shown in Figure 1-18. The submenu is then displayed until you close it
yourself.

Figure 1-18 Mailbox Submenu Detached From the Main Menu

You can drag into a submenu to choose a command.
The submenu closes afterward.

Drag a submenu
by its title bar to
detach it.

A close button
appears

Click on the
button to
close the
submenu.
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If you press on the command that opened a detached submenu, another copy
of the submenu is displayed next to the main menu. You can drag into this
copy to choose a command, but when you release the mouse button it will
close.

Clicking for Help
In some applications, you can find out about an item by selecting it with the
question mark pointer, as shown in Figure 1-19. You get this pointer by holding
down the Help key.

♦ Hold down the Help key and click on any command, window, or panel.

Figure 1-19 Clicking for Help

Click on a
button to see a related
topic.

When you click on
something with the
question mark pointer,
the Help panel opens.

The help you requested
is displayed here.

You may need to drag
this knob downward to
see more.
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Clicking with the question mark pointer usually provides help on a command,
window, or panel. In some cases, you can also find out about a specific button
or icon in a window by using the question mark pointer to click on it.

Getting Help by Topic

You can find out how to do something in an application by selecting a topic
from the table of contents in the Help panel, as shown in Figure 1-20.

1. Choose Info from the application’s main menu.

2. Choose Help from the Info menu.

3. Click a topic in the Help panel.

Figure 1-20 Getting Help by Topic

You can also click on a  button to see a related topic.

Click on a topic in the table of contents.

To see all the topics, you can drag
this knob up or down.

Drag this knob to resize the two areas in
the panel.

The topic is displayed here.
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Buttons in the Help Panel

The three buttons at the top of the Help panel provide other ways to find a
topic.

Index Click on this button to view an index of topics in the application. The
index appears in the topic area. Then select the index entry you want to find
out about.

Backtrack You can click on this button to see the topic you viewed last.

Find You can type a keyword in the text field at the top of the Help panel.
Then click on Find to view the next topic that contains the keyword. Help is
organized like a stack of topics. The Find button searches through the stack
starting from the current topic. You can click on Find again and again until you
find the topic you want.

Ending Your Work Session
At the end of a work session, you can log out of the OpenStep desktop to put
all your work away. Before doing this, make sure to save any work you have
done in any application.

♦ To log out, choose Log Out from the Workspace menu and click on the
Log Out button.

You log out with the Log Out command in the Workspace menu, as shown in
Figure 1-21 on page 1-17. If this menu is not visible, you can make it appear by
clicking in the File Viewer, or by double-clicking on the Sun icon at the top of
the dock.

When you choose Log Out, the panel shown in Figure 1-21 on page 1-17 opens.
If you click on Log Out by accident, click on Cancel in the panel to make it
close so you can keep working.
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Figure 1-21 Logging Out

The Log Out command shuts down all running OpenStep applications. If you
have unsaved work, another panel asks if you want to save.

The Log Out command also shuts down the X server unless the
TerminateWindowManager  user default has been set to NO (see the Solaris
OpenStep Installation Guide).

Note – For information on how to save work before logging out, see Chapter 5,
“Creating and Saving Files.”

Choose Log Out from
the Workspace menu.

Click here or press Return
to log out.
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Working With Windows 2

This chapter describes how to work with windows and includes information
about the following:

• Types of windows
• Selecting a window to work in
• Reordering overlapping windows
• Moving a window
• Resizing a window
• Scrolling to see more
• Miniaturizing a window
• Closing a window

Types of Windows
Windows can look different from one another, but they generally have a few
things in common.

• A title bar at the top of the window shows the window’s name.

• Scrollers—shaded areas along the left side and sometimes the bottom of a
window—to adjust the view in the window when there is more of it than
you can currently see.

• A resize bar at the bottom of many windows is for changing the window’s
size.
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OpenStep™ has two types of windows: standard windows and panels.

A standard window is where the action in an application occurs. If you are
creating a document, you type or draw in a standard window, such as the Edit
window shown in Figure 2-1. The File Viewer is also a standard window—it is
where you do desktop management tasks such as organizing files.

Figure 2-1 Typical Standard Window

Panels are windows in which you tell an application what to do. Often they
open when you choose a command, asking you for more instructions or to
confirm the command. When you quit an application without saving your
changes, for example, a panel might ask if you want to save those changes.

Scrollers
let you
adjust the
view when
there is
more to
see.

The title bar
is light
gray, or it is
highlighted
in light gray
and black.

The resize bar lets you change the window’s size.

The title bar
usually
contains
one
or two
buttons for
miniaturizin
g
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Some panels act on the contents of a standard window. For example, a Find
panel locates specific text in a document (see Figure 2-2).

Figure 2-2 Different Types of Panels

A panel with a blank title bar (no title or buttons) is an attention panel (see
Figure 2-2). When one of these panels opens, you have to respond to it before
you can do anything else in the application.

A Cancel button is for
closing the panel without
performing any function.

A panel might
have places for
you to enter
text, or buttons
for telling an
application
what to do.

A blank title bar
indicates an
attention panel.

The  symbol means
you can operate the button
by pressing the Return key.

You often click on an OK
button to close a panel after
reading its message.
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Selecting a Window to Work In
To work in a window, you make it the key window—the window where you
type, or that accepts your keystrokes. There is only one key window at a time
(see Figure 2-3).

♦ Click in the window where you want to work.

Figure 2-3 Selecting a Window

The key window’s title bar is black.

Other standard
windows and
panels have gray
title bars.
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When you open a panel that helps you work in a standard window, the panel
becomes the key window—its title bar becomes black. The standard window
then gets a dark gray title bar and is known as the main window (see
Figure 2-4).

Figure 2-4 Main Window

A standard window with a black title bar is both the key window and the main
window.

Here, the FInd panel
is the key window.

The
window it
searches
is the main
window—
its title bar
is dark
gray.
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Reordering Windows That Overlap
Like sheets of paper on your desk, windows can overlap or completely cover
each other. You bring a window forward so you can work in it by clicking in it
(see Figure 2-5).

♦ To bring a window forward, click in it.
or

♦ Choose Windows from the Workspace menu and then choose the window
from the Windows menu.

Figure 2-5 Reordering Windows

Clicking in a
window brings
it forward and
makes it the
key window.
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No other window can cover an attention panel. Menus stay in front of standard
windows and ordinary panels.

More Ways to Reorder Windows

In addition to reordering by direct clicking, you can use keys on the keyboard
to reorder windows in special ways, as listed Table 2-1.

For more information about the Windows menu, see “Standard Commands”
on page A-1.

1. On a Sun keyboard, either of the Alt keys works as you r Alt key.

2. On a Sun keyboard, the ◆ key works as your Command key.

Table 2-1 Keyboard Commands for Reordering Windows

Action Effect

Hold down the Alt1 key and click in the
window’s title bar.

Brings the window forward without
making it the key window

Hold down the Command2 key and click
in the window’s title bar.

Sends the window to the back of other
windows

Hold down the Command key and press
the up arrow key.

Brings the back window to the front

Hold down the Command key and press
the down arrow key.

Sends the front window to the back
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Moving a Window
You can move a window on the screen by dragging its title bar as shown in
Figure 2-6 (do not press any buttons in the title bar). As you drag, the entire
window follows the pointer. When the window is where you want it, release
the mouse button.

♦ Drag the title bar of the window you want to move.

Figure 2-6 Moving a Window

Dragging a window brings it to the front of other windows. It also makes it the
key window (unless you hold down the Alt key while you drag).

You can drag a window anywhere on the screen and even partially off the edge
of the screen (see Figure 2-7 on page 2-9). Since the pointer cannot leave the
screen, part of the window’s title bar—the part where the pointer is—always
remains visible, and you can drag the window back into full view.

Former location
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Figure 2-7 Dragging a Window Off the Screen

Resizing a Window
You can make a window larger, to see more of its contents, or smaller, so it
takes up less space (see Figure 2-9 on page 2-10 and Figure 2-10 on page 2-11).
To do so, drag its resize bar—the narrow gray border along the bottom of most
windows (see Figure 2-8).

♦ To change the width of a window, drag horizontally from either end
region of its resize bar.

♦ To change its height, drag vertically from the middle region.

♦ To change width and height at the same time, drag diagonally from an
end region.

Figure 2-8 Resize Bar

You can drag a window partially off the
edge of the screen.

End region End regionMiddle region
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Figure 2-9 Resizing a Window

As you drag the resize bar, an outline of
the window follows the pointer.
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Figure 2-10 Resized Window

Scrolling to See More
Often there is more in a window than you can see at once. To see what is not
visible, you scroll, as shown in Figure 2-11 on page 2-12. If only one page of a
25-page document is showing, for example, you can use the vertical scroller to
see the other pages.

♦ To scroll one line or other increment, click on the scroll button that points
in the direction you want to scroll.

♦ To scroll a “windowful,” hold down the Alt key and click on a scroll
button.

You see more (or less) of the window’s contents
when you finish dragging the resize bar.
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♦ To scroll to an approximate location, drag the scroll knob or click in the
bar.

Figure 2-11 Window Showing Only Part of a Document

A scroller works like a slider—you move a knob up and down or back and
forth in a bar (see Figure 2-12). You can also click on a scroll button. Press either
of the scroll buttons to scroll continuously.

Figure 2-12 Scroller

Use a scroller when information is too long or wide to appear all at once.

Scroll buttons Scroll knob

Scroller
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How to Scroll—A Summary
Table 2-2 summarizes the ways in which you can scroll through windows.

Some applications have their own buttons for scrolling a page at a time. See the
user’s guide that comes with the application.

You can hold down the Alt key while clicking on a scroll button to scroll by
just less than the height or width of the current view, showing some of the
previous view for context. Figure 2-13 on page 2-14 shows other ways to scroll.

1. On a Sun keyboard, either of the Alt keys works as your Alt key.

Table 2-2 Ways to Scroll—A Summary

Action Effect

Click a scroll button Scrolls an increment

Press a scroll button Scrolls continuously by increments

Alt1-click a scroll button Scrolls a “windowful”

Click in the bar Scrolls directly to any location

Drag the scroll knob Scrolls gradually to any location

Alt-drag the scroll knob Scrolls more gradually to any location
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Figure 2-13 Scrolling Techniques

The size and position of the scroll knob show how much and what part of the
total contents you are viewing. The scroller represents the length or width of
the contents, and the knob represents the portion and location of the current
view (see Figure 2-14 on page 2-15).

Drag the scroll knob to
scan contents as they go
by. Hold down the Alt key
while dragging to scroll
more gradually.

Click in the scroll bar. The
scroll knob jumps to where
the pointer is and contents
scroll accordingly.

Press and hold down the
mouse button in the bar
and keep dragging.
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Figure 2-14 Scroll Knob Indicates What Portion of the Document Is Displayed

The size of the scroll knob also changes when you resize the window.

This window shows the
middle third of the document.

When you type more, the knob
gets shorter.
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Miniaturizing a Window
If you want to put a window aside without actually closing it, you can
miniaturize it, as shown in Figure 2-15. When you do this, the window shrinks
into a miniwindow—an icon that appears at the bottom of the screen.

♦ To miniaturize a window, click on the miniaturize button at the left of its
title bar.

♦ To restore the window, double-click on its miniwindow.

Figure 2-15 Miniaturizing a Window

Click on the
miniaturize button
to shrink the
window into a
miniwindow.

The miniwindow
shows at least
part of the
window’s title.
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You can move the miniwindow by dragging it, or click on it to bring it to the
front. You cannot, however, drag it into the dock (as you can an application
icon) or into the File Viewer (as you might a file or folder icon).

When you double-click on the miniwindow to restore the window, the
miniwindow goes away and the window returns as you left it—in its same size
and location as though it had never been miniaturized. Unsaved work is still
there too.

You can also miniaturize a window by choosing Miniaturize Window from the
Windows menu (see “Standard Commands” on page A-1).

Closing a Window
When you are finished with a window, you can close it to remove it from the
workspace completely, as shown in Figure 2-16. Unlike miniaturizing, closing a
window makes it disappear from the screen.

♦ Click on the close button at the right end of the window’s title bar.

Figure 2-16 Closing a Window

Click on the close
button to close the
window.
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A partially drawn close button usually means that the window contains
unsaved work (see Figure 2-17). When you save, the button returns to normal.
If you click on the button while it is partially drawn, a panel asks if you want
to save your work. After you respond to the panel, the window closes.

Figure 2-17 Partially Drawn Close Button

If you close a window without saving changes, the changes will not be there
the next time you open the window.

For information on saving work in a window before closing that window, see
Chapter 5, “Creating and Saving Files.”

You can also close a window by choosing Close Window from the Windows
menu. See “Standard Commands” on page A-1.

A partially drawn close
button reminds you
that the window
contains work you
have not saved.
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Using the File Viewer 3

The Workspace Manager has a variety of tools for browsing information in
your file system and locating files and applications. You use the File Viewer to
see what files and applications you have. It has a Finder for quickly locating a
specific file or folder.

This chapter describes how you can do the following:

• Open a folder
• Open a file
• Browse files and folders
• List files and folders
• Stock the shelf
• Open folders and files by typing
• Select several files and folders
• Open a folder in its own window
• Find files and folders
• Personalize your File Viewer
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File System
The OpenStep™ file system keeps information in files and folders. A file might
be a magazine article you write, an illustration you create with a graphics
application, or the application itself. A folder is a container, and it can contain
files and other folders, which can themselves contain more folders. Folders can
be “nested” in as many layers, or levels, as you find useful.

The files and folders make up a file system. You can think of this file system as
an upside down tree, with a root folder at the top and branches that grow
downward. Figure 3-1 shows three branches of a typical OpenStep file system.

Figure 3-1 Three Branches of a Typical OpenStep File System

natsume

home net

starr winn

ReactionReports EBDraft.rtf

fred

export

publicity creative

usr

openstep

Apps
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Each file or folder has a name that identifies its contents. For example, a folder
containing the Solaris™ OpenStep™ applications is called Apps . A file might
be called EB_draft.rtf .

A file or folder also has a path name that identifies its location. The path name
lists the folders along its branch of the file system. The folder names are
separated by slashes (/). A slash at the beginning of a path name represents
the root folder.

The complete name for the Apps  folder (referring to Figure 3-1 on page 3-2) is
/usr/openstep/Apps ; the complete name for the text document is
/home/starr/EB_draft.rtf .

You often identify a file or folder by its path name. You might type a path
name or read it in a panel.

Workstations running the OpenStep desktop are typically part of a network,
and make use of files on other computers. Many of these files are displayed in
a path that includes the /net  folder, which represents the network. Referring
again to Figure 3-1 on page 3-2, the path name
/net/fred/export/publicity  identifies a folder named publicity  on
another computer that is named fred .

As Seen in the File Viewer
To get to the files and folders in the file system, you use the File Viewer (see
Figure 3-2 on page 3-4). The File Viewer appears when you enter the OpenStep
workspace and can stay open the whole time you are working.
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Figure 3-2 File Viewer, Showing One Branch of Starr’s File System

Files and folders are displayed as icons. Different areas of the File Viewer have
the following uses:

• Icons on the shelf can provide a shortcut to files and folders you access
frequently. The shelf always contains your home folder, which is where you
keep your own work. You can add or remove other files and folders.

• The icon path shows where you are in the file system. This row of icons
shows the selected file or folder and the folders above it in its branch of the
file system.

• The bottom area displays the contents of the current folder—the one you are
currently working in. When you use OpenStep for the first time, files and
folders here are shown as icons.

When you enter the workspace, you see the contents of your home folder. Your
home folder has the icon of a house. Its name is your user name.
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Opening a Folder
You open a folder (as shown in Figure 3-3) to see its contents, which are
displayed in the bottom area of the File Viewer (as shown in Figure 3-4 on
page 3-6). When you first use OpenStep, files and folders here are displayed as
large icons. To see them as large icons if you do not currently, open the View
menu and choose Icon.

♦ Click on a folder on the shelf or in the icon path.

or

♦ Double-click on a folder in the current view.

Figure 3-3 Opening a Folder

Click on a
folder on
the shelf.

Click on a
folder in
the icon
path.

Or double-
click on a
folder that
is in the
current
view.
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Figure 3-4 After Double-clicking on ReactionReports

With the icon view, you can select a folder without opening it by clicking on it
in the current view instead of double-clicking on it.

The way you move through the file system when you open a folder depends
on what part of the File Viewer you open it from (see Figure 3-5, Figure 3-6 on
page 3-7, and Figure 3-7 on page 3-7).

Figure 3-5 Opening a Folder From the Shelf

The folder you
open is
highlighted
as the
selection.

The contents
of each folder
appear below,
replacing the
contents of
the previous
folder.

Opening a folder
from the shelf goes
directly to that folder.
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Figure 3-6 Opening a Folder From the Icon Path

Figure 3-7 Opening a Folder in the Current View

The file system contains UNIX® files that are not displayed in the File Viewer
unless you specify that you want them to be displayed. See “Displaying UNIX
Files” on page 15-24.

Opening a File
You open a file (as shown in Figure 3-8 on page 3-8) to see its contents.

If a file is associated with an OpenStep application, the application associated
with the file starts, if it is not already running. It then shows the contents of the
file in a window. See “Which Application Opens a File” on page 3-10 for
information on the file extensions that are recognized by OpenStep desktop
applications.

♦ Double-click on the file on the shelf, in the icon path, or in the current
view.

Opening a
folder from the
icon path
moves up the
current branch
of the file
system.

Opening a
folder in the
current
view moves
down its
path in the
file system.
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Figure 3-8 Opening a File

If a file is associated with a non-OpenStep application (for example, a
document file associated with FrameMaker), opening the file in the File Viewer
does not start the non-OpenStep application, but may start an OpenStep
application.

If you open a file that is an OpenStep application, the application simply starts.

If you open a file that is a non-OpenStep application, OpenStep does one of the
following:

• Starts the Terminal application, which then attempts to start the application
you opened.

• Displays an alert panel with the message “This application doesn’t contain
software for this kind of computer.”

When an OpenStep application that is not in the dock starts, its icon is
displayed at the bottom of the screen. You can drag the icon into the dock, as
shown in Figure 3-9 on page 3-9. Do not drag icons of non-OpenStep
applications into the dock.

Click on a file
to select it.
Double-click
to open it.

The file is
highlighted in
the icon path.

The
rightmost
folder in the
icon path is
the current
folder.
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Figure 3-9 Dragging an Application to the Dock

If a file does not open, you may not have read permission for it. See
“Permissions Granted” on page 6-2 and “Changing Permissions for a File or
Folder” on page 7-9.

When a ghost image appears in the
dock, release the mouse button.

If an application is not in the dock, you
can drag it to an empty area of the dock.
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Which Application Opens a File
You can tell which application opens a file by the file icon. Usually, it resembles
the application icon (see Table 3-1). You can also tell by the file name
extension—the last period in the name and the characters that follow. The
extension describes the type of information in the file. For example, a file in
Rich Text Format (RTF) has the extension .rtf . A file with encapsulated
PostScript™ has an .eps  extension. A plain text file has no extension.

OpenStep desktop applications recognize files with the extensions listed in
Table 3-2, and the correct application is started to open these files. The icons for
these file types are shown in Table 3-3 on page 3-11.

Note – For more information, see “Changing the Application That Opens a
File” on page 7-6.

1. Other file types are used by OpenStep development tools. Some of
these files may also be opened by Edit.

Table 3-1 Which Application Opens a File

File Extension File Icon Application Icon Application

.eps Preview

.rtf Edit

Table 3-2 File Extensions Recognized by OpenStep Desktop Applications

Opened by Extensions

Edit1 .rtfd , .rtf , .text

Mail .mbox , .vox

Preview .ps , .tiff , .eps



Using the File Viewer 3-11

3

Icons in the File System

Different kinds of files and folders have different icons. There are also icons for
disks, disk drives, or any other devices that might appear in your file system.
Table 3-3 shows some common icons. (For information on other icons, see
Chapter 4, “Working With Applications” and Chapter 8, “Working With
Disks.”) You also may see icons for applications you buy or create yourself.

Table 3-3 Icons in the File System

Icon Meaning

A general-purpose folder. You can create folders of this type.

A folder that is on another computer on the network. You can open it by
clicking, even though it is on another computer. (In most cases, you will
not have access to every folder on the other computer.)

A computer’s root folder. The computer’s name is displayed with the
icon.

Your home folder.

Someone else’s home folder, which you might see if you are working on
a network or sharing your computer with other people.

The /net  folder, which contains folders on other computers that belong
to the network.
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A file in Rich Text Format (often called an RTF file), which contains text
with font and formatting properties, such as bold or italic.

An RTF file that contains one or more graphic images.

A file that contains only plain text—text with no font or formatting
properties.

A file that contains a graphic image in encapsulated PostScript format,
often called an EPS file.

A file with a graphic image in tag image file format, often called a TIFF
file.

An application that does not have its own icon.

A file or folder that has been compressed. See “Compressing and
Decompressing a File or Folder” on page 6-16.

A broken link to a file or folder (see Chapter 6, “Organizing Your Work,”
for information on links).

An application that cannot be run—for example, because it is not
configured to run on your type of computer. In the dock, it might be an
application that was moved, renamed, or that no longer exists.

Table 3-3 Icons in the File System (Continued)

Icon Meaning
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A folder is dimmed when you do not have permission to open it. If you try to
open it, no contents are displayed even if it has some.

Browsing Files and Folders
Browsing is a way to move quickly through the files and folders in your file
system. When you choose Browser, the current view becomes a browser, which
lists the contents of each folder in the icon path, as shown in Figure 3-10. The
contents are listed by name in the column below the icon.

♦ To see the contents of several folders at once, choose View from the Dock
menu and then choose Browser from the View menu.

♦ To open a folder, select its name in the browser.

♦ To open a file, double-click on its name in the browser.

Figure 3-10 File Viewer’s Browser View

A  marks
a folder.
Other
names are
files.

Name of
the current
folder.

Contents
of the
current
folder.
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When you select a folder in a browser, the contents of the folder are displayed
in the column to the right (see Figure 3-11).

Figure 3-11 Opening Files and Folders in Browser View

You can also open files and folders from the shelf and icon path, just as you can
when you are working with other views.

Click on a
folder to
open it.

Double-
click on a
file to open
it.
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Listing Files and Folders
♦ To change to the listing view, choose View from the Workspace menu and

then choose Listing from the View menu.

♦ To open a file or folder, double-click on the icon next to its name.

You can list the contents of the current folder to show the size, history, and
permissions for files and folders. When you choose Listing, the view changes
to show this information (see Figure 3-12).

Figure 3-12 File Viewer’s Listing View

Drag this
knob to
adjust the
width of
the Name
column.

Click on a
file or
folder to
select it.

Double-
click on the
icon (not
the name)
to open the
file or
folder.

Scroll if all columns are not visible at once.
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In the listing view, the icon next to a name indicates whether it is a file, folder,
or application:

 Marks a folder

 Marks an application

 Marks any other file

You can also open a file or folder from the shelf or icon path, just as you can
when working with other views.

To find out the size of a folder, you have to use the Inspector command. See
“Getting Information about a File or Folder” in Chapter 7.

What You See in the Listing View

When you display the contents of a folder in the listing view, the columns next
to each file or folder name provide the following information (see Figure 3-13
on page 3-17):

Size The size, in bytes, for files. In a plain text file, for instance, each character
occupies one byte.

Last Changed The date and time (based on a 24-hour clock) that the file or
folder was created, or that changes were last made to it. Older files list the year
instead of the time.

Permissions The read (r), write (w), and execute (x) permissions, successively,
for the person who owns the file or folder, a group of people who may have
special access it, and anyone else who has access to the file system. A listing of
r – x for the group, for example, means the group has read and execute
permissions but not write permission.

Owner The user name of the person who owns the file or folder.

Group The group of users who have the group permissions.

For more information on permissions, see “Changing Permissions for a File or
Folder” on page 7-9.
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Figure 3-13 File and Folder Permissions in the Listing View

Stocking the Shelf
You can stock your shelf with folders or files you use frequently. Just drag
them from the icon path as shown in Figure 3-14 on page 3-18.

♦ To add a folder or file to the shelf, select the folder or file. Then drag it
from the icon path to an empty space on the shelf.

♦ To remove a folder or file from the shelf, drag it out of the File Viewer
into the workspace.

A d marks a
folder (UNIX
directory)

Owner
permissions

Group
permissions

Permissions
for everyone
else

An l marks a
link to a file
or folder
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Figure 3-14 Adding a Folder To the Shelf

Drag a file or folder into the workspace to remove it from the shelf (see
Figure 3-15 on page 3-19).

Drag a file
or folder to
the shelf.

Release the
mouse
button when
a ghost
image of the
icon
appears.

In the icon
view, you
can also
drag a file or
folder from
the current
view.
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Figure 3-15 Removing a Folder From the Shelf

Caution – When you drag a file or folder to add it to the shelf or remove it, do
not release the mouse button while the icon you are dragging is over another
folder. If you do, you might accidentally copy or move the file or folder you
are dragging.

You can make more room on your shelf by resizing the File Viewer so it is
wider.

You can adjust the number of rows on your shelf. See “Personalizing Your File
Viewer” on page 3-32.

Release
the mouse
button when
the file or
folder
disappears
from the
shelf.

You
cannot
remove
your home
folder from
the shelf.

!
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Opening Folders and Files by Typing
You can put your mouse aside and select and open folders and files from
the keyboard, as shown in Figure 3-16 and Figure 3-17 on page 3-21.

♦ To move along the current branch of the file system, press the left or right
arrow key.

♦ To move through the contents of a folder in the browser or listing view,
press the up or down arrow key.

♦ To select a specific file or folder in the current folder, type the first few
characters of its name.

♦ To open the selected file or folder, press Return.

Figure 3-16 Opening Files or Folders From the Keyboard

If you make a mistake or change your mind while typing a file or folder name,
pause for a moment to start over.

The left
arrow key
selects
(moves the
highlight to)
this folder.

When a
folder is
selected,
the right
arrow key
selects the
first name in
the current
folder.

Typing ‘Gr’
selects this
folder.
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With the browser or listing view, you can use the up and down arrow keys to
move through the contents of a folder, as shown in Figure 3-17.

Figure 3-17 Using the Arrow Keys to Move in the Browser View

You can locate any file or folder by typing its path name. As soon as you type
a slash (/) or tilde character (~) to begin the path name, the Finder opens. See
“Options for Searching” on page 3-31.

The up
arrow key
selects and
opens this
folder.

The down
arrow key
selects this
file.
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Selecting Several Files and Folders
You can select several files and folders in the current folder and then perform
some operation with all of them (see Figure 3-18). For example, you can open
several files at the same time by selecting them and double-clicking on the
selection icon (see Figure 3-19 on page 3-23).

♦ Drag around (or over) the files and folders you want to select.

♦ Hold down the Shift key and select each file or folder you want to add to
the selection or remove from it.

♦ In the browser or listing view, hold down the Alt key and click to select a
range between the current selection and where you click.

Figure 3-18 Selecting Several Files

In the icon
view, begin
dragging at a
point outside
the icons you
want to
select.

As you drag,
an outline
surrounds
the icons.
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Figure 3-19 Opening Several Selected Files

You can also hold down the Shift key while dragging around several icons to
add all of them to your selection.

You can drag and use the Shift key to make multiple selections in the browser
or listing view too (see Figure 3-20 on page 3-24).

Double-click
on the
selection
icon to open
all the files in
the
selection.

Shift-click
on a file or
folder to
add it to the
selection.
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Figure 3-20 Selecting Multiple Files in the Browser View

Or you can use the Alt key to select a range of files and folders, as shown in
Figure 3-21 on page 3-25.

Drag to make a continuous selection. Shift-click on a name to add it to the
selection.



Using the File Viewer 3-25

3

Figure 3-21 Extending a Selection in the Browser View

In either the browser or listing view, you can hold down the Shift key while
you click a selected file or folder, or while you drag over several, to remove
files or folders from the selection.

To find out which is your keyboard’s Alt key, see “Keyboard Basics” on
page 9-5.

Opening a Folder in Its Own Window
You can open a folder in its own window (see Figure 3-22 on page 3-26), for
example, to be able to see the folder’s contents while opening other folders in
the File Viewer.

1. Select the folder you want to open.

Alt-click to extend a selection ... ... to here.
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2. Choose File from the Dock menu.

3. Choose Open as Folder from the File menu.

Figure 3-22 Opening a Folder in Its Own Window

This window behaves like the File Viewer, except that it shows only the
contents of the selected folder. In it, you can open files and folders, drag them
to the shelf, and do anything else you do in the File Viewer.

Select the
folder you
want to open
in its own
window and
choose
Open as
Folder.

The
window’s
title bar
shows the
folder name.

The folder
appears on
the window’s
shelf and in
the icon
path.

You can
display
contents
in icon,
browser, or
listing
view.
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File Packages—Files That Are Really Folders

A file package is a special kind of folder whose contents are not normally
shown in the File Viewer or any other folder window. Instead, file packages
look and behave like regular files. Double-clicking on a file package, for
example, starts up an application or shows the contents of a file in a window.

File packages keep together information that should not be separated. When
you add a graphic image to an Edit document, for example, Edit puts the
graphic in its own file and stores it in a file package along with a file
containing the document’s text. Most applications are also file packages. They
consist of a file containing the actual application and other files that the
application uses, such as sounds.

You rarely need to see the contents of a file package, and you shouldn’t
normally change its contents. But to look inside one—for example, to copy
something from it—select it in the File Viewer and choose Open as Folder from
the File menu as shown in Figure 3-23 on page 3-28.

You can tell that a file is really a file package if:

• The Open as Folder command is not dimmed when the file is selected.
When you select a regular file, this command is dimmed.

• When you inspect the file with the Inspector command, the file is treated as
a folder. See “Getting Information About a File or Folder” on page 7-1.

• The file is an RTF file with an .rtfd  extension.

• The file is an application with an .app  extension.
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Figure 3-23 Opening a File Package

Finding Files and Folders
You can search for a file or folder (see Figure 3-24 on page 3-29) based on any
part of its name. You can also search for a file based on a string of text that is
in the file. You tell the Finder where to search by designating a target. You can
drag any folder from the File Viewer to the Finder’s shelf and use it as a target.

1. Choose Tools from the Dock menu.

2. Choose Finder from the Tools menu.

3. Select a target from the Finder’s shelf.

4. Use the pop-up list to indicate whether you are searching for a file name
or a text string inside a file.

The contents
of the file
package are
displayed in a
separate
window.

The file
package has
its usual file
icon.

This file
package has
a TIFF
graphic file,
an EPS
graphic file,
and a text file.
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5. Type in the name or text string for which you want to search.

6. Click on the Find button or press the Return key.

Figure 3-24 Searching for Files and Folders

You can search for a single file or folder by name—regardless of the target—by
typing its entire path name in the Finder, such as
/home/starr/publicity/Press_Releases  or ~starr/creative . When
found, the file or folder is selected in the File Viewer.

Click on a target on the
Finder’s shelf.

Type text to search for
here.

Press here to choose to
search by name or by
file content.

Click on Find to begin
the search.

Files and folders are
listed here.
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Shortcuts to Typing Path Names

Here are a few shortcuts you can use to enter a path name in the Finder.

• You can designate your home folder with a tilde character (~). To identify a
path that continues past your home folder, just continue the path name.
Typing ~/EB_draft.rtf , for example, is a shortcut for
/home/starr/EB_draft.rtf . To specify someone else’s home folder,
type ~ followed by the name of that person’s home folder, as in ~poupon .

• You can type a few characters of a name in a path name and press the Esc
key to fill in the rest of the name. To type /home/starr , for example, type
/h  and press Esc, then type /s  and press Esc. If more than one name
matches what you have typed so far, the Finder lists all possible matches
each time you press Esc.

During a search, the Find button changes to a stop sign that you can click on to
interrupt the search.

You can select a file or folder in the Finder and use the Inspector command to
inspect it (see Chapter 7, “Inspecting Files and Folders”). You can also search
for an address book by content.

To narrow down your search, you can select from the files and folders you
find, as shown in Figure 3-25, and then search on the selection.

Figure 3-25 Selecting a Second Target From the Results of the First Search

Select one or more files,
for example, by dragging
over them.

The selection appears
here.

You can drag the
selection to the shelf to
make it the new target.
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When you search by name, you can double-click on a file or folder listed in the
Finder to select it in the File Viewer—even while the search is still in progress.
When you search by content, double-clicking on a file listed in the Finder
opens the file and selects the text you are searching for. In either mode, you can
also select a file in the Finder and then double-click on its icon to open it.

Options for Searching

You can find any file or folder while working in the File Viewer by typing its
full path name. As soon as you type a slash (/) or tilde character (~), the Finder
opens and shows your typing. Complete the path name and press Return. The
file or folder is selected in the File Viewer and the Finder closes.

You can also press Esc in the File Viewer to type the path name of the current
selection in the Finder.

If you want the Finder to list a file or folder without selecting it in the File
Viewer—for example, so you can drag it to the Finder’s shelf to use as a
target—type the path name and press Esc instead of Return.

You can Shift-click an item on the shelf to add it to your target. If you forget
what is in a target that consists of a multiple selection, press the Esc key to list
the selection’s contents.

When searching by name, you can use an asterisk (*) as a wildcard. For
example, to find all TIFF files within a target, type *.tiff .

To search for names that contain a ~ or *, enclose your text in quotation marks,
as in “~oldfile ”.

You can select more than one file or folder in the Finder the same as with
browser or listing view in the File Viewer. See “Selecting Several Files and
Folders” on page 3-22. You can use the Preferences command to search for one
or more keywords in files. See “Workspace Manager Commands” on
page A-10.
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Personalizing Your File Viewer
You can adjust spacing of icons or browser columns displayed in the File
Viewer. The Icon View option lets you adjust the spacing in the icon view, as
shown in Figure 3-26.

1. Choose Info from the Workspace menu.

2. Choose Preferences from the Info menu.

3. Choose the Icon View, Browser, or Shelf option from the pop-up list at the
top of the Workspace Manager Preferences panel.

4. Make settings in the panel to adjust spacing between icons or the width
of browser columns.

Figure 3-26 Adjusting the Spacing Between Icons

With the Browser option, you can adjust the width of columns in the browser
view, as shown in Figure 3-27 on page 3-33.

Choose the Icon View
option

Drag an arrow to adjust
spacing between icons.

The white field shows
the space available for
text beneath an icon.
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Figure 3-27 Adjusting the Width of Columns in the Browser View

With the Shelf option, you can adjust spacing between icons on the shelf, as
shown in Figure 3-28 on page 3-34.

Choose the Browser
option

Drag the arrow inward
or outward to adjust
column width.
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Figure 3-28 Adjusting the Spacing Between Icons on the Shelf

You can also add rows to the shelf. When you click on the Resizable Shelf box,
a resize knob appears at the bottom center of the shelf, as shown in Figure 3-29
on page 3-35.

Choose the Shelf
option.

Drag an arrow to adjust
spacing between icons.

The white field shows
the space available for
text beneath an icon.

Check this box to make
the shelf in folder
windows resizable.
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Figure 3-29 Adding Rows to the Shelf

You can click on the Use Default Setting button in the Preferences panel to
return to the default OpenStep settings.

Network Perspective
Since OpenStep runs on computers that are connected in networks,
understanding the basics of networking will help you get the most out of
OpenStep. It is the network that makes it possible to exchange electronic mail
with other people and share their files, all within seconds and without ever
leaving your own desk.

A network can consist of two computers or two thousand. Some of them will
have people like you working at them. Others, known as servers, will contain
files and folders shared by everyone on the network.

Drag the
knob
downward
to add
rows to the
shelf.
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You access servers and the files they contain through the /net  folder in your
root folder. Files and folders accessed through other paths, such as
/usr/openstep , are usually on the hard disk in your own computer.

Note – Your home folder is typically on a server, and therefore accessible from
any computer in the network. This means you can log into any computer on
the network with your user name and password, and find yourself in your
own workspace, with access to the files in your home folder.

Working with files and folders on a server is no different than working with
files and folders on your own computer. But while everyone can access the
folders in /net , only you can access the other folders in your root folder.
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This chapter describes the following topics:

• Starting an OpenStep™ application from the dock
• Running several applications
• Switching to another application
• Hiding an application
• Customizing the application dock
• Starting applications automatically
• Requesting services from other applications
• Quitting an application

Starting an OpenStep Application From the Dock
Solaris™ OpenStep™ comes with several applications, and you may add other
OpenStep applications that you buy or create yourself. You can keep the icons
that represent the applications in the application dock—the column of icons
lining the right side of the screen.

When you double-click on an application icon in the dock, the icon is
highlighted for a moment. Then the application’s main menu appears, often
along with another window, as shown in Figure 4-1 on page 4-2.

♦ Double-click on the application icon in the dock.
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Figure 4-1 Starting the Edit Application

Before you start an application, its icon has an ellipsis . While an
application is starting, its icon is highlighted. When the application is running,
the ellipsis disappears. See Figure 4-2.

Figure 4-2 Application Icons Show Application Status

The Sun icon remains at
the top of the dock. You
can drag it downward to
remove most of the dock
from view.

You can double-click on an
application to start it up.

You use the recycler to
delete files and folders
from the file system.

Not running Starting up Running
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Note – You start an OpenStep application that is not in the dock by opening a
file from the Workspace Manager. See “Opening a File” on page 3-7.

The recycler is described in “Deleting a File or Folder” on page 6-18.

Running Several Applications
You can run several applications at once, as shown in Figure 4-3 on page 4-4.
For instance, you can view a Mail message while typing in an Edit document.
Although several applications can be running, you work in only one at a
time—the active application.

When you start an application, it becomes the active application. Its main
menu replaces any other menus on the screen.

♦ Start each application you want to run.
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Figure 4-3 Starting Mail After Edit

You might also do something that causes an application to start up automatically.
For example, double-clicking on a document file icon starts the Edit application
and opens the document file.

Switching to Another Application
When you want to work in another application, just click in one of its windows
as shown in Figure 4-4 on page 4-5. If no windows are showing, double-click
on the application icon.

The active application is the
one with a menu showing.

It also contains the key window.
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♦ Click in one of the application windows.

or

♦ Double-click on its icon.

Figure 4-4 After Clicking in the Document Window

When you leave one application to work in another, the standard windows that
belong to the application you leave stay on your screen. If an attention panel is
open, it stays too. But the application’s menus and all other panels are no
longer displayed. When you switch back to the application, its menus and
panels reappear, just as you left them.

Click in a window to bring the window
forward and activate its application.

Or double-click on its application icon.
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Hiding an Application
If you want to stop working with an application but plan to use it later in the
same work session, you can hide it to get its windows out of the way. All its
windows disappear from view, but the application continues to run (see
Figure 4-5).

By hiding applications, you can have several running and easily accessible
while your workspace remains free of windows you are not currently using.

♦ To hide an application, choose Hide from its main menu.

♦ To show the application, double-click on its icon.

Figure 4-5 After Choosing Hide From the Mail Menu

Unhide the Workspace Manager
application by clicking on the Sun icon.

When a docked application is
hidden—as opposed to not
running—there is no ellipsis
in its icon.
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When you unhide an application, all its windows reappear, and the application
is activated, just as though it had never been hidden.

Note – When you hide an application, no unsaved work is lost. Nor is it saved.
For information on saving your work, see Chapter 5, “Creating and Saving
Files.”

Customizing the Application Dock
You can fill your dock with frequently used OpenStep applications. Then, to
start up a docked application, you just double-click on it.

The Solaris™ OpenStep™ applications can be found in the
/usr/openstep/Apps  folder. Any additional OpenStep applications installed
on your network should be in the /usr/local/openstep/Apps  folder, and
OpenStep applications installed only on your computer should be in
~/openstep/Apps . If you installed WorkShop™ OpenStep™, you can find
the developer applications in /usr/openstep/Developer/Apps  folder.

♦ To add an OpenStep application to the dock, select the application in the
File Viewer and drag it into an empty space in the dock (see Figure 4-6 on
page 4-8).

♦ To remove an application from the dock, drag it into the workspace while
it is not running (see Figure 4-7 on page 4-9).

♦ To reorder applications in the dock, drag one from its current location to
an empty space in the dock.
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Figure 4-6 Customizing the Application Dock

You can drag an application from the File Viewer to an empty space in the
dock. (Release the mouse button when a ghost image of the icon is displayed in
the dock.) You can also drag a freestanding application icon into the dock.

Normally, no windows or menus can cover the dock. However, if you hold
down the Alt key and click on the Sun icon in the dock, the dock can
be covered. To bring the dock back to the front, Alt-click on the Sun icon again.

Note – Alt-clicking on the Sun icon to send the dock to the back increases the
area of the screen you can work in.

When a ghost image
appears in the dock,
release the mouse button.

Drag an application icon
from the File Viewer to any
empty space in the dock.

You can also drag a
freestanding application
into the dock.
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If your dock fills up, you must remove an icon from it to add any others. You
can drag an application out of the dock when it is not running, as shown in
Figure 4-7. (Release the application when it is no longer displayed in the dock.)

Figure 4-7 Removing an Icon From the Dock

The Sun icon always remains at the top of the dock. The Recycler appears in
the dock, or if there is no room there, at the lower-left corner of the screen.

Note – You can remove a running application from the dock by holding down
the Command key and dragging it out of the dock. You can also do this to
remove the recycler.

Note – Do not drag non-OpenStep applications to the dock.

When You Want to Locate a Docked Application

If you forget where a docked application is in the file system, you can see its
path name in the Workspace Manager Preferences panel, as shown in
Figure 4-8 on page 4-10. Open the Info menu and choose the Preferences
command. Then choose the Dock option from the pop-up list at the top of the
panel.

You can drag an application out of the
dock when it is not running.

Release the mouse button when the
application disappears from the dock.
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Figure 4-8 Locating a Docked Application

Starting an Application Automatically
You can set any application that is in the dock to start up automatically when
you enter the workspace, as shown in Figure 4-9 on page 4-11. If you regularly
exchange electronic mail with other people on a network, for instance, you can
set the Mail application to start up when you log in.

1. Put the application in the dock.

2. Choose Info from the Workspace menu.

3. Choose Preferences from the Info menu.

4. Choose Dock from the pop-up list at the top of the Preferences panel.

5. Click on an application to select it.

6. Click on the Start up at login check box.

Choose Dock from
this pop-up list.

The path to the
application is
displayed here.

Click on the name of
an application.
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Figure 4-9 Setting Mail to Start Automatically

The Workspace Manager is always running, and so it is always checked.

Requesting Services From Other Applications
You can request the service of one application while you are working in
another. A service provides a shortcut to starting up or switching to an
application and requesting a specific action from it. Available services are listed
in the Services menu.

Figure 4-10 on page 4-12 shows an example.

1. Select the text or file you want serviced.

2. Choose Services from the application’s main menu.

3. Choose a command from the Services menu.

Choose Dock from
this pop-up list.

Click on the name of
an application.

A check mark means
the application is set to
start automatically. If
you select the
application and click on
the button, the check
mark disappears.

When you click on this
button, a check mark
appears in front of the
application name.
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Figure 4-10 Requesting a Workspace Service While Using Mail

The exact commands in the Services menu depend on which applications you
have. Some commands, like the one shown in Figure 4-10, are not available
until you select something, like a file’s path name.

Several OpenStep applications provide services. If you have other applications,
you might see other services in the menu too.

Note – Services menu commands for OpenStep applications are described in
“Standard Commands” on page A-1. You can use the Preferences application to
remove commands you do not need from the Services menu. See “Customizing
the Services Menu” on page 15-16.

Select a path
name you
receive in a Mail
message.

Choose Open in
Workspace from
the Services menu.

The file opens
without your
having to locate it
first in the File
Viewer.
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Quitting an Application
When you are completely finished with your work in an application, you can
quit the application to close all its windows and any work they contain.

♦ Choose Quit from the application’s main menu.

Figure 4-11 After Quitting Edit (Mail Is Running But Hidden)

If any window in the application contains unsaved work, a panel asks if you
want to save before quitting the application (and closing the window).

Note – If you think you may use the application later in your work session and
just want its windows out of the way, it is better to hide the application rather
than quit it—it takes less time to unhide an application than it does to restart it.

For information on saving your work before quitting an application, see
Chapter 5, “Creating and Saving Files.”

When you quit an application that is in the
dock, the ellipsis  is displayed again in
its icon.

A docked
application that
is hidden does
not have an
ellipsis  in
its icon.
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When the Quit Command Fails

On rare occasions, your actions in an application may have no effect due to a
software problem. You can usually solve the problem simply by quitting the
application and starting it again.

If choosing the Quit command has no effect, you may be able to quit the
application by using the Workspace Manager Processes command, as shown in
Figure 4-12. Switch to the Workspace Manager—for instance, by clicking in the
File Viewer. Open the Tools menu and choose the Processes command. Then
choose Applications from the pop-up list at the top of the Processes panel.
Select the application you want to quit and click on the Kill button.

The application quits running, but any unsaved work in the application is lost.
You should use the Processes command to quit an application only as a last
resort.

Figure 4-12 When the Quit Command Fails

OpenStep Applications
OpenStep comes with several applications, which are kept in the
/usr/openstep/Apps  folder. These applications are briefly described in
Table 4-1 on page 4-15 along with their icons.

Select the application
that is causing
problems from this list.

Choose Applications
from this pop-up list.

Click here to quit the
application without
saving any work.
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If you installed the developer software, you will find the developer
applications in /usr/openstep/Developer/Apps .

Table 4-1 OpenStep Applications

Icon Application

Preferences is an application for setting personal preferences for using
the OpenStep desktop, such as key repeat speed or an application
language. When it is running, its icon in the dock shows the date and
time. See Chapter 15, “Personalizing the Workspace” and Chapter 16,
“Managing Hardware.”

Mail is a multimedia electronic mail application for communicating
with others on a network. You can send text, graphics, sound, and even
files and folders. See Chapter 12, “Receiving and Sending Mail” and
Chapter 13, “Managing the Mail Application.”

Edit is a Rich Text editor you can use to create formatted documents
with graphics. See Chapter 9, “Typing and Editing” and Chapter 11,
“Working With Graphics.”

Terminal is for working directly with UNIX® by entering UNIX
commands and running UNIX programs. Terminal can also run
programs that require VT100 terminal support. See Chapter 17, “Using
the Terminal Application.”

Preview displays the contents of PostScript™, EPS, and TIFF files as
images. See Chapter 11, “Working With Graphics.”
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Creating and Saving Files 5

Whenever you create a document (for example, a text report, an illustration, or
a spreadsheet), you start by creating a file. All the work you do is kept in that
file when you save it. You can change it and save the changes, or you can save
different versions of the file.

This chapter describes how to do the following:

• Create a file
• Open a file
• Save a new file
• Save changes
• Save another version of a file

Creating a File
When you want to create something new, you start the application you want to
use, open a new window, and begin to work in it.

You open the window with the New command in the document menu, as
shown in Figure 5-1 on page 5-2. This menu might be called Document, Image,
Project, or whatever describes what you create with the application.

1. Start the application you want to use.

2. Choose the command that opens the document menu.

3. Choose New.
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Figure 5-1 Creating a File

You store the work you do in a file. You name the new file and put it in a folder
when you first save the contents of the new window.

If you close the window without saving, no file is created and work you have
done in the window is lost.

Some applications give you a new window automatically when you start them
from the dock or when you open their files from the File Viewer.

As soon as the window opens,
you can begin working, for
example, by typing.

Choose the command below Info, which opens the
document menu, named File here.

Choose New to open a new window.

A new window’s title bar contains a temporary title.
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Opening a File
You can open a file while you are working in an application. Use the Open
panel, which contains a small browser that lists the files the application can
open, as shown in Figure 5-2. You locate a file in this browser just as you locate
a file with the browser view in the File Viewer.

1. Choose the command that opens the document menu.

2. Choose Open.

3. In the Open panel, select the file or files you want to open.

4. Click on OK.

Figure 5-2 Opening a File

Instead of selecting the file you want to open in the browser, you can type its
path name, as shown in Figure 5-3 on page 5-4. If the file is further down the
branch of the file system from the folder that is currently open in the panel,
you only need to type the part of the path name that begins with a name in
that folder.

Open a folder by clicking on it.

Select the file you want to open.

Click to open the file.

Clicking on this button opens your
home folder.

Scroll along a branch of the file system
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Figure 5-3 Typing a Path Name

Note – You can double-click on a file in the browser to open the file without
having to click on OK. You can also open more than one file by selecting the files
you want to open—for example, by dragging over them—and clicking on OK.

When you open a file, the panel goes away and the contents of the file are
displayed in a window.

Note – You can use the same shortcuts to typing path names in the Open panel
as you can in the Finder. See “Shortcuts to Typing Path Names” on page 3-30.

For more information on using a browser, see “Browsing Files and Folders” on
page 3-13.

You can use the disk buttons in an Open panel to open and eject floppy disks.
See “Opening and Saving Files on a Floppy Disk” on page 8-10.

Saving a New File
To name a new file and put it in a folder, you must save it. When you are
working in a new window and you choose Save, a panel opens that contains a
browser (see Figure 5-4 on page 5-5). Locate and open a folder in this browser
just as you do with the browser view in the File Viewer.

1. Choose the command that opens the document menu.

2. Choose Save.

3. In the Save panel, name the file and open the folder in which you want to
put it.

4. Click on OK.

You can type this to open
SummerCatalog.rtfd  in the
Catalog  folder.
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Figure 5-4 Saving a New File

When you save a file, the Save panel closes and the file is placed in its folder,
as shown in Figure 5-5.

Figure 5-5 Path Name of Saved File Displayed in Title Bar

Open the folder in which you want to
put the file by clicking on the folder.

Type a name for the file here.

Click to save the file.

Scroll along a branch of the file system

Clicking on this button opens your
home folder.

The name of the file and the
path name of the folder in which
you put it are displayed in the
new window’s title bar.
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Guidelines for Naming Files and Folders
You can choose nearly any name you want for a file or folder. Just keep the
following in mind:

• You cannot use the same name more than once in the same folder. However,
you can use the same name in different folders.

• Lowercase letters are distinguished from uppercase letters, so Fall
Catalog is the name of one file and fall catalog  is the name of another
file.

• You can use any characters except a slash (/ ), which separates names in a path
name. It is better to avoid spaces and the ‘ “ & | - and ^  characters,
which have special meanings in UNIX®.

• Remember that the extension at the end of most file names associates the file
with an application. If you do not include the extension when you name
the file, the application adds it automatically.

Tricks in the Name Field
Instead of selecting a folder to save a file in, you can type a path name for the
file in the Save panel. Use the same shortcuts described in “Shortcuts to Typing
Path Names” on page 3-30.

To save the file further down the branch of the file system from the folder that
is currently open in the panel, type just the part of the path name that begins
with a name in that folder. In the panel Figure 5-4 on page 5-5, for example,
type Catalogs/FallCatalog  to save FallCatalog.rtfd  in the Catalogs
folder.

You can also create a folder in which to save a file. Type a path name for the
file that includes the folder’s name as though the folder already exists. Type
Festival/Program , for example, to create a Festival  folder and save
Program.rtfd  in it. In the panel that asks if you want to create the folder,
click on Create.

To replace a file with the one you are saving, select the file you want to replace
and click on OK. In the panel that asks if you want to replace the file, click on
Replace.
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Saving Changes
You save changes you make to a file so they are there when you next open the
file. Just choose Save while working in the window that contains the file. The
contents of the window replace the previous version of the file on disk. The
window stays on the screen so you can keep working in the file (see
Figure 5-6).

♦ To save changes in a file, open the document menu from the main menu
and then choose Save from the document menu.

♦ To save changes in all the files open in an application, choose Save All
from the document menu.

Figure 5-6 Saving Changes in a File

A partially drawn close
button means the window
contains unsaved changes.

After you save the file, the
close button returns to
normal.
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You can undo changes you do not want to keep with the Revert to Saved
command in the document menu. See “Standard Commands” on page A-1.

Note – You should save changes periodically as you work in a file, not just
when you are about to close it. By saving frequently, you avoid losing a lot of
work if the file closes unexpectedly—for example, if there is a power failure.

If you choose Save All when any window in the application contains work that
has not yet been saved, a Save panel opens. You can then name the file and put
it in a folder.

When You Save an Edit Document

When you save an Edit document, Edit creates a temporary backup file, which
contains the version of the file without the changes you are saving. Edit deletes
this backup file as soon as the new version is successfully saved on disk.

If something happens that prevents Edit from saving the file—a power failure,
for example—the backup copy remains, and you can recover its contents. You
can tell which is the backup copy because it has the same name as the original
file but with a tilde (~) appended to it. For example, the backup copy for
Memo.rtf  would be Memo.rtf~ .

If you only the backup file remains, you can remove the ~ from the name and
use it in place of the original. See “Renaming a File or Folder” on page 6-4.

Saving Another Version of a File
You can save the contents of a file under a different name and in a different
folder while keeping the original file too. You typically do this to save one
version of a file before making any more changes to it.

Both the Save As and Save To commands save the contents of the window you
are working in as another file. Each command opens the Save panel, where you
name the new version of the file and put it in a folder, just as you do for a new
file (see Figure 5-7 on page 5-9). The original file stays the same as when you
last saved it.
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1. Open the document menu from the main menu.

2. Choose Save As or Save To from the document menu.

3. In the Save panel, name the new version and open the folder in which
you want to put it.

4. Click on OK.

Figure 5-7 Saving Another Version of a File

Note – You can think of these commands as taking a snapshot of the file and
putting the snapshot away, while you continue to work in the other version of
the file. Save As puts a snapshot of the original version aside, and Save To puts
a snapshot of the revised version aside.

Save As puts away the
previous version, which
does not include
changes. You keep
working in the new
version, which includes
changes.

Save To puts away the
new version, which
includes changes. You
keep working in the old
version, where your
changes are not yet
saved.
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Why Save?

When you work in a file—for example, by typing in an Edit document—the
system displays your work in a window. But it does not retain your work
permanently on disk until you save the file.

Before closing a window that contains a file you have been working in, you
need to save your changes if you want them to be there the next time you open
the file. If you close the file without saving, the changes are not copied onto the
disk and they are there when you next open the file.

Figure 5-8 Reasons for Saving

OpenStep leaves the original file on disk. It copies the file into the window.

When you revise a file, for
example, by typing in it:

The file on disk remains unchanged.

When you save the file:

When you open a file:

The copy you have revised replaces the file on disk.

You see your revisions in the window.
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This chapter describes the following tasks you can perform in the OpenStep™
environment to organize your work:

• Creating a folder
• Renaming a file or folder
• Copying a file or folder
• Moving a file or folder
• Replacing a file or folder
• Merging two folders
• Creating a link
• Setting options for copying links
• Compressing and decompressing a file or folder
• Deleting a file or folder
• Retrieving a file or folder from the recycler
• Handling several files and folders at once
• Managing several file operations
• Solving file and folder problems
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Permissions Granted
To make changes to the file system, for instance, by moving files around or
renaming them, you must have certain permissions for the files and folders
you are working with. To rename a file, for example, you need permission to
change the contents of the folder it is in.

There are two basic types of permissions for a file or folder: read
permission—that is, permission to look at its contents—and write permission, or
permission to change its contents.

All of the tasks described in this chapter require that you have the correct
permissions. When you try to do something you do not have permission
for—such as move a file out of someone else’s folder—a panel typically
informs you that you cannot do it.

You can set permissions for your own files and folders to prevent anyone else
from changing them. For example, you might give other people permission to
read a folder, and therefore browse its contents. But if you do not give them
write permission for the folder, they cannot change the folder’s contents, for
example, by moving a file out of it.

You can even use permissions to protect your work from yourself. If you
remove write permission from an important file, for example, you cannot
accidentally alter the file by saving changes to it.

For information on how to set permissions for yourself and for others who
have access to your files, see “Changing Permissions for a File or Folder” on
page 7-9.
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Creating a Folder
As you accumulate files, you can create folders to put them in so they are easy
to find. Choosing New Folder creates a folder in the current folder, as shown in
Figure 6-1.

1. Open the folder in which you want to put the new folder.

2. Choose File from the Workspace menu.

3. Choose New Folder from the File menu.

4. Type a name for the folder and press Return.

Figure 6-1 Creating a Folder

Your new folder is empty at first. But you can put files and other folders in it
by copying or moving them into it, by saving files in it, or by creating other
new folders in it.

At first, the
folder is
called
NewFolder

You type the
name you
want and
press
Return.
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Pick a name for your folder as described in “Guidelines for Naming Files and
Folders” on page 5-6.

Renaming a File or Folder
You can rename a file or folder simply by editing its name in the File Viewer or
any other folder window, as shown in Figure 6-2.

1. Select the file or folder.

2. Edit the name in the icon path.

3. Press Return.

Figure 6-2 Renaming a File or Folder

Pick a new name for the file or folder as described in “Guidelines for Naming
Files and Folders” on page 5-6.

When you
click in a
name in the
icon path,
an insertion
point is
displayed.

In the icon or
listing view,
you can also
edit a name
in the
current view.
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You can use Edit menu commands to edit a file or folder name. You can also
choose Sort Icons from the View menu to alphabetize the contents of a folder
after renaming in it. See “Workspace Manager Commands” on page A-10.

The name of a file or folder cannot or should not change in these cases:

• You cannot rename your home folder.

• Do not rename an application. Changing an application’s name may prevent
you from opening files you have already created with the application.

• Do not change a file’s extension if that will prevent the file from opening in
the right application.

Copying a File or Folder
You can make a copy of a file or folder in another folder, as shown in
Figure 6-3 on page 6-6. When you copy a folder, you copy all the files and
folders in it too.

1. Select the file or folder and drag it to the shelf.

2. Select the folder in which you want to put the copy.

3. Hold down the Alt key and drag what you are copying from the shelf to
the folder in the icon path.
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Figure 6-3 Copying a File or Folder

The standard way to copy a file or folder is to drag it from the shelf to a folder
in the icon path. But you can also drag from the icon path to a folder on the
shelf, or from one folder window to another.

You might not need to hold down the Alt key while you drag. It depends on
where you are dragging the selection. When you drag it to a folder that is on a
different disk, for example, the selection is copied even if you do not use the
Alt key.

If a folder does not open when you drag a selection to it, check your
permissions for that folder.

To find out which is your keyboard’s Alt key, see “Keyboard Basics” on
page 9-5.

In the icon
view, you
can also
drag to or
from the
current view.

The copy
pointer
shows that
you are
copying
instead of
moving.

The folder
opens to
accept the
selection.
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If the Processes panel asks for additional instructions, see “Solving File and
Folder Problems” on page 6-24.

For information on copying a selection of files or folders, see “Handling
Several Files and Folders at Once” on page 6-21.

You can also use the Duplicate command in the File menu to copy a file or
folder. See “Workspace Manager Commands” on page A-10.

Moving a File or Folder
You move a file or folder into another folder much as you copy it—by dragging
it to the other folder, as shown in Figure 6-4 on page 6-8. When you move a
folder, you move all the files and folders in it, too.

1. Select the file or folder and drag it to the shelf.

2. Select the folder you want to put it in.

3. Hold down the Command key and drag what you are moving from the
shelf to the folder in the icon path.
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Figure 6-4 Moving a File or Folder

The standard way to move a file or folder is to drag it from the shelf to a folder
in the icon path. But you can also drag from the icon path to a folder on the
shelf, or from one folder window to another.

If the Processes panel asks for additional instructions, see “Solving File and
Folder Problems” on page 6-24.

For information on moving a selection of files or folders, see “Handling Several
Files and Folders at Once” on page 6-21.

You might not need to hold down the Command key while you drag. It
depends on where you are dragging the selection. When you drag it to a folder
on the same part of a disk, for example, the selection is moved even if you do
not use the Command key.

In the icon
view, you
can also
drag to or
from the
current view.

The pointer
 changes

color to
show that
you are
moving
instead of
copying.

The folder
opens to
accept the
selection.
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If a folder does not open when you drag a selection to it, you do not have
permission to put anything in that folder.

When It Is a Copy or a Move
When you drag a file or folder to another folder, the Workspace Manager either
copies it or moves it, depending on where the destination folder is. You can tell
which by the shape of the pointer.

A  copies the selection. This pointer is displayed when the selection and the
folder to which you are dragging it are on a different disk (or different part of
a disk, if your system administrator has partitioned the disk to act as separate
disks). For example, it is displayed when you drag a file from your system’s
hard disk to a floppy disk or to a disk on another system on the network.

A  moves the selection. This pointer is displayed when the selection and the
folder are on the same disk or part of a disk.

To make the copy pointer appear in any case, you can hold down the Alt key
as you drag. To get the move pointer, hold down the Command key as you
drag.

Replacing a File or Folder
You can replace a file or folder with another one of the same name. If the
replacement and original do not have the same name, rename one of them so
they do. Then copy or move the replacement into the folder that contains the
original. The Processes panel (see Figure 6-5 on page 6-10) asks if you want to
replace the existing file or folder.

1. Select the file or folder you want to use as the replacement.

2. Drag the selection to the folder that contains the file or folder you want to
replace.

3. Click on Replace in the Processes panel.
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Figure 6-5 Replacing a File or Folder

Replacing a folder removes the entire contents of the existing folder and leaves
only the contents of the folder you copied or moved, as shown in Figure 6-6.

Figure 6-6 Effect of Replacing a Folder

Any file or folder you replace is moved into the recycler. To get it back, see
“Retrieving a File or Folder From the Recycler” on page 6-19.

For information on replacing a selection of files and folders, see “Handling
Several Files and Folders at Once” on page 6-21.

If the Processes panel asks for additional instructions, see “Solving File and
Folder Problems” on page 6-24.

Path name—or part of
path name—of folder
you are copying.

Folder you want to
replace.

Click if you do not want
to replace anything.

Click to replace the
folder.

Copy this Art  folder..

Contents:

dog.tiff
frog.tiff

Contents:

dog.tiff
frog.tiff

Contents:

cat.tiff
dog.tiff

Click on Replace to get
these contents.

...over this Art  folder. The
entire folder is replaced.
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Merging Two Folders
You can incorporate changes made to one folder into another folder that has
the same name. When you copy a folder over another with the same name, the
Processes panel provides the options shown in Figure 6-7.

1. Select the folder you want to merge.

2. Hold down the Alt key and drag the selection to the folder that contains
the folder with which you want to merge.

3. Click on Merge in the Processes panel.

Figure 6-7 Merging Two Folders

When you merge two folders, the new folder contains the entire contents of the
folder you copy, plus any files or folders unique to the existing folder, as
shown in Figure 6-8 on page 6-12.

Click to merge the two
folders.

Click to stop the
operation without
merging anything.

Path name—or part of
path name—of folder
you are copying.

Folder with which you
are merging it.
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Figure 6-8 Effect of Merging Two Folders

To find out which is your keyboard’s Alt key, see “Keyboard Basics” on
page 9-5.

For information on merging more than one folder at a time, see “Handling
Several Files and Folders at Once” on page 6-21.

Any file or folder that is replaced is moved into the recycler. To get it back, see
“Retrieving a File or Folder From the Recycler” on page 6-19.

If the Processes panel asks for more instructions, see “Solving File and Folder
Problems” on page 6-24.

How Merging Saves Time

Before the Workspace Manager replaces a file during merging, it checks for any
differences between it and the replacement. It compares their size and the date
they were last changed. If it finds no difference, it does not replace the file.

When you are working on a large project at your office, you might copy part of
the project onto a disk to work on it at home. Maybe you change 5 files out of
20 that you copied. When you merge them back with the rest of the files, the
Desktop Manager detects that you changed only 5 files. Instead of taking the
time to copy all 20 files, it copies only those 5.

Creating a Link
You can keep a file or folder in one location and work with it in another by
creating a link to it (see Figure 6-9 on page 6-13). The link looks just like the file
or folder to which it points. It has the same icon, and when you open it, you
see the same contents.

Copy this Art  folder..

Contents:

dog.tiff
frog.tiff

Contents:

cat.tiff
dog.tiff

Contents:

cat.tiff
dog.tiff
frog.tiff

...over this Art  folder. Only
one file will be replaced

Click on Merge to get
these contents
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1. Select the file or folder to which you want to create a link and drag it to
the shelf.

2. Select the folder in which you want to put the link.

3. Hold down the Control key and drag the selection from the shelf to the
folder in the icon path.

Figure 6-9 Creating a Link

To create a link, you can also drag from the icon path to a folder on the shelf,
or from one folder window to another.

If a folder does not open when you drag a selection over it, you do not have
permission to put a link in that folder.

For information on creating several links at a time, see “Handling Several Files
and Folders at Once” on page 6-21.

The folder
opens to
accept the
selection.

A link
pointer
shows that
you are
creating a
link instead
of copying or
moving.

In the icon
view, you
can also
drag to or
from the
current view.
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You can identify a link and tell what file or folder it points to with the
Inspector command. See “Getting Information About a File or Folder” on
page 7-1.

What Is a Link?

A link is a pointer to a file or folder that is somewhere else in the file system. A
link looks and acts like the file or folder to which it points. It has the same icon,
and when you open it, you see the same contents.

• On a network, links make it easy for several people to open the same file.

For example, if you are working with a group of people on the same project,
you can create a link to your group’s Schedule  file and keep it in your
home folder. To see the current schedule—including any changes made to
it—you can open your link.

• Links save time.

Instead of following a lengthy path to a folder you work in frequently, you
can create a link to the folder and put it somewhere convenient, such as in
your home folder. Then to get to the actual contents of the folder, you just
open your link.

• Links save disk space.

Instead of copying a sound or application into your home folder, just make
a link to it. Since a link is just a pointer to the file, it takes up practically no
space on the disk.

A link remains tied to the name and location of the file or folder it points to.
You can move the link or rename it, and it still points to the file or folder. If the
actual file or folder is moved, renamed, or deleted, however, the link breaks.
You should therefore make links only to files or folders that you are relatively
sure are not going to be moved or renamed.

When a link does break, its icon changes to a question mark. You can re-
establish the link by returning the actual file or folder to its original location
and name. Otherwise, you should delete the link.
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Setting Options for Copying Links

When you copy a file that is actually a link, the Processes panel asks whether
you want to make another link, or make a copy of the actual file or folder the
link points to. If you do not want to be asked, you can select an option that
applies for every link you copy. You select this option in the Workspace
Manager Preferences panel, as shown in Figure 6-10.

1. Choose Info from the Workspace menu.

2. Choose Preferences from the Info menu.

3. Choose File Copy Options from the pop-up list at the top of the
Workspace Manager Preferences panel.

4. Select an option.

Figure 6-10 Setting Options for Copying Links

Options for Copying Links

Select one of the following options from the File Copy Options in the
Workspace Manager Preferences panel. The option you select applies for all
links that you copy.

Press here to choose
File Copy Options.

Select an option for
how you want all links
to be copied.
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Ask When this option is selected, the Processes panel asks what you want to
do for each link you try to copy.

Make a new link Select this option and the Workspace Manager creates
another link for each link it copies.

Skip the link Select this option and the Workspace Manager skips all links
without copying them.

Copy the original Select this option and the Workspace Manager creates a
copy of the actual file or folder to which a link points.

Compressing and Decompressing a File or Folder
You can free space on your disk by compressing a file or folder, as shown in
Figure 6-11. Then when you want to open the file or folder, you decompress it.

1. To compress a file or folder, select it and choose File from the Workspace
menu. Then choose Compress from the File menu.

2. To decompress the file or folder so you can open it, select it and choose
File from the Workspace menu. Then choose Decompress from the File
menu.
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Figure 6-11 Compressing a File or Folder

When you compress a file or folder, the amount its size is reduced depends on
the kind of information in it. Compression works best on text files, reducing
the size by up to 75 percent. It is also a good idea for folders that you do not
look in very often, such as a folder containing an old project you are not
currently working on.

You can decompress a file or folder with the Decompress command or you can
double-click on a compressed file or folder. In the latter case, the Inspector
panel opens, and you can click on the Decompress button to decompress the
file or folder. The file or folder then has its original icon and takes up its
original amount of disk space.

You can use the Inspector command to find out the size of a file or folder
before and after compressing it. See “Getting Information About a File or
Folder” on page 7-1.

A compressed
file or folder
looks like this
and has a
.compressed
 extension.
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Deleting a File or Folder
You can remove a file or folder from the file system without immediately
destroying it by moving it into the recycler—the icon at the bottom of the
screen, as shown in Figure 6-12. When you decide you really want to destroy it,
you can empty the recycler.

1. Select the file or folder.

2. Drag the selection from the icon path to the recycler.

3. When you are sure you want to destroy everything in the recycler, choose
File from the Workspace menu and then choose Empty Recycler from
the File menu.

Figure 6-12 Deleting a File or Folder

A sphere in the center of the recycler
means there is something in it.

The recycler starts spinning
to accept your selection.
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You can also drag a file or folder from the shelf to the recycler. Or with the icon
view, you can drag it from the current view.

Caution – The Empty Recycler command permanently destroys the contents of
the recycler. You should leave files and folders in the recycler until you are sure
you do not need them. But to free disk space, make sure to empty the recycler
periodically.

Retrieving a File or Folder From the Recycler
When you move a file or folder into the recycler, it is not lost forever. You can
retrieve it by opening the recycler and dragging the file or folder back to the
File Viewer or any other folder window, as shown in Figure 6-13 on page 6-20.

1. Double-click on the recycler.

2. Drag the file or folder from the Recycler window to a folder in the
File Viewer.

3. Click on the close button in the Recycler window.

!
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Figure 6-13 Retrieving a File

You can only retrieve files or folders that you recycled since you last chose the
Empty Recycler command.

You can destroy a file or folder without moving it to the recycler with the
Destroy command in the File menu. See “Workspace Manager File Menu” on
page A-11.

Drag the file or folder from the Recycler
window to a folder in the File Viewer.

Double-click on the recycler
to see its contents.

Click to close the
Recycler window.
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On many networks, the system administrator makes backup copies of files. If
you accidentally destroy something, see your system administrator about
retrieving a copy of it.

For information on deleting a selection of files and folders, see “Handling
Several Files and Folders at Once” on page 6-21.

Handling Several Files and Folders at Once
You can work with several files and folders at once—to move them all to
another folder, for example, or to put them all in the recycler. When you select
several files or folders, a selection icon is displayed in the icon path, as shown
in Figure 6-14 on page 6-22. You can drag this icon to copy, move, link, or
delete the selection of files and folders just as you drag a single file or folder.

1. Select the files or folders you want to copy, move, link, or delete.

2. Drag the selection icon to a folder or the recycler.
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Figure 6-14 Handling Several Files and Folders at Once

If the folder does not open, you do not have permission to complete
the operation.

Select more than one file or folder as described in “Selecting Several Files and
Folders” on page 3-22.

If the Processes panel asks for additional instructions, see “Solving File and
Folder Problems” on page 6-24.

Drag the
selection
icon to
maneuver a
selection of
files and
folders.

The folder
opens to
accept the
selection.
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Managing Several File Operations
OpenStep can perform several file operations at the same time (see
Figure 6-15). You can copy a selection, compress a folder, and delete another
folder, without waiting for any previous operation to be completed. In the
meantime, you can do something else in the Workspace Manager or with any
other application.

1. Choose Tools from the Workspace menu.

2. Choose Processes from the Tools menu.

3. Choose Background from the pop-up list at the top of the Processes panel.

4. Click on the operation you want to check.

5. If you want to halt the operation, click on Pause or Stop.

OpenStep carries out most of the file operations described in this chapter in the
background—that is, behind the scenes where you do not have to worry about
them. You can track the progress of an operation, or stop, or pause it with the
Processes panel.

Figure 6-15 Managing Several File Operations

Press here to choose
Background.

Click on an operation in
this list.

Shading in the circle
shows the percentage of
the operation that is
complete.

Click to stop the
operation completely.

Click to halt the
operation and click again
to resume it.
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Caution – Sometimes you need to make sure that a particular operation is
complete before you begin another. For example, if you are moving some files
out of a folder that you then want to delete, make sure the move is complete
before you delete the folder.

If you stop an operation that is partially completed, such as a copy or move,
any file or folder already named in the panel is copied or moved. If you stop
while a folder is named, parts of the folder may be copied or moved.

Solving File and Folder Problems
Sometimes when you are working with files, the Processes panel may describe
a problem and wait for additional instructions before proceeding, as shown in
Figure 6-16.

Figure 6-16 Solving File and Folder Problems

!

This is the problem.

This is what you can do.

If you are working with
several files or folders,
you can check here to
repeat instructions for
all of them.

You can press this
button to stop the
operation completely.

The options change
for each problem.
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Here are some common messages and ways to respond to them.

One or several folders already exist at destination

♦ Click on Merge to merge all folders in the selection with the existing
folder of the same name.

♦ Click on Replace to have all folders in the selection replace the existing
folder of the same name.

♦ Click on Proceed to decide for each folder.
When you click on Proceed, you are asked whether you want to replace,
merge, or skip each folder, one at a time (see the messages in “File or folder
already exists”).

File or folder already exists

♦ Click on Replace to replace the existing file or folder named in the panel.
See “Replacing a File or Folder” on page 6-9 for more information.

♦ Click on Merge to merge the folder named in the panel with the existing
folder.
See “Merging Two Folders” on page 6-11.

♦ Click on Skip if you do not want to replace the file or folder.
When you are copying or moving a selection of files or folders, this button
skips the one currently named in the panel, but keeps copying or moving
the rest of the selection.

File or folder is a link

♦ Click on Copy to create a copy of the actual file or folder the link points
to.
This copy is not a link.

♦ Click on New Link to create another link to the file or folder.

♦ Click on Skip if you do not want to copy the link.
When you are copying or moving a selection of files and folders, this button
skips the link currently named, but continues with the rest of the selection.

Note – You can choose one of these options for all links you copy with the
Preferences command. See “Setting Options for Copying Links” on page 6-15.
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No room on disk

1. Remove files and folders from the disk to which you are copying or
moving and click on Proceed. Choose the Inspector from the Tools menu
to see how much space is left on the disk and the size of your selection.

2. Free the necessary amount of space, return to the Processes panel, and
click on Proceed to complete the operation.

No room in recycler

♦ Click on Empty to empty the recycler.
Any files or folders in the recycler are permanently removed and then the
operation continues.

Repeat Box
When the Processes panel asks how to handle one of several files or folders in
a selection, you can check the Repeat box. Then click on a button to apply your
response to the entire selection.

For example, if the panel says a file already exists, you can check Repeat and
click on Replace to replace all files with the same name as any in the selection
without being asked about each one.

If the panel says that a file or folder you are copying is a link, you can check
Repeat and click on New Link to copy all links as links. Or check Repeat and
click on Skip if you do not want to copy any links in the selection.

The Repeat option can carry out or skip any of these actions: replacing files,
copying links, or merging or replacing folders. It applies only to the exact
situation named in the panel.
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The Workspace Manager’s Inspector panel gives you quick information about
files and folders—and some options for managing them. You open the
Inspector panel with the Inspector command in the Tools menu.

The following topics are discussed in this chapter:

• Getting information about a file or folder
• Previewing the contents of a file
• Sorting files and folders
• Changing the application that opens a file
• Assigning a file or folder to a new group
• Changing permissions for a file or folder

Getting Information About a File or Folder
You can use the Inspector to get information about a file or folder—its size,
owner, and group, as well as its permissions and the last time it was changed,
as shown in Figure 7-1 on page 7-2.

1. Choose Tools from the Workspace menu.

2. Choose Inspector from the Tools menu.

3. Select a file or folder in the File Viewer.

4. Choose Attributes from the pop-up list at the top of the Inspector panel.
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Figure 7-1  Getting Information About a File or Folder

The size of a file is displayed automatically each time you inspect it. But you
have to compute the size of a folder if you have changed any of its files since
the last time you inspected it.

Choose Attributes to get information
about the selected file or folder.

File name

Path name

Click here to compute the size of a folder.

Permissions show who can open
or change a file or folder.

Date and time the file or folder
was last changed
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When a File Is Not a File
In the File Viewer, you may see things that look like files or folders but really
are not. These are either links or file packages.

Links A link looks and acts like an ordinary file or folder but is actually a
pointer to a file or folder somewhere else in the system. When you inspect a
link, the Inspector panel shows both the path name for the link and the path
name for the file or folder to which it is linked. See “What Is a Link?” on
page 6-14.

File packages A file package is a folder that looks and acts like a file. It
contains information that should not be separated, such as the text and
graphics files that make up a document or the files that make up an
application. When you inspect a file package, it looks like a folder—you need
to press the Compute button to compute its size. See “File Packages—Files
That Are Really Folders” on page 3-27.

You can also get this information in the File Viewer. See “Listing Files and
Folders” on page 3-15.

Previewing the Contents of a File
You can get a quick look at the contents of a file without taking the time to
open the file and start up its application—to make sure it is the one you want,
for example.

You use the File Inspector panel, which changes when you open different types
of files. For example, the Inspector panels in Figure 7-2 on page 7-4 show the
contents of an RTF file and a TIFF file.

1. Choose Tools from the Workspace menu.

2. Choose Inspector from the Tools menu.

3. Select a file in the File Viewer.

4. Choose Contents from the pop-up list at the top of the Inspector panel.
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Figure 7-2 Previewing the Contents of a File

The Workspace Manager provides Inspector panels for inspecting several types
of files, including RTF (.rtf  and .rtfd ), EPS, TIFF, and sound (.snd ) files. If
the application you are using produces a different kind of file, it may provide
its own Inspector panel. If not, you cannot preview its files.

Sorting Files and Folders
The files and folders in the File Viewer and other folder windows are normally
listed alphabetically by name. You can change the order in any folder to list its
contents by kind, date, size, or owner, as shown in Figure 7-3 on page 7-5.

Choose Contents to preview a file.

Click here to display the complete TIFF
image in the window.

You can select text in the preview of an RTF file
to copy and paste in another document.
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1. Choose Tools from the Workspace menu.

2. Choose Inspector from the Tools menu.

3. Open the folder you want to sort in the File Viewer.

4. Choose Contents from the pop-up list at the top of the Inspector panel.

5. Click on one of the sorting options and click on OK.

Figure 7-3 Sorting Files and Folders

Any change you make in the Folder Inspector panel applies only to the folder
that is currently open in the File Viewer.

Click on Contents.

Then click on one of these options to
change the way the contents are
organized.

Click on OK to confirm the sorting
option.
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In the icon view, you can also use the Clean Up Icons command and the Sort
Icons command in the View menu to organize your files and folders. See
“Workspace Manager Commands” on page A-10.

Changing the Application That Opens a File
When you open a file in the Workspace Manager, an application automatically
starts at the same time. That application depends on the type of file—that is, on
its file extension. For example, when you open an RTF file, Edit normally
starts.

You can use the Inspector to see which applications can open a file, to change
the application that starts whenever you open specific types of files, or to open
a file temporarily in another application, as shown in Figure 7-4 on page 7-7.

1. Choose Tools from the Workspace menu.

2. Choose Inspector from the Tools menu.

3. Select a file in the File Viewer.

4. Choose Tools from the pop-up list at the top of the Inspector panel.

5. Click on the application you want to open the file.

6. Click on Set Default.
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Figure 7-4 Changing the Application That Opens a File

Note – You can also open a file temporarily in an application by holding down
the Command key and dragging the file icon from the icon path to the
application icon in the dock.

For more information about what makes a file and application compatible, see
“Which Application Opens a File” on page 3-10.

The highlighted application is the one that
currently starts when you open the file.
Click on another application to make it the
startup application.

Choose Tools.

To open the file temporarily in another
application, double-click on the
application’s icon.

Click on Set Default to start the
highlighted application whenever
you open the file.
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Assigning a File or Folder to a New Group
The Workspace Manager helps groups of people work more efficiently by
sharing access to a set of files and folders. Every file and folder you create is
assigned to a group. If you belong to more than one group, you can reassign
files and folders from one group to another, as shown in Figure 7-5.

1. Choose Tools from the Workspace menu.

2. Choose Inspector from the Tools menu.

3. Select a file or folder in the File Viewer.

4. Choose Attributes from the pop-up list at the top of the Inspector panel.

5. Choose the new group from the Group pop-up list and click on OK.

Figure 7-5 Assigning a File or Folder to a New Group

Choose Attributes.

When you belong to more than one
group, you get a pop-up list here.

Click on OK to confirm.

You choose the group to which you want
to assign the file or folder.
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You can reassign only files and folders that you created.

For information about setting up groups to share files and folders, see your
system administrator.

Changing Permissions for a File or Folder
You can control access to individual files and folders that you create—and
protect them from accidental changes—by setting permissions for them, as
shown in Figure 7-6 on page 7-10.

1. Choose Tools from the Workspace menu.

2. Choose Inspector from the Tools menu.

3. Select a file or folder in the File Viewer.

4. Choose Access Control from the pop-up list on the Inspector panel.

5. Check the permissions you want in the grid and click on OK.
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Figure 7-6 Changing Permissions for a File or Folder

Permission is granted when a check mark appears in the appropriate square.
An X indicates that permission is denied. You can change permissions only if
you are the owner of the file or folder.

You can also set read and write permissions in the Attributes Inspector panel.
These permissions apply only to the current file or folder—not the files and
folders it contains.

Caution – Do not change execute permissions unless you are an expert user. If
you uncheck execute permissions for an application, you may not be able to
open any of the files that use the application. If you uncheck execute
permissions for a folder, you or others may not be able to open any of the files
in the folder.

Check Write for permission to change
the contents of a file or folder.

Check Execute for permission to run
applications or other program files.

Choose Access Control.

The person who created the file or folder.

Click here if you want the permissions to
apply to all files and folders in a folder.

Check Read for permission to look at the
contents of a file, or the list of files and
folders in a folder.

Anyone in the group associated with the
file.

Everyone else who has access to your file
system.

!
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Permissions affect many file operations. For an overview, see “Permissions
Granted” on page 6-2.

You can preset permissions for any file or folder you create with the
Preferences application.
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This chapter discusses how to use disks: floppy disks and CD-ROMs. It covers
the following topics:

• Inserting a floppy disk
• Preparing a new floppy disk
• Creating a folder window for a disk
• Copying files to or from a disk
• Reusing a disk
• Ejecting a disk
• Opening and saving files on a floppy disk

Inserting a Floppy Disk
You can use a floppy disk to store backup files or to move files from one
computer to another. The disk can be in DOS format or UNIX® format.

1. Slide the disk into the drive, metal end first, label side up.

2. Gently push the disk until it clicks into place.

3. Choose Disk from the Workspace menu.

4. Choose Check for Disks from the Disk menu.

5. Click on the disk on the shelf or double-click on it in the current view to
open it.
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Note – If a panel says that the disk is unreadable, you have to initialize the
disk. See “Preparing a New Floppy Disk” on page 8-3.

For information on inserting a disk while working in an Open or Save panel,
see “Opening and Saving Files on a Floppy Disk” on page 8-10. For
information about how to insert a CD-ROM, see the owner’s guide for your
CD-ROM drive.

When you insert a floppy disk and choose Check for Disks, it is displayed in
your File Viewer—you have to choose Check for Disks for the disk to be
displayed.

The disk is put in the folder called floppy  in your root folder and the files and
folders on the disk become part of your file system, as shown in Figure 8-1.
You can open the disk to see its contents just like you open a folder.

Figure 8-1 Floppy Disk in the File Viewer

The disk
appears on
the shelf if
space
permits.
Click on it
to open it.

The disk is
put in the
floppy
folder in
your root
folder, and
has a name,
just like a file
or folder.
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You are the owner for all files and folders on any floppy disk that you insert.
You can work in all its files and folders and change their permissions.

Preparing a New Floppy Disk
Before you can use a brand-new floppy disk, you have to initialize it.
Initializing a disk prepares it to store files and folders. When you insert a
new disk and choose Check for Disks, the Workspace Manager usually
asks if you want to initialize the disk.

1. Insert the disk in the disk drive.

2. Choose Disk from the Workspace menu and choose Check for Disks from
the Disk menu.

3. Click on Initialize.

4. Choose a format from the pop-up list in the Initialize panel.

5. Type a name for the disk.

6. Click on Erase.

When you click on Initialize, the panel shown in Figure 8-2 opens.

Figure 8-2 Initializing a Disk

If you do not name the disk, it has the name unnamed_floppy .

Click to initialize the disk.

Type a name for the disk here.

Press here if you want to choose
DOS format.
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Note – You should initialize a disk in DOS format if you want to use the disk
to copy files from your system to a DOS computer.

Creating a Folder Window for a Disk
When you insert a floppy disk or CD-ROM in your computer, the disk
normally shows up on the File Viewer’s shelf, if space permits. You can have
the disk open in its own window instead (see Figure 8-3).

1. Choose Info from the Workspace menu.

2. Choose Preferences from the Info menu.

3. Choose Disk Options from the pop-up list in the Workspace Manager
Preferences panel.

4. Click on the “open new folder window” option for removable disks.

Figure 8-3 Disk Options

Choose DIsk Options
from this pop-up list.

Select an option for
floppy disks or
CD-ROMs.
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Other Disk Options

You can select one of four options for how removable disks are displayed
in your file system. No matter which option you select, you can always find the
disk to open it in your root folder.

Place icon on shelf When this option is selected, the disk is displayed on the
shelf, if space permits.

Open new folder window Select this option to display the contents of the disk
in its own folder window.

Select the disk This option selects and opens the disk in the File Viewer so its
contents are displayed.

Do nothing This option simply puts the disk in your root folder without
opening it or putting it on the shelf.

Copying Files to or From a Disk
You copy files or folders to or from a disk just like you copy them between
folders. Select them and drag them where you want to put them, as shown in
Figure 8-4 on page 8-6. To move a selection instead of copying it, hold down
the Command key as you drag.

1. Select the files you want to copy and drag them to the shelf.

2. Select the disk you want to copy them to. Or if you are copying from
a disk, select the folder you want to copy them to.

3. Drag the files from the shelf to the disk or folder.
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Figure 8-4 Copying Files to or From a Disk

Note – The best way to work with a file on a floppy disk is to copy the file
somewhere else in your file system first and work in the copy. If you want to
change a file on a CD-ROM, you must copy it somewhere else in your file
system and then change the copy. You cannot change the contents of a
CD-ROM.

Note – After copying files to a floppy disk, you can eject the disk and insert it
into another computer to transfer files to that computer. See“Ejecting a Disk”
on page 8-9.

When you
drag to a
disk, it
sparkles to
accept the
selection.
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DOS Disks
You can use a floppy disk to transfer files between a DOS computer and your
system.

When you insert a DOS floppy disk into your system, the disk is displayed in
the floppy  folder in your root folder like any other disk. You can then copy
files from the disk to your file system.

If you want to transfer a file from your system to a DOS computer, you can
initialize a disk in DOS format (see “Reusing a Disk” on page 8-8. Then copy
the files you want to transfer onto the disk, eject the disk, and insert it into the
other computer.

Once a DOS disk is in your file system, you can work with its files just as you
do anywhere else in the file system, with these exceptions:

• You do not set permissions for files or folders on a DOS disk, but you can
when you copy them to your system’s disk.

• You cannot rename a DOS disk by editing its name in the icon path. You
have to name it when you initialize it.

You may need to rename a file that you copy from a DOS disk.

When a File or Folder Does Not Fit on One Floppy Disk
If a file or folder is too large to fit on one floppy disk, you can copy it onto
several. To make a backup copy of a 2-Mbyte file, for example, you can copy it
onto two 1.4-Mbyte disks.

1. Copy the file or folder to a floppy disk as you normally would.

2. If what you are copying is too big to fit on the disk, a panel asks if you
want to create a multi-volume file. When you click Yes, the Workspace
Manager copies a “chunk” of the file or folder onto the disk.

3. When the disk is full, a panel asks you to remove the disk from its drive
and insert another one. After doing this, click Proceed in the panel. The
Workspace Manager copies the second chunk.

4. Repeat this for as many disks as needed.
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To copy the file or folder from the disk back into your file system, perform the
following steps:

1. Insert the disk containing the first chunk—a file with a .chunk  extension.

2. Drag the chunk to the folder you want to put it in.

3. When a panel asks for the next chunk, remove the disk, insert the next
one, and click on Proceed.

4. Repeat this until you have copied all the chunks. Make sure to copy
chunks in the order they were originally copied.

5. If you insert a disk in the wrong order, just remove it and insert the
correct one before clicking Proceed.

6. After you copy all the chunks, you can open the file or folder as usual.

Note – The Workspace Manager compresses a file or folder before it copies a
chunk onto the floppy disk. Sometimes this makes the file or folder fit on one
disk, in which case the Workspace Manager does not request an additional disk
after all.

Reusing a Disk
You can erase a floppy disk and change its format by reinitializing it. Just select
the disk (or any file or folder on it), and choose Initialize.

1. Insert the disk into the disk drive.

2. Choose Disk from the Workspace menu and choose Check for Disks from
the Disk menu.

3. Select the disk in the File Viewer.

4. Choose Initialize from the Disk menu.

5. Choose a file format from the pop-up list in the Initialize panel and type a
new name for the disk.

6. Click on Erase.



Working With Disks 8-9

8

Caution – Initializing a disk destroys all files and folders on it. They cannot
be retrieved.

When you choose Initialize, the panel shown in Figure 8-5 on page 8-9 opens.

Figure 8-5 Reusing a Disk

You can give the disk a new name when you initialize it. If the disk is in UNIX
format, you can also rename it later by editing its name in the icon path (just
like you rename a file or folder).

Ejecting a Disk
When you are done using a removable disk, such as a floppy disk or a
CD-ROM, you choose Eject to remove the disk’s contents from the file system,
as shown in Figure 8-6 on page 8-10. Only after you choose Eject and see the
message asking you to eject should you actually remove the disk from the
drive.

1. Select the disk you want to eject.

2. Choose Disk from the Workspace menu.

3. Choose Eject from the Disk menu.

4. When a message asks you to eject the disk, remove the disk from your
system’s disk drive.

!

You can type a new name for the disk here.

Press here if you want to choose
DOS format.

Click to erase the current contents of
the disk.
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Figure 8-6 Ejecting a Disk

Caution – Do not remove a floppy disk from the disk drive before a message
says to, or else you might lose information from that disk or from the next one
you insert.

You can also eject a disk while working in an Open or Save panel. See
“Opening and Saving Files on a Floppy Disk.”

Opening and Saving Files on a Floppy Disk
To make it easy to open and save files on a floppy disk, you can insert and eject
disks while working in an Open or Save panel, as shown in Figure 8-7 on
page 8-11.

Select the
disk (or any
file or folder
on it) and
choose
Eject from
the Disk
menu.

!
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1. When an Open or Save panel is open, insert the disk you want to open
from or save on.

2. Click on the disk button in the panel.

3. Select the file you want to open, or type a name for the one you are
saving.

4. Click on OK in the panel.

Figure 8-7 Saving Files on a Floppy Disk

Caution – Do not remove a floppy disk from the disk drive before a message
says to, or else you might lose information from that disk or from the next one
you insert.

You can use the disk and eject buttons to open and eject a floppy disk,
a CD-ROM, or any other removable disk.

Insert a disk and click here to open it
in the browser. Click the button after
browsing to locate and select the
disk again.

Click here to remove a disk from the
file system so you can safely eject it
and insert another one.

!
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When you have more than one removable disk in your file system, clicking on
the disk button repeatedly selects the next disk. To eject a particular disk when
there is more than one, you must select the disk or a file or folder on it, and
then click on the eject button.

You can browse several disks, one after the other, in an Open or Save panel.
Just insert a disk and click on the disk button. Then after browsing, click on the
eject button, remove the disk, insert another one, and click on the disk
button again.

For information on opening and saving files in general, see Chapter 5,
“Creating and Saving Files.”

The disk and eject buttons in an Open or Save panel perform the same
operations as the Check for Disks and Eject commands in the Workspace
Manager’s Disk menu. See “Workspace Manager Commands” on page A-10.
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This chapter describes how you can type and edit documents. Most of the
examples show Solaris™ OpenStep’s™ Edit application, but any application
that uses text, including the File Viewer and Mail, will use these editing
techniques. The techniques work in text areas of any size, from file names in
the File Viewer to Mail messages to large documents produced in Edit:

• Starting the Edit application
• Typing text
• Selecting text
• Deleting and replacing text
• Moving and copying text
• Finding text
• Replacing text that you find
• Typing special characters
• Previewing special characters
• Setting a new font
• Previewing a font
• Setting margins, indentation, and tabs
• Checking your spelling

Starting the Edit Application
The Edit application is a tool for creating formatted documents. You can start
Edit with its icon in the dock or by opening an RTF file (one with an .rtf  or
.rtfd  extension) from the File Viewer (see Figure 9-1 on page 9-2).
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♦ Double-click on the Edit icon in the dock.

or

♦ Open the /usr/openstep/Apps  folder in the File Viewer and then
double-click on Edit.app .

or

♦ Double-click on the icon for an RTF or RTFD file.

Figure 9-1 Icons That Start Edit

You create an Edit document in a document window. When you start up Edit
from the application dock, an empty document window like the one in
Figure 9-2 on page 9-3 appears. When you start up Edit by clicking on a file
icon, the file is opened in a document window. A window with a document in
it looks like the one in Figure 9-3 on page 9-4. You can also open a new
document window by choosing New from the File menu.

Edit application icon .rtf  file icon .rtfd  file icon
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Figure 9-2 New Edit Document

For information on naming an Edit document, see Chapter 5, “Creating and
Saving Files.”

You can add color or graphic images to a document. See Chapter 10, “Working
With Color,” and Chapter 11, “Working With Graphics.”

Typing Text
You type text in a document or text field using the keyboard (see Figure 9-3 on
page 9-4). As you type each character, it appears in the key window at the
insertion point.

1. Click in the window where you want to type.

2. Type without pressing Return at the end of each line.

3. Press Return to end each paragraph.

4. Click elsewhere to continue typing there.

A new Edit
document is
untitled. You
name the
document
when you
first save it.
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Figure 9-3 Typing to Create a Document

To move the insertion point and select a new place to type, click where you
want the text to be displayed (see Figure 9-4).

Figure 9-4 Moving the Insertion Point

You can also move the insertion point with an arrow key on the keyboard.

You do not have to press Return to end a line as you do on a typewriter.
Applications automatically break lines between words (a process known
as word wrap). You only press Return to cut a line short, as when ending
a paragraph.

The pointer
usually
becomes
an I-beam
when you
can type
text.

The
insertion
point
moves
forward as
you type.

The insertion point is
displayed where you
click.

Text you type is
inserted, and lines in
the paragraph adjust
to accommodate it.
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Keyboard Basics

Most keys on your keyboard are labeled with letters, numbers, punctuation, or
other symbols that the keys generate when you press them (see Figure 9-5).

Figure 9-5 Typical Keyboard Layout for Sun Workstations

• Holding down the Shift key while typing another key gives you either
uppercase letters or the upper characters on keys labeled with two
characters. On most keyboards, you can press Caps Lock if you want to type
uppercase letters without holding down the Shift key. To turn off Caps Lock,
press the key again.

• Press the space bar to insert a space between two characters.

• Press Return to end a paragraph or begin a new line. In some panels,
pressing Return operates a button.

• Press Tab to move to the next tab stop in a document or to the next text field
in a panel. Sometimes, holding down Shift while pressing Tab moves you in
the reverse direction—for example, to the previous field in a panel.

• To delete text, press the Back Space key, which backs up over text one
character at a time.

• On a Sun keyboard, the ◆ and Alt keys work as your Command key and Alt
key, respectively. On the x86 keyboard, the key labeled “Alt” to the left of
the space bar is the Command key, and the key labeled “Alt” to the right of
the space bar is the Alt key. Several uses for these keys are given throughout
this book.
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• When you hold down a key, the character repeats itself. You can use the
Preferences application to adjust the repetition speed. See “Setting the Rate
for Repeating Characters” on page 16-6.

• The numeric keypad provides a convenient way to enter numbers and do
calculations. There is no difference between typing the same character here
and on the main part of the keyboard.

• Finally, if you type when there is no key window or if the key window does
not accept typing, your system beeps so you know that your keystrokes are
not having any effect.

Selecting Text
To edit text, you usually select it first, as shown in Figure 9-6. Your next action,
such as choosing the Delete command, acts on the selection.

♦ Drag across the text you want to select.

♦ Hold down the Alt key while clicking to select a range between the
insertion point and where you click.

♦ Double-click on a word to select it.

♦ Triple-click anywhere in a paragraph to select the whole paragraph.

One way to select text is to drag across it. Drag horizontally to select text on
the same line or vertically to select several lines of text. You can even drag past
the edge of your view—for instance, past the bottom of an Edit window—to
scroll the window’s contents and keep selecting.

Figure 9-6 Selecting the Word “blowout”

The Alt key is useful for selecting large amounts of text, as shown in Figure 9-7
on page 9-7. You can even scroll beforehand to select more than is currently
displayed.

Selected text is
highlighted in gray so
that it stands out.
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Figure 9-7 Selecting Text With the Alt Key

If you select text by double-clicking or triple-clicking on it, you can drag before
releasing the mouse button the final time to extend the selection by a word
or paragraph at a time. If you then Alt-click, the selection is extended to the
next word or paragraph boundary.

Deleting and Replacing Text
Pressing the Back Space key as you type backs up and deletes characters one at
a time. When text (or a graphic image) is selected, the Delete command in the
Edit menu and the Back Space key do the same thing—they delete the selection
(see Figure 9-8 on page 9-8).

♦ To delete text as you type, press the Back Space key.

♦ To delete a block of text, select it. Then choose Delete from the Edit menu
or press the Back Space key.

♦ To replace text, select it. Then type the replacement text.

Click here and
then scroll.

Alt-click to
select to here.

You can Alt-click again to extend
the selection (or shorten it).
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Figure 9-8 Deleting and Replacing Text

When you delete a word that you selected by double-clicking on it, spacing is
automatically adjusted around the remaining words. For instance, if you
double-click on the word automatically in the first sentence of this paragraph
and then delete it, one space remains between is and adjusted instead of two.

Moving and Copying Text
You can move and copy text with the Cut, Copy, and Paste commands in the
Edit menu, as shown in Figure 9-9. In applications where you work with
graphic images, you can typically copy and move them too.

1. Select what you want to move or copy.

2. Choose Edit from the application’s main menu.

3. Choose Cut to move the selection or choose Copy to copy it.

4. Put the insertion point where you want the selection to be displayed.

5. Choose Paste.

Figure 9-9 Moving and Copying Text

Press the Back Space
key to delete the
selection.

Or type text to replace
the selection.

Cut or copy the selection.

Move the insertion point.

Paste the selection.
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Choosing Cut removes the current selection and places it on the
pasteboard—your system’s holding place for information you are transferring
from one place to another. Choosing Copy puts a copy of the selection on the
pasteboard.

The Paste command inserts the contents of the pasteboard at the insertion
point, or if you selected text, in place of the selection.

You can paste text anywhere you can type—somewhere else in a document, in
a text field, even in another application. Just click where you want the text
to go.

A selection stays on the pasteboard until you replace it by choosing Cut or
Copy again. You can therefore keep choosing Paste to paste the same selection
over and over. When you paste a word that you cut or copied after double-
clicking on it, spacing is adjusted around the pasted word.

Finding Text
You can search for a string of text in a document, such as an Edit document or
a Mail message you are composing. You do this with the Find panel as shown
in Figure 9-10 on page 9-10.

1. Choose Edit from the application’s main menu.

2. Choose Find from the Edit menu.

3. Choose Find Panel from the Find menu.

4. Click in the document you want to search.

5. In the Find panel, type the text you want to find.

6. Click on the Next or Previous button.
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Figure 9-10 Finding Text

You can search for any sequence of characters in the standard text character set,
including spaces. In some applications, you can also search for characters such
as tabs and returns.

The Find panels in Edit and Mail have the options listed in Table 9-1 for
searching for text.

Table 9-1 Find Options in Edit and Mail

Option Meaning

Ignore Case Uncheck the Ignore Case box to distinguish between uppercase
and lowercase letters during the search—for example, to locate
“Planet” but not “planet”.

Regular Expression Check this box if you want the Find panel to recognize UNIX
regular expressions, which are described in the UNIX manual
page for ed .

Type what you want to find here.

Click to search
forward or backward
from the insertion
point or selection.

The FInd panel remains
the key window so you
can keep searching for
text by clicking on a
button in the panel.

When text is found, it is
highlighted in the main
window.
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Commands in the Find menu provide other ways to search for text. See
“Standard Commands” on page A-1.

Replacing Text That You Find
In some applications, including Edit and Mail, the Find panel (see Figure 9-11)
provides easy ways to replace each occurrence of text you find with another
string of text. You can replace occurrences one by one, or you can replace them
all at once.

1. Choose Edit from the application’s main menu.

2. Choose Find from the Edit menu.

3. Choose Find Panel from the Find menu.

4. Click in the document you want to search.

5. In the Find panel, type the text you want to find and the replacement text.

6. Click on the Next or Previous button.

7. Click on a replace button.

Figure 9-11 Replacing Text

Note – You can delete one or more occurrences of text you are searching for by
leaving the “Replace with” field empty and clicking on a replace button.

Type the text you want to replace here.

Type the replacement text here.

After you find text, click on one of
these buttons to replace it.
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The Find panel in Edit and Mail has several options (see Table 9-2) for
replacing text you find. In Mail, these options apply only for a message you are
composing.

Setting a New Font
You can give text in a document a different look by setting its font—changing
its font family, making it bold, making it larger or smaller, or combining these
effects. You use the Font Panel, as shown in Figure 9-12 and Figure 9-13 on
page 9-13. The new font you select on the panel applies to text you are about to
type at the insertion point or to text you select.

1. Select the text whose font you want to change, or click where you want to
type text in a new font.

2. Choose Format from the application’s main menu.

3. Choose Font from the Format menu.

4. Choose Font Panel from the Font menu.

5. In the Font Panel, select the font family, typeface, and size you want.

6. Click on Set.

Table 9-2 Replace Options Available in Edit and Mail

Option Meaning

Replace Click on this button after finding an occurrence of text to
replace it with the text in the “Replace with” field.

Replace & Find Click on this button to replace the current occurrence and find
the next one, all in one motion.

Replace All You can use the Replace All button to replace all occurrences of
the text you are searching for. Replace All can apply to the
entire document or to a selection only, depending on the setting
under Replace All Scope.

Entire File If you set the Entire File option under Replace All Scope,
Replace All replaces all occurrences in the document.

Selection You can select a portion of a document and set Selection under
Replace All Scope. Clicking on Replace All then replaces only
the occurrences in the selection.
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Figure 9-12 Font Panel

Figure 9-13 Increasing or Decreasing the Font Size

You can double-click on a font property to set it without clicking on Set. For
example, double-click on 12 in the Size column to make your selection 12
points.

The top of the Font Panel usually displays the current font—the one you are
about to type at the insertion point or the font of text you select (see
Figure 9-14 on page 9-14).

Select a font family by clicking
on it in this column.

Click in this column to select a
typeface within the family.

Or click on this button to undo
selections you have made in the panel.

Type a size for the text in the text
field—decimals are okay—or
click on a size in the column.

Click on this button to apply your
selections to your document.

Type a + or - before a size value to increase or decrease each
character in the selection by a certain number of points.
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Figure 9-14 Current Font

You can apply one font property to a selection without affecting other
properties. For example, you might select the following text:

Third Annual Blue Planet
We are the Earth

This selection includes more than one size and typeface. If you reset its size to
11 points, the whole selection is displayed in 11-point but the typefaces stay the
same:

Third Annual Blue Planet
We are the Earth

If you set a family but not a typeface, for example, by double-clicking on the
family in the Font Panel, a matching typeface in the new family is set
automatically. Changing the above example to Helvetica, for example, makes it
look like this:

Third Annual Blue Planet
We are the Earth

If a matching typeface is not available, setting the family but not a typeface has
no effect.

You can also set font properties by choosing commands such as Bold or Italic
from the Font menu. See “Standard Commands” on page A-1.

In some applications, the Font command is in the main menu. See the user’s
guide for the application.

See also “What Is a Font?” on page 9-15.

The current font is displayed against a
white background.

If you select text that contains more than
one font, the top of the font panel looks
like this.
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Fonts and Special Characters

When you work with symbols and graphic characters that are not standard text
characters, you can change the font family of standard characters in a selection
without affecting the other characters. Just do not set a typeface.

For example, if you select “ Blue Planet,” which is in the Helvetica font
family, and then double-click on Times in the Font Panel, the standard
characters change to Times and the  remains, as in “ Blue Planet.” If you
similarly change “The value πr2” from Helvetica to Times, the standard
characters assume the new font but the π remains. If you instead set a typeface
in either of these examples, the  or π changes to its equivalent standard
character—here, a c or a p.

Some special characters, including π, are actually members of another font
family. See “What Is a Font?.

What Is a Font?

A font is a set of properties—font family, typeface, and size—that determine
what text looks like.

A font family is a collection of characters with a consistent design. Most families
contain standard text characters. Some families, however, have symbols or
graphic characters. The Symbol family, for example, has letters from the Greek
alphabet and mathematical symbols.

Unlike other families, the characters in the Courier family all have the same
width.

A typeface is a variation of a font family, such as Bold, Italic, or Bold Italic. Each
family has its own set of typefaces.

The size of text is measured in points: A point is 1/72 of an inch. Point size is
relative within a font family, so 11-point Times is larger than 10-point Times
but looks smaller than 11-point Helvetica.

All characters—even spaces—have a font. If you put the insertion point after
the space between two words and start to type, the text is displayed in the
same font as the space character (which may not be the font of any neighboring
text character).
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The fonts available for your use will depend on the network you are using, but
the fonts listed in Table 9-3 should be available in most situations.

Previewing a Font
You can see what a font looks like before you actually apply it to your
document, as shown in Figure 9-15 on page 9-17.

1. Choose Format from the application’s main menu.

2. Choose Font from the Format menu.

3. Choose Font Panel from the Font menu.

4. In the Font Panel, select the font you want to preview and click on
Preview.

5. Replace text at the top of the panel with text you want to preview.

6. Delete text you typed to display font names at the top of the panel again.

Table 9-3 Commonly Available Font Families

Font Family Example

Lucida Sans This family is used on the OpenStep windows, and is usually the
default font for Edit, Mail and other documents.

Times This family is popular for memos, letters, or other documents.

Helvetica This family is often used for headlines or headings.

Symbol π ≥ ÷ ≠    ↔ Ω

Courier This is a standard typewriter family.



Typing and Editing 9-17

9

Figure 9-15 Previewing a Font

If you hold down the Shift key while clicking on the Preview button, the
button remains highlighted until you Shift-click on it again. While the button
is highlighted, each selection you make in the Font Panel is previewed at
the top of the panel.

Setting Margins, Indentation, and Tabs
In many applications, you can use a ruler to alter margins, tab stops, and
indentation (see Figure 9-16 through Figure 9-20). The ruler is initially hidden,
but you can display it in a document window with the Show Ruler command.

1. Choose Format from the application’s main menu.

2. Choose Text from the Format menu.

3. Choose Show Ruler from the Text menu.

4. Drag the left and right margin markers to set the margins for the
entire document.

5. Adjust tab and indentation markers to format individual paragraphs.

The previewed font appears here.

You can type to preview your own text.
Delete it when you are through.

Click to preview the font you selected.

Click to undo your selections and return
settings to the current font.
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Figure 9-16 Showing the Ruler in Edit

Figure 9-17 Ruler Markers

Ruler

Indented
paragraph

Text placed
at a tab
stop

Left margin
marker

Body indentation
marker

Indentation marker for first
line only

Tab
marker

Right margin
marker
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Margin Markers

The margin markers  set the left and right margins of all text in the
document (see Figure 9-18).

Figure 9-18 Setting Margins

Tab Stop Markers

To change the tab stops in a paragraph, click or select text anywhere in the
paragraph. Then adjust tab markers in one of the ways shown in Figure 9-19.

Figure 9-19 Adjusting a Tab Stop

Once you adjust the markers, you can press the Tab key anywhere in the
paragraph and the insertion point advances to the next tab position.

Drag a margin
marker.

While you drag, a
gray line shows the
margin position.

When you finish
dragging, tab
and indentation
markers move
with the left
margin.

Drag a tab
marker to
reposition it.

Click just below
the ruler’s scale
to create a tab
marker.

Drag a marker
off either end
of the ruler to
remove it.
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Indentation Markers

Indentation markers also apply to the paragraph where you click or make
a selection. Drag the first line indentation marker ( ) to indent the first line of
the paragraph. Drag the body indentation marker (▼) to indent the rest of the
lines of the paragraph.

When you press Return to start a new paragraph, the new paragraph has the
same indentation and tab stops as the one preceding it. You can also select
several paragraphs to format all at once.

Note – If you drag the first line marker to the left of the body indent marker
you can create a hanging indent. If you then align the body indentation marker
with a tab marker, you can type a bulleted paragraph, like the one in
Figure 9-20.

Figure 9-20 Setting Indentation

You can also use commands in the Text menu to align text in a paragraph and
to copy and paste ruler settings. See “Standard Commands” on page A-1.

The location of the Text command may vary for some OpenStep applications.
For specific information, see the chapter that describes the application.

Drag the ▼
marker to
indent all
but the first
line.

Press Tab
under the
bullet to
type this
paragraph.
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Checking Your Spelling
In some applications, including Edit and Mail, you can quickly locate
misspelled words and choose from possible corrections, as shown in
Figure 9-21 on page 9-22.

1. Click in the document you want to check.

2. Choose Edit from the application’s main menu.

3. Choose Spelling from the Edit menu.

4. Click on Find Next in the Spelling panel.

5. When a misspelled word is found, correct it or select another option from
the panel.

6. Repeat steps 4 and 5 until you have checked the entire document.
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Figure 9-21 Checking Spelling

If a word appears to be misspelled, but is actually correct for the document
you are checking, click on Ignore. For this document only, the panel skips all
other occurrences of the word.

The misspelled
word is highlighted
in the document.

Click to find the next misspelled word.

Select from this list of possible corrections.

Or type your own correction here.

Click to replace the misspelled
word with your correction.
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You can double-click on a word listed in the guess section of the panel to
correct the misspelled word in your document. Then you do not have to click
on Correct.

You can choose Check Spelling from the Edit menu to check spelling without
opening the Spelling panel. See “Standard Commands” on page A-1.

You can even check the spelling of a word that is not in the document you are
checking so that you can determine the correct spelling before you type it, as
shown in Figure 9-22.

Figure 9-22 Checking the Spelling of a Word Not in the Document

Dictionary Options
The Spelling panel checks spelling against an English spelling dictionary. It
also provides options for selecting from other dictionaries you have installed
or for modifying a dictionary.

Dictionary If you have installed additional dictionaries, you can press this
button to choose the one you want to use. The panel checks spelling against
words listed in the dictionary you choose.

Type a word you want to find out how to spell.

Click on Guess to see a list of possible corrections.
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Learn If the panel identifies a correctly spelled word as misspelled, you can
click on Learn to add the word to the current dictionary. The panel then treats
this word as correct when you use any dictionary of the same language.

Forget You can select a word you have added to the current dictionary and
click on Forget to remove the word from the dictionary.

Ignore Click on this button to treat all occurrences of a word as correct for this
document only, without adding the word to the dictionary.

For information on installing additional dictionaries, such as a French or
German dictionary, see the instructions that come with the dictionary.
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Working With Color 10

This chapter discusses the following topics:

• Using color in a document
• Creating color swatches
• Selecting a color from the color wheel
• Selecting colors from the screen
• Mixing your own colors
• Using an image as a palette
• Adding an image to the list of palettes
• Creating your own color list

Where to Find the Colors Panel
You use the Colors command to open the Colors panel.

In text applications like Edit and Mail, the Colors command is in the Font
menu. (Choose Format from the main menu and then choose Font from the
Format menu.) In applications that have color tools, the Colors command is
typically in the Tools menu.

If you want to have the Colors panel at your fingertips, you can create a
keyboard alternative for the Colors command and use it in any application that
has a Colors command. See “Creating Keyboard Alternatives” on page 15-18.
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Using Color in a Document
When you send Mail messages, you can send them in color. When you write a
memo in Edit, you can highlight the text with color. When you want to add
color to documents or even change the background color of your screen, you
select the colors you want from the Colors panel, as shown in Figure 10-1 on
page 10-3.

1. Open the Colors panel.

2. Select the color you want.

3. Drag the color from the color well to selected text in the document.
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Figure 10-1 Using Color in a Document

Some applications have color tools—for drawing in color, for example. These
tools typically use colors from wells in the application’s Inspector panel. To put
color in one of these wells, you select a color in the Colors panel and drag it to
the color well in the Inspector panel.

For more information about the color wheel, see “Selecting a Color From the
Color Wheel” on page 10-5.

For other ways to select colors, see the instructions throughout this chapter.

Drag the color in
this color well to
your document.

Click to select a color from the color wheel.

You can also drag one of these color
swatches to your document.
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Creating Color Swatches
When you need to use the same colors over and over, you can save them as
swatches in the swatch bar at the bottom of the Colors panel, as shown in
Figure 10-2.

1. Open the Colors panel.

2. Select a color.

3. Drag the color from the color well to the swatch bar.

Figure 10-2 Creating Color Swatches

Drag the color from the color well to
the swatch bar.

Enlarge the panel and then drag here
to show several rows of swatches.
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Each swatch has its own cell in the swatch bar. When you drag a new color to
a cell, it replaces the existing color. You can make room for more
swatches—hundreds of them—by making the Colors panel bigger.

All Colors panels have the same swatches. When you put a color swatch in the
swatch bar in one application, it is instantly displayed in the Colors panels in
other applications. The swatch remains there until you replace it with a new
swatch.

Selecting a Color From the Color Wheel
The color wheel is a quick, visual method for selecting colors (see Figure 10-3
on page 10-6).

1. Open the Colors panel.

2. Click on the color wheel button.

3. Click or drag in the color wheel to select the color you want.

4. Drag the brightness slider to make the color lighter or darker.
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Figure 10-3 Selecting a Color From the Color Wheel

As you move the pointer around the wheel, the hues change. Hue is what
distinguishes between red and yellow or yellow and green, for example. The
colors on the rim of the wheel are the most saturated. You can think of
saturation as the intensity of the color—or how much of a particular hue is in
the color. As you move the pointer toward the center of the wheel, the colors
become less saturated and more neutral. At the very center of the wheel, they
appear white.

Color wheel button

Brightness slider

Click to select a color.

Or drag to scan a range of
colors in the color well.

Shift-drag to change the
saturation without changing
the hue.
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What Happens When You Print Colors
The colors you see on the screen can never precisely match printed colors
because screen colors are created with light, while printed colors are created
with pigments. Also, colors printed by different printing methods never look
exactly alike.

However, your OpenStep™ environment has some features that help you get
the color you want. Most colors you select in the Colors panel are calibrated so
that they look the same when you print them on different brands of Level-II
printers.

The exceptions are the CMYK colors described “Mixing Your Own Colors” on
page 10-9. If you are an expert color graphics user and are using a traditional
printing process, you can use these color models to specify colors
numerically—for exact results.

If you are not an expert, you should use one of the other models and a Level-II
printer to produce your printed images. Check the owner’s guide that comes
with your printer to find out if it is a Level-II printer.

Selecting Colors From the Screen
You can capture any color that is on the screen and use it in a document or
save it as a color swatch (see Figure 10-5 on page 10-9).

1. Open the Colors panel.

2. Click on the magnifying glass; then move it to find the color you want.

3. Center the color you want between the crosshairs and click.
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Figure 10-4 Finding the Color You Want to Select From the Screen

When you move the magnifying glass around the screen, it shows a magnified
picture of every pixel you drag it over. (A pixel is one of the dots that makes up
the image on the screen.)

When you click here, the pointer
changes to a magnifying glass.

Use the magnifying glass
to find the color you want.
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)

Figure 10-5 Selecting a Color From the Screen

Mixing Your Own Colors
You can mix your own colors—or shades of gray—using one of four models
built into the Colors panel. Each of these models creates colors differently.

1. Open the Colors panel.

2. Click on the color models button.

3. Click on the color model you want.

4. Drag the sliders to mix the color you want.

You center the
color you want
between the
crosshairs and
click.
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For example, the RGB color model (see Figure 10-6) mixes colors by blending
red, green, and blue light. This is a standard model for representing color on
computer screens. The slider values indicate brightness, which can range from
0 for minimum brightness to 255 for maximum brightness.

Figure 10-6 RGB Color Model

The CMYK color model (see Figure 10-7 on page 10-11) simulates the four-color
printing process, which creates colors by combining cyan, magenta, yellow,
and black inks. The slider values indicate saturation, which can range from 0
for no saturation to 100 for maximum saturation.

Color models button

RGB button

Each of these buttons represents a
different color model.

Adjusting these sliders is like mixing
colored lights.
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Figure 10-7 CMYK Color Model

The HSB color model (see Figure 10-8 on page 10-12) mixes colors by adjusting
hue, saturation, and brightness. You can think of hue as the color name—red,
green, or yellow, for example. Saturation is the intensity, or how much of a
particular hue is in the color. Brightness is how dark or light the color is.

Adjusting these sliders is like mixing inks
on a printing press.

CMYK button
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Figure 10-8 HSB Color Model

In addition to these three color models, you can use the gray scale (see
Figure 10-9 on page 10-13) to work with shades of gray. The values on the
gray-scale slider show the percentage of white in the gray.

HSB button

Adjusting hue, saturation, and brightness
is like using the color wheel—but you can
set precise values.
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Figure 10-9 Gray Scale

If you are working with both color and shades of gray, you can also select
shades of gray with the other models. In the RGB model, you set the same
values for all three sliders. In the CMYK model, you set the cyan, magenta, and
yellow sliders to 0 and adjust the black slider. In the HSB model, you set the
hue and saturation sliders to 0 and adjust the brightness slider.

Grayscale button

Drag to select unlimited shades of gray.

Click to select distinctive shades of gray
well-suited to the screen display.
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Using an Image as a Palette
You can use an image as a color palette, as shown in Figure 10-10. For example,
if you have a cover image for a color brochure, you can keep it in a list of
palettes in the Colors panel. Then you can choose one of the colors from it to
use in the text of the brochure.

1. Open the Colors panel.

2. Click on the palette button.

3. Choose an image from the pop-up list at the top of the panel.

4. Click or drag in the image to select the color you want.

Figure 10-10 Using an Image as a Palette

Some applications come with several images to use as palettes. You can also
add your own images as described in “Adding an Image to the List of Palettes”
on page 10-15.

You can also select a color directly from an image on the screen. See “Selecting
Colors From the Screen” on page 10-7.

Palette button

You choose an image from this
pop-up list of palettes.

Click or drag in the image to select a color.
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Adding an Image to the List of Palettes
You can add images to a list of palettes in the Colors panel to turn any image
file into a palette, as shown in Figure 10-11.

1. Open the Colors panel.

2. Click on the palette button.

3. Choose New from File from the Palette pop-up list.

4. Select an image file and click on OK.

Figure 10-11 Adding an Image to the List of Palettes

When you add an image, it is added to this
pop-up list.

Choose New from File to add the image.

In the browser, select the image file you want to
add to your list of palettes and click on OK—or
drag a file or selection of files directly from the File
Viewer to the image area of the Colors panel.
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You can press Palette and choose Rename to change the name of an image. You
can also remove images from the list with the Remove command. All the
images you add are saved as TIFF files in your ~/Library/Colors  folder.

Using Part of an Image as a Palette

If you want to use part of a color image as a palette, you can do the following:

1. Select the part of the image you want and copy it to the pasteboard.

2. Then open the Colors panel, click on the palette button, and choose New
from Pasteboard from the Palette pop-up list.

3. The image on the pasteboard is displayed in the Colors panel, and it is
listed as an unnamed palette in the list at the top of the panel.

To use the image in the color palette in a document, you can press Palette,
choose Copy, and then use the Paste command in your application to paste it.

Opacity and Transparency—When You Want Layers of Color

Sometimes you want layers of color. For example, you may want to show color
text over a color photograph. Or you may want the text to block part of the
image behind it. You may want the image to show through your words. Or
maybe you want to blend two or more images into a collage of semitransparent
objects that overlap each other but do not block each other out.

In some applications, the Colors panel has an Opacity slider. You can use this
slider to make selected objects and text as opaque or transparent as you want.

When you move the Opacity slider, you begin to see a split pattern in the color
well. It is as though you were looking through a colored glass at a surface that
is half black and half white. The more transparent the color becomes, the more
clearly you see the black-and-white contrast.

In some applications, you can select individual pixels and change their opacity,
so you can make parts of the image transparent.
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Creating Your Own Color List
You can create your own list of colors, as shown in Figure 10-12 on page 10-18,
and select them by name in the Colors panel. For example, if you have a
publication that uses a standard palette of colors, you can name the colors and
save them in a list.

1. Open the Colors panel.

2. Select the first color you want to put in the list.

3. Click on the Color List button.

4. Choose New from the List pop-up list.

5. Select another color, click on the Color List button, press Color,
and choose New.

6. Repeat step 5 for each color in the list.
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Figure 10-12 Creating Your Own Color List

When you create a list, it is displayed as an unnamed list in the pop-up list at
the top of the panel. You can choose Rename from the List pop-up list to give
it a name, as shown in Figure 10-13 on page 10-19.

Select a color using any of
the methods in this chapter.

When you choose New here, a
new unnamed list opens.

The currently selected color is the first
color in the new list.

Color List button
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Figure 10-13 Renaming the Color List

You can choose Rename from the Color pop-up list to name individual colors
in the list, as shown in Figure 10-14.

Figure 10-14 Renaming a Color

You can add as many colors as you want to the list. You just select each color
one at a time and choose New from the Color pop-up list (see Figure 10-15 on
page 10-20).

Choose Rename from the
List pop-up list to name
the list.

Choose Rename from
the Color pop-up list to
name the selected color.
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Figure 10-15 Adding Colors to a Color List

You can choose Remove from the Color pop-up list to remove selected colors
you do not want in the list. If you no longer need the list, you can choose
Remove from the List pop-up list to remove it.

When you choose New here, the color
in the color well is added to the list.

Or you can drag a color directly from the
color well or from a color swatch to the
list. You can also drag from a color well in
another application.
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If Your Application Supplies Color Lists
Some applications supply color lists. They are stored in files with the extension
.clr . You can open these lists in the Colors panel and use them like the color
lists you create. You can choose Open from the List pop-up list to find them in
your file system. When you select a .clr  file and click on OK, it is displayed
in the list. You can also drag the file icon directly into the list in the Colors
panel.

All color lists that you create as well as those you get from applications are
kept as .clr  files in your ~/Library/Colors  folder. When you open an
application’s list with the Open command, a copy of the original file appears in
the folder. When you remove the color list, the original file remains in your file
system.

Caution – If you remove a list you created, the Remove command permanently
removes it from the file system, and it can no longer be retrieved.!
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Working With Graphics 11

You can drag or paste graphic images into your pages in most OpenStep™
applications. You can preview how your pages will look before you print them.
This chapter describes the following topics to help you work with graphics:

• Adding a graphic image
• Previewing pages
• Previewing graphic images

Adding a Graphic Image
You can add a graphic image to documents such as Edit documents or
Mail messages (see Figure 11-1 on page 11-2). The image may be a file in TIFF,
EPS, or another graphics file format.

1. Click in the document where you want the graphic image to appear.

2. Drag the icon for the graphic file from the File Viewer into the document
window.

If you add a graphic image to an Edit document that contains only text, the
document is converted to an untitled RTFD file. (RTFD files are Edit file
packages that contain rich text and one or more graphic images.)
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Figure 11-1 Adding a Graphic Image

If you want to add only part of a graphic image, you can use the commands in
the Edit menu to copy what you want from the graphics document and paste it
in the document where you want to add it.

You cannot modify the contents of graphic images you add to text documents.
You can only move, copy, or delete them with the commands in the Edit menu.

For more information about file packages, see “File Packages—Files That Are
Really Folders” on page 3-27.

You select graphic images you want to copy differently in different
applications. For more information, see the user’s guide for your application.

You drag
the icon for
a graphic
file into the
document.

The pointer changes to a  to
show that you are adding a
copy—not the original file.
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Graphics File Formats
Graphic images and the documents they are created in can be stored in a
number of different formats. The most common are shown in Table 11-1.

For more information, see “What Is a PostScript File?” on page 14-6.

Previewing Pages
You can preview your pages on screen before you print them, so you can see
how they will look when you print them (see Figure 11-2 on page 11-4).

1. Choose Print from your application’s main menu and then click on
Preview.

2. Double-click on a PostScript (PS) file, if you have saved your pages in
this format.

Table 11-1 Graphics File Formats

Icon Format

TIFF Tagged image file format is a format for single-page or
smaller images. TIFF files typically include gray-scale or color
halftones (such as photographs or shaded art) or screen images,
as well as other kinds of art. TIFF files have a .tiff  extension.

EPS Encapsulated PostScript is another format for single-page
or smaller images. EPS files typically include black-and-white,
gray-scale, or color text or line art (such as technical drawings),
as well as other kinds of art. Unlike TIFF files, EPS files
can look good at almost any scale or resolution. Many
illustration applications create EPS files. EPS files have an .eps
extension.

PS PostScript™ is a format for single- or multiple-page files.
They can include the same kinds of information as EPS and
TIFF files, but they also include information about how text and
images are oriented on one or more pages. PS files can include
fonts and printer-specific information for how they should be
printed. As a rule, you cannot add PS files to your documents,
but you can open them in Preview and print them. PS files have
a .ps  extension.
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When you click on Preview or double-click on a PostScript file that has a .ps
extension, the Preview application starts and displays the first page of the file
in a window.

Figure 11-2 Previewing a Page

You can use the commands in the Display menu to switch pages, enlarge or
reduce the scale of the pages in the window, and change how your pages are
displayed in other ways.

Type the number of
the page you want to
preview and press
Return.
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Note – If you are having trouble previewing a file, start the Preview
application in the /usr/openstep/Apps  folder. Then try to open the file with
the Open command in Preview’s File menu, but click on Use Simple Mode in
the Open panel before clicking on OK. Some of Preview’s commands are not
available in simple mode, but you can open a wider range of graphics files.

For more information about PostScript files and how to create them, see
“Saving Your Pages as a PostScript File” on page 14-5.

For more information about the commands in the Display menu, see “Preview
Commands” on page A-31.

Previewing Graphic Images
You can preview a graphic image in TIFF, EPS, and other graphics file formats
to see how it will look when you add it to a document or print it (see
Figure 11-3).

1. Start up the Preview application by opening the /usr/openstep/apps
folder and double-clicking on Preview.app .

2. Choose File from the Preview menu.

3. Choose Open from the File menu.

4. Select a graphics file in the panel.

5. Click on OK.

Figure 11-3 Previewing a Graphic Image

Use the Zoom In and Zoom Out commands in the Display menu to enlarge
and reduce the image.

A graphics file opens in a
Preview window sized to
fit the image.
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You can also use the Inspector command on the Workspace Manager menu to
preview a graphic image. See “Previewing the Contents of a File” on page 7-3.
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The Solaris™ OpenStep™ Mail application enables you to receive and send
messages, which may contain text, sound, graphic images, and even entire files
or folders.

This chapter describes how to do the following:

• Start Mail
• Open a message
• Listen to a recording
• Open a file or folder in a message
• Send a message
• Attach a file or folder
• Forward a message
• Reply to a message
• Record and insert sound in a message
• Edit sound
• Save and restore a draft

Starting Mail
The Mail application is a tool for exchanging electronic messages with other
people on a network or with others who have home folders in your system.

When Mail starts, a window displays the contents of your Active mailbox, as
shown in Figure 12-1 on page 12-2. The Active mailbox is where all new
messages are delivered.
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♦ Double-click on the Mail icon in the application dock.

or

♦ Open the /usr/openstep/Apps  folder in the File Viewer and
double-click on Mail.app .

Figure 12-1 Active Mailbox Window

Click on the Get Mail button to receive your undelivered mail. When you
become familiar with the Mail application, you will probably want to set it up
for automatic delivery. See “Tailoring How You Receive New Messages” on
page 13-18 for more information.

A one-line
summary of each
message you
receive is
displayed in the
summary area.

Drag to see
more or fewer
summaries at
once.
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When a Mailbox Is Already in Use

If a panel warns that your mailbox is locked when Mail starts up, one of two
causes is probable:

• Your Active mailbox is open on another system on the network. Click on
Cancel in the panel so the mailbox does not open on this system.

• Your last Mail session ended abnormally, because of a power failure, for
example. The mailbox is not open anywhere else so you can click on OK to
open it now.

When working on a network, do not open the same mailbox on more than one
system at once or you might lose mail from that mailbox. If you tend to log
into several systems and you have set Mail to start automatically, you should
set it to start hidden, which prevents your Active mailbox from opening at
startup. To do so, do the following:

1. Choose Preferences from the Info menu.

2. Then check the Hide on Auto-Launch box in the Preferences panel.

Note – You can also use the Mail application by choosing a command from an
application’s Services menu. See “Standard Commands” on page A-1.

Opening Messages
Messages you receive are listed in the summary area of your Active mailbox.
When you select a message in the summary area, its contents appear in the
message area below, as shown in Figure 12-2 on page 12-4.

1. Select the message you want to look at by clicking it in the summary area.

2. Click on the down arrow button to select the next message, or click on the
up arrow to select the previous one.
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Figure 12-2 Opening a Message

As a shortcut, you can press Return to operate the down arrow button, and
you can hold down Shift while pressing Return to operate the up arrow button.

After reading your messages, you can hide Mail. As long as Mail is running,
you can tell if there are new messages by the appearance of its icon in the dock
(see Figure 12-3).

Figure 12-3 Mail’s Icon Tells You About Unread Mail

Note – You can receive a sound signal when new messages arrive. See “Setting
a Sound to Announce New Messages” on page 13-20.

A  in the
summary
line means
the message
is unread.

The
message
area shows
the current
message.

Date and
time the
message
was sent

An
means that
the message
is a MIME
message,
that includes
text
formatting,
sound,
attachments,
or graphics.

Click to step
through your
messages.

If your
system
administrator
has enabled
this feature,
the sender’s
picture can
be displayed
here.

New messages No new messages
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Listening to a Recording
You might receive a sound recording in a message. The recording is displayed
as an icon, as shown in Figure 12-4. If your computer can play sounds, you can
play back the recording, as shown in Figure 12-5 on page 12-6.

1. Double-click on the sound icon in the message.

2. Click on Play in the Lip Service panel.

Figure 12-4 Message With Three Recordings

When you
double-click
on a sound
icon, the Lip
Service panel
opens.
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Figure 12-5 Playing Back the Recording

The buttons in the Lip Service panel work like those on a standard
tape recorder.

Opening a File or Folder in a Message
You might receive a message with a file attached to it—or a folder containing
several files. The file or folder is displayed as an icon on which you can
double-click to see its contents (see Figure 12-6 on page 12-7).

♦ Double-click on the file or folder in the message.

Click to play the recording.

During playback this meter
indicates the sound level of
the recording.

Click to pause during playback.
Click again to resume.

Click to stop playback before
the end.
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Figure 12-6 Opening a File and a Folder Attached to a Message

A file opens in its associated
application.

A folder opens
in its own
Workspace
Manager folder
window.
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You can edit the contents of the file and save your changes. If you then send
the message to anyone else—for example, by forwarding it—the file with your
changes goes with it.

If you want to keep a copy of the file or folder, drag it out of the mailbox
window to one of your folders in the File Viewer. You can also drag a graphic
image out of the window to keep a copy of it.

Sending a Message
You can send a message to one person, a group of people, or a combination of
individuals and groups. You address the message directly to at least one
person or group. You can also send a “carbon copy” to anyone else who should
see the message. You address and compose a message in a Compose window,
shown in Figure 12-7 on page 12-9.

1. Click on the Compose button in a mailbox window.

2. Address the message and type a brief summary of it.

3. Compose your message.

4. Click on the Deliver button.
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Figure 12-7 Sending a Message

You can type your message, set fonts, and make ruler settings just as you can
in any standard document, such as an Edit document. To add a graphic image,
drag a TIFF or EPS file into the message from the File Viewer or from another
Mail window. You can also paste text or images copied from a Mail window or
from another application.

Figure 12-8 Triangle Reminder

When you include a graphic image in a message, Mail delivers a copy of the
image. The file that contains the original remains wherever you dragged
it from.

Type at least one
address here.

Type a brief
summary here.

Send carbon copies
by typing addresses
here. Separate
addresses with a
comma or space.

Click to deliver the
message.

Compose the
message here.

When you set fonts, make ruler settings, or add images, a
triangle reminds you to send the message only to people
running OpenStep mail.
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If you change your mind about sending a graphic, you can delete it just as you
would delete text—for example, by pressing the Back Space key.

If you do not know an address, you can look it up. See “Looking Up Mail
Addresses” on page 13-5.

Note – For more information on typing, formatting, and adding images, see
Chapter 9, “Typing and Editing” and “Adding a Graphic Image” on page 11-1.

Note – For a summary of the buttons in a Compose window, see “Mail Buttons
and Commands” on page A-17.

You can send your message to computers that do not run OpenStep mail, such
as those on a NetWare network. Some of these computers will be able to
receive MIME messages, include formatting, graphics, and attachments, but
others will not. To be sure that what recipients who are not running OpenStep
mail see matches what you send them, set the mail format button to MIME
mail before delivering the message (see Figure 12-9).

Figure 12-9 Mail Format Button

Note – Formatting, graphics, sounds, or file or folder attachments generate
unintelligible messages on computers that cannot receive MIME mail. If your
message is going to other kinds of computers, switch the mail format button to
Plain Text before delivering the message.

If you log out when a Compose window is open, without saving or delivering
the message in it, a panel asks if you want to save your draft before closing it.
If you click on Save, the message is saved in your Drafts mailbox.

Note – Use only ASCII characters in the address and Subject fields. Mail
converts any other types of characters to ASCII characters.

Click to send your
message to a computer
that can display MIME
messages.

Click to send your
message to a
computer that
cannot display
MIME messages.
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What Is Plain Text Mail?

When you click on the Plain Text button in a Compose window, the text in
your message is displayed in a fixed-width font, such as Courier. Any
formatting is lost and line length is limited to 72 characters.

Also, if there are any graphic images, sounds, or attachments in the message, a
panel asks you to remove them. Remove them and click on Plain Text again.

As you type your message, word wrap works as usual. But when you send the
message, Return characters are added to the ends of lines, as required by the
receiving computer.

You should include only ASCII characters in a message to a computer that does
not run OpenStep. Mail converts any other characters to ASCII. For example, it
converts an em dash (—) to a hyphen (-).

You can change the maximum line length of plain text messages. See “Expert
Preferences” on page 13-29.

Addresses and Some Options for Entering Them

A person’s address is usually his or her user name. Your system administrator
may also have set up group addresses, such as BP_publicity,  that allow you
to send messages to a specific group of people.

To send a message to someone on another network, you need to include
information about the network. Such an address might look like
sammi_wright@globalvoice.com .

You can look up the address of a person or a group on your network with the
Addresses panel. See “Looking Up Mail Addresses” on page 13-5. A person’s
address also is displayed in the summary of any message that person sends to
you.

If you want to type a long list of addresses in a Compose window, choose Send
Options from the Compose menu and type the list in the Send Options panel
(see Figure 12-10 on page 12-12). (This panel has a large area for listing more
addresses than can fit in a Compose window field.) Then press the button at
the top of the panel to choose a type of address, as follows:
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• Choose To or Cc to insert the addresses in the Compose window’s To or Cc
field.

• Choose bcc (blind carbon copy) to send hidden copies of the message.
Whoever you enter here receives a copy of the message, but no other
recipients know because the bcc list is not displayed in the message.

Figure 12-10 Send Options Panel

You can also have replies to your message go to one or more addresses other
than your own. Type the addresses in the Reply-To field. When recipients click
Reply in their mailbox window to reply to your message, any address you type
here is inserted in their To field. If you also want a reply, type your address
here too. For more information, see “Replying to a Message” on page 12-16.

You can specify a Reply-To address for all messages you send with the
Preferences command in the Info menu. See “Mail Buttons and Commands” on
page A-17.

Attaching a File or Folder
You can include a file or even an entire folder in a message, as shown in
Figure 12-11 on page 12-13. Just drag the file or folder from the File Viewer or
any other Workspace Manager folder window. You can even drag a selection
icon into your message to attach all the files and folders in the selection.

Type a list of addresses
here.

Press here to choose a type
of address.

Type the address of any
person or group you want
to receive replies to the
message.

Check here if you want the
message archived.
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1. Click in the Compose window where you want the file or folder to be
displayed.

2. In the Workspace Manager’s File Viewer, select the file or folder you want
to send.

3. Drag the selection from the icon path into the Compose window.

Figure 12-11 Attaching a File

Note – File or folder attachments generate unintelligible messages on
computers that cannot read MIME mail.

You can also copy or drag a file or folder from another Compose window or
from a mailbox window.

Drag a file or folder
from the File Viewer.

The triangle
reminds you
to send the
message only
to people
using
computers
running
OpenStep.

The file or folder appears where you last
clicked or in place of the current selection.
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When you click on Deliver, Mail delivers a copy of the file or folder. The
original remains wherever you dragged it from.

If you change your mind about attaching a file or folder, you can delete it from
the message, for example, by pressing the Back Space key.

Forwarding a Message
You can quickly forward a message to others who may want to read it, as
shown in Figure 12-12 on page 12-15.

1. Open the message you want to forward.

2. Click on the Compose button in the mailbox window.

3. Click on Forward in the Compose window.

4. Address the message.

5. Click on Deliver.
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Figure 12-12 Forwarding a Message

You can forward several messages all in the same message. Just open each
message in your mailbox window and click on Forward in the Compose
window. Each message is inserted following anything that is already there.

Click to copy the
current message
and its subject
into a Compose
window.

Insert anything
you want to add
to the message.

Fill in the
addresses.

Mail adds
information
about where the
message came
from.
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When you copy a message into a Compose window with the Forward button,
all formatting is copied, too, as well as any recordings, graphics, or file or
folder attachments.

Note – You can remove formatting from a message you are forwarding
by choosing Make ASCII from the Utilities menu. See “Mail Buttons and
Commands” on page A-17.

Replying to a Message
If you want to reply to a message, you can quickly copy the sender’s address
and subject into a Compose window, as shown in Figure 12-13 on page 12-17.
Just click on the Reply button in your Compose window. To then copy the
addresses listed in the message’s Cc field, click on the button again.

1. Open the message.

2. Click on the Compose button in the mailbox window.

3. Click on Reply in the Compose window.

4. Click on Reply All to also send the reply to those who received a carbon
copy of the original message.

5. Type your reply.
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6. Click on Deliver.

Figure 12-13 Replying to a Message

If the sender used the Send Options command to route your reply to an
address other than his or her own, clicking Reply fills the To field with that
address. See “Addresses and Some Options for Entering Them” on page 12-11.

Note – Use Forward and Reply together to include a copy of the original
message to which you are responding. If recipients of your message do the
same thing, their replies will contain all of the earlier messages in the
exchange, and the message history will grow.

Recording and Inserting Sound in a Message
If your system can record sounds, you can include a sound recording in a
message, as shown in Figure 12-14 on page 12-18 and Figure 12-15 on
page 12-19.

The Reply
button
alternates
between Reply
and Reply All
when you click
on it.

Reply fills these
fields.

Reply All fills this
one.

You just type
your reply.
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You can use the Play button to play back your recording before inserting it. If
you do not like the recording, just record over it or click Erase. You can also
close the Lip Service panel without inserting the recording. Unless you erase it,
the recording will be there when you next open the panel.

1. While composing a message in a Compose window, click on the Lip
Service button.

2. Click on Record in the Lip Service panel and record through your
computer’s microphone.

3. Click on Stop when you are finished.

4. Click in the Compose window where you want the sound icon to be
displayed.

5. Click on Insert.

Figure 12-14 Recording a Sound

Click to begin recording.

This meter displays the
recording’s sound level.

Click to insert the recording in your message.Click when you are finished recording.
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Figure 12-15 Including the Sound in a Message

If you change your mind about sending a recording after you insert it, delete
the sound icon, for example, by pressing the Back Space key.

For more information on using a microphone with your computer, see the
owner’s guide for the computer or for any devices you have attached to it.

Editing Sound
You can edit a recording you have made or received by modifying its
waveform in the Lip Service panel, as shown in Figure 12-16 on page 12-20,
Figure 12-17 on page 12-21, and Figure 12-18 on page 12-22.

1. Double-click on the sound icon.

2. Click on the waveform button in the Lip Service panel.

3. Select a portion of the waveform or click somewhere in it.

Click to open
the Lip
Service
panel.

The sound
icon is
inserted
where you last
clicked.

The triangle
reminds you
to send the
message only
to people
using
computers
running
OpenStep.
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4. Use Edit menu commands to edit the waveform. Or click Record to insert
new material.

5. Click on Play to listen to the result.

Figure 12-16 Displaying the Waveform of the Current Sound

Click to display the
waveform for the current
sound. Click again to hide
the waveform.

Scroll to see the entire
waveform.

Resize to see more of the
waveform at once.
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You can select a segment of the waveform, as shown in Figure 12-17. Then click
on Play to play back the segment. Click on Record to record over it. Or choose
Cut or Copy from the Edit menu to move or copy it.

Figure 12-17 Selecting a Segment of the Waveform

You can also click in the waveform where you want to insert new material (see
Figure 12-18 on page 12-22). Then click on Record to record the material, or
choose Paste to insert a segment you cut or copied.

Drag across the waveform
to select a segment of it.
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Figure 12-18 Inserting New Material in the Waveform

Caution – The Erase button erases the entire recording, even when only a
segment is selected.

Saving a Draft
You can save the contents of a message you are composing, much as you save
the contents of a document, as shown in Figure 12-19 on page 12-23. You might
do this when composing a message you want to finish later or to save versions
of a message as you type it.

1. Choose Compose from the Mail menu.

2. Choose Drafts from the Compose menu.

3. Choose Save in Drafts from the Drafts menu.

An insertion point is
displayed where you click.

!
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Figure 12-19 Saving a Draft

If you close a Compose window without saving or delivering the message in it,
a panel asks if you want to save your draft before closing it. If you click on
Save, the message is saved in your Drafts mailbox.

Each time you save a draft, Mail saves another version of the message in the
Drafts mailbox—it does not replace the last version you saved.

Remember to delete drafts you do not need anymore from the Drafts mailbox
so they do not take up disk space.

Restoring a Draft
You can restore the last draft of a message you saved so you can resume
working in it, as shown in Figure 12-20 on page 12-24. Just choose the Restore
Draft command. A Compose window opens that contains your draft, exactly as
when you last saved it.

The subject and
addresses you
have typed are
saved too.

Mail saves the
contents of your
Compose
window as a
message in the
Drafts mailbox,
which it creates
for you.
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♦ To restore the last draft you saved, open the Compose menu and choose
Restore Draft from the Drafts menu.

♦ To restore an earlier draft, open the Drafts mailbox, select the message,
and choose Restore Draft.

Figure 12-20 Restoring a Draft

To restore an earlier draft, you must open the Drafts mailbox, select the
message summary of the draft you want to restore, and choose Restore Draft.

You open the Drafts mailbox using the Mailboxes panel.

Mail restores your
subject and
addresses too.

Mail opens a
Compose
window
containing the
draft.
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Besides getting and sending messages, you can use the Mail application to
create and manage the contents of mailboxes, find out someone’s mail address,
send messages to groups of people, and set a variety of other personal
preferences. The contents of this chapter show you how to do the following:

• Delete messages
• Compact a mailbox to free disk space
• Look up Mail addresses
• Create a Mail address book
• Create your own group address
• Create a mailbox
• Move messages to another mailbox
• Find messages
• Focus on a group of messages
• Tailor how you get new messages
• Set a sound to announce new messages
• Create headers for messages you send
• Tailor headers in messages you receive

Deleting Messages
You can let important messages accumulate in your mailbox. But you should
delete messages you do not need (see Figure 13-1 on page 13-2)—especially if
they contain sounds, graphic images, or attached files or folders, which can
take up a large amount of disk space.
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1. Select the message or messages you want to delete in the summary area.

2. Click on the Delete button or press the Back Space key.

Figure 13-1 Deleting a Message

If you can tell without reading a message that you want to delete it, hold down
the Control key while clicking on its summary to select the message without
waiting for its contents to appear.

Table 13-1 on page 13-3 summarizes the ways in which you can select
messages.

Note – You may be able to restore a message you deleted with the Undelete
command in the Edit menu. See “Mail Buttons and Commands” on page A-17.

Deletes the
selected
message or
messages.
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.

Compacting a Mailbox to Free Disk Space
Deleting a message removes it from the mailbox, but it does not remove the
message from the system. To do that, you have to compact your mailbox, as
shown in Figure 13-2 on page 13-4.

Caution – If you do not periodically compact your Active mailbox, messages
accumulate and unnecessarily take up disk space. Once you compact, however,
messages you have deleted from the mailbox are destroyed permanently—you
cannot restore them with the Undelete command.

1. Open the mailbox you want to compact.

2. Choose Utilities from the Mail menu.

Table 13-1 How to Select a Message

What You Do What Happens

Drag Selects the messages you drag across

Shift-click Adds the message to the selection, or removes it from the
selection

Alt-click Selects all messages between the one you click and the last one
you selected

Control-click Selects a message without opening it

!
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3. Choose Compact from the Utilities menu.

Figure 13-2 Compacting a Mailbox

You delete a message. The message is removed
from your mailbox.

You choose Compact. All deleted messages are removed
from disk permanently. Remaining
messages in the mailbox are
renumbered.

But it remains on your list and you
can retrieve it with the Undelete
command.
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Looking Up Mail Addresses
You can look up the addresses of other people and groups on your network
with the Addresses panel, as shown in Figure 13-3. This panel lists addresses in
a browser.

1. Open a Compose window and click the Addresses button.

2. Click on the type of address for which you are looking.

3. Select an address, or type part of a name and click on Find.

4. Click on the To or cc button to copy the address into your Compose
window.

Figure 13-3 Looking Up a Mail Address

You can copy several addresses, one after the other, into a Compose window.
Just select an address and click To or cc. The button appends the address to any
already in the corresponding Compose window field.

You can use the Find button in the Addresses panel to search for an address
based on any text in it, as shown in Figure 13-4 on page 13-6. For instance, if
you type greg  in the Name field and click on Find, Mail can find addresses
like Greg.McLaughlin  or gregm@dublin . Click on Find again to find the
next occurrence of text in the list.

Click on the type of
address for which you
are looking in the Types
column.

Click to select an
address. Or type the
first few characters.

If the person has a
picture in the system,
it is displayed here.

Click to copy the
address into a field in
the Compose window.
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Figure 13-4 Using the Find Feature

When you select an individual’s address, a picture is displayed if your system
administrator has set up Mail that way. For groups, and for people who do not
have pictures in the system, the panel displays silhouette icons.

Understanding the Types Column

You can look up addresses in one of five lists described in Table 13-2. You select
a list from the Types column.

Table 13-2 Types Used on the Address Panel

What You Do What Happens

Users List all addresses for everyone on your network

Groups Lists group addresses available to everyone on the network

Login Names Lists the user name of each person on the network

Private Users Lists addresses that you use frequently

Private Groups Lists group addresses you create

Type any part of the
address here.

Click on Find.

Mail finds an address
in the current list.
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Addresses in Users, Groups, and Login Names are defined by your system
administrator. You add the Private Users and Private Groups addresses
yourself. See “Creating a Mail Address Book” next and “Creating Your Own
Group Address” on page 13-8.

Creating a Mail Address Book
You can keep your own list of addresses in the Private Users list of your
Addresses panel (see Figure 13-5). Maintaining such a list for addresses you
use frequently saves you the trouble of searching through long lists to find
them.

1. Open a Compose window and click the Addresses button.

2. Click on Private Users in the Types column of the Addresses panel.

3. Type an address in the Name field.

4. Click on Add.

Figure 13-5 Creating Private User Sammi Wright

Once an address is in your Private Users list, you can select it and click on the
To or cc button to copy the private address to the Compose window.

Type an address here.

Click here to add it.

The address is added
to your Private Users
list.
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To remove an address from your Private Users list, select the address and click
on the Remove button.

Note – If you open a message from someone whose address you want to add
to your Private Users list, choose Add Private User from the Utilities menu.
The sender’s address is automatically added to your list, even if the Addresses
panel is not open.

Creating Your Own Group Address
In addition to the group addresses set up by your system administrator, you
can create some for your own use, as shown in Figure 13-6 on page 13-9. You
might create an address for sending messages to everyone working on a
particular project. When naming a group, do not use a comma or a space.
Otherwise, follow the same guidelines as for naming files and folders.

1. Click on the Addresses button in a Compose window.

2. Click on Private Groups in the Types column of the Addresses panel.

3. Type a name for the group address and click on Add.

4. In the Private Groups column, select the group address you just created.

5. Type an address you want assigned to the group and click on Add.

6. Repeat step 5 for each address in the group.
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Figure 13-6 Creating Private Group “Festival_Planners”

The group automatically includes your own address. You can add other
addresses by selecting the group, typing an address, and clicking on Add again
(see Figure 13-7).

Figure 13-7 Adding Poupon to Festival Planners

Select Private Groups.

Type a name for the
group here.

Click on Add.

The new group is
displayed in Private
Groups after you click
on Add.

Select the group.

Type an address here.

Click on Add.

The new address is
displayed in the group
after you click on Add.
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To remove an address from the group, select the address and click on Remove.
You cannot remove the last remaining address associated with a group (so if
you want to remove your own address, you have to add another one first). But
you can remove the entire group by selecting its name in the Private Groups
column and clicking on Remove.

Note – You can create a shorthand address for one person. Just create a group
and assign only that person to it. For example, if you send messages frequently
to the address sammi_wright@globalvoice.com , you might create the
group sammi, add his address to it, remove your own, and then send messages
to him using the shorthand address.

For more information on naming a group address, see “Guidelines for Naming
Files and Folders” on page 5-6.

Creating a Mailbox
Instead of letting messages accumulate in your Active mailbox, you can
organize them in other mailboxes. You create and manage mailboxes with the
Mailboxes panel, as shown in Figure 13-8 on page 13-11.

1. Click on the Mailboxes button in a mailbox window.

2. Type a name for the new mailbox in the Mailboxes panel.

3. Click on New.
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Figure 13-8 Creating the Festival Mailbox

When you create a mailbox, an empty mailbox window opens for it.

You can also open a mailbox to see its messages (see Figure 13-9 on
page 13-12). Or you can delete the mailbox to destroy all the messages in it. If
you delete your Active mailbox, Mail creates another, empty Active mailbox
the next time you start it.

Type a name for a mailbox.

Click on New to create it.

The new mailbox is displayed in the list.
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Figure 13-9 Opening the Festival Mailbox

You can select a mailbox in the list by clicking it or by typing the first few
characters of its name.

Note – You can create a mailbox that collects outgoing messages using the
Preferences command in the Info menu. See “Mail Buttons and Commands” on
page A-17.

Moving Messages to Another Mailbox
After you create a mailbox, you can move messages to it from your Active
mailbox. You can also move messages between any mailboxes you create. See
Figure 13-10 on page 13-13.

1. In a mailbox window, select the messages you want to move.

2. Click on the Mailboxes button.

3. In the Mailboxes panel, select the mailbox to which you want to move the
messages.

Select the mailbox you want to open or delete.

Click here to open it.

Click here to delete it.
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4. Click on Transfer.

Figure 13-10 Moving Messages to the Festival Mailbox

You can also use Edit menu commands to move selected messages. Choose Cut
from the Edit menu. Then click in the summary area of the mailbox window
you are moving to and choose Paste.

Select the
mailbox to
which you want
to move them.

Click on Transfer.

Select the
messages you
want to move.
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Note – After removing messages from a mailbox window, remember to
compact the mailbox.

A Mailbox Is a File Package

Your Active mailbox and any mailboxes you create are actually file packages
with an .mbox  extension. Mail keeps these file packages in the Mailboxes
folder in your home folder.

You do not have to open a file package to read the messages in a mailbox. It is
easiest to read and maintain messages in the mailbox window.

For information on selecting several messages to move at once, see Table 13-1
on page 13-3.

Finding Messages
You can find a message by searching for any text in its summary, as shown in
Figure 13-11 on page 13-15. You can search for text in the message’s subject,
message number, date, or sender’s address. Any message that is found is
highlighted in the summary area.

1. Click in the summary area of the mailbox window.

2. Choose Find from the Edit menu.

3. In the Find panel, type what you want to find.

4. Choose the options you want.

5. Click on Next, Previous, or Find All.
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Figure 13-11 Finding a Message

To open a message that you find, you have to click on its summary.

You can also open the Find panel by clicking on the Find button if it appears in
the Mailbox window. The Find button replaces the Get New Mail button when
you have Mail set up to retrieve new messages automatically (see “Tailoring
How You Receive New Messages” on page 13-18).

Click on any
summary.

Type the text for
which you want to
search here.

Click to select all
message
summaries that
contain the text.

Click to search
forward or
backward.
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Note – You can also search for text in a message—either one you received or
one you are composing. See “Finding Text” on page 9-9.

Note – You can use commands in the Sorting menu to sort message summaries
in a variety of orders.

Focusing on a Group of Messages
You can find all messages in a mailbox that have your search text either in their
summaries or in the messages. You can then “focus” on those messages,
temporarily hiding others so it is easy to find a particular message.

1. Click in the summary area of a mailbox window.

2. Click on the Find button.

3. In the Find panel, type the text you want to find.

4. Select the options you want.

5. Click on Find All.

6. Open the Message menu and choose Focus.

7. When you are finished reviewing the messages resulting from the search,
choose Unfocus.
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Figure 13-12 Focusing on a Group of Messages

As a shortcut, you can hold down the Alt key and click on Find All to have
Mail find the messages and then focus on them automatically.

To narrow your search, you can do another Find All search and choose Focus
again to display the results of that search in the mailbox window. You can keep
selecting messages and choosing Focus as many times as you want.

Type the text for which you want
to search here.

Click on Find All to find all
messages that contain the text.

When you
choose Focus,
Mail displays all
the messages
selected by the
search.
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To see all your messages again, choose Unfocus. Mail also displays all
messages the next time you open the mailbox.

You can stop a search before it is complete by holding down the Command key
and typing a period (.).

Tailoring How You Receive New Messages
Before messages addressed to you actually reach you, they are collected in a
central “post office”—a folder on the network that your system administrator
maintains. At first, Mail is set up to check this post office when you click on the
Get New Mail button. If you prefer, you can have mail check the post office at
a regular interval and deliver new messages to your Active mailbox.

You can set how often Mail checks for new messages in the Preferences panel
(see Figure 13-13 on page 13-19).

1. Choose Info from the Mail menu.

2. Choose Preferences from the Info menu.

3. Choose General from the pop-up list at the top of the Preferences panel.

4. In the Preferences panel, click on Automatic or Manual.

5. If you clicked on Automatic, use the Minutes field to indicate how
frequently Mail should check for new messages.

6. Click on Set.

7. If you clicked on Manual, you must click on the Mailbox window’s Get
New Mail button when you want to retrieve new messages.
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Figure 13-13 Tailoring How You Receive New Messages

When you select Automatic, Mail does not wait for you to retrieve your
messages. The next time a mailbox window opens, a Find button is displayed
in place of the Get New Mail button. Mail checks the post office at a regular
intervals and delivers new messages to your Active mailbox.

If you prefer to control how quickly messages accumulate in your mailbox, you
can retrieve new messages yourself.

When you select Manual, Mail no longer delivers messages automatically.
Instead, the next time a mailbox window opens, a Get New Mail button is
displayed in place of the Find button. To retrieve messages, you must either
click on the Get New Mail button or choose New Mail from the Mailbox menu.

When new messages are ready to be retrieved, a fan of letters is displayed in
Mail’s icon in the dock.

Click here to retrieve new messages
manually.

Click here to have new messages
delivered automatically.

Type a retrieval interval in
minutes here.

Choose General from the pop-up list
at the top of the panel.



13-20 Using the OpenStep Desktop—September 1996

13

Setting a Sound to Announce New Messages
When new messages arrive, a fan of letters appears in the Mail icon in
the dock. You can also choose to have a sound notify you of new messages.
If you receive messages automatically, the sound tells you that there are
new messages in your Active mailbox. If you check for messages manually,
the sound tells you that there are messages for you to retrieve with the Get
New Mail button.

When you click the Sound button in the Preferences panel, an Open panel is
displayed, as shown in Figure 13-14 on page 13-21.

1. Choose Info from the Mail menu.

2. Choose Preferences from the Info menu.

3. Choose General from the pop-up list at the top of the Preferences panel.

4. In the General Preferences panel, click on Sound and then click on the Set
button.

5. In the Open panel, select a sound file.

6. Click on OK in the Open panel.

7. Click on Set in the Preferences panel.
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Figure 13-14 Choosing a Sound to Announce New Mail

You can select a sound file from the /usr/openstep/Library/Sounds
folder. You can use any sound file, as long as it has an .snd  or .au  extension.

If your system makes only one sound, you will get that one, no matter which
sound file you select.

You locate and select a sound file in the Open panel just as you open a file from
any standard Open panel. For more information, see “Opening a File” on
page 5-3.

Creating Headers for Messages You Send
You can create headers of your own that will be displayed in messages you
send. You can create up to two headers. You do so using Mail’s Expert
Preferences, as shown in Figure 13-15 on page 13-22.

1. Choose Info from the Mail menu.

2. Choose Preferences from the Info menu.

Select a file with an .snd  or .au
extension.

When you click on OK, you hear the
sound.
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3. Choose Expert from the pop-up list at the top of the Preferences panel.

4. Double-click in the Key field and type the name of a header you want to
create.

5. Press Tab, type any text you want to appear with the Header in the Value
field, and press Return.

Follow these guidelines when typing a name in the Key field:

Mark Custom Headers with “X-” It is common protocol among network users to
precede the name of headers you create with an X-, as in X-Quote-Of-The-Day.

Do Not Use Spaces Do not use a space to separate words in a header, or else
Mail will not recognize the header and include it in your messages. If a header
contains more than one word, separate words with a dash, as in X-Quote-Of-
The-Day.

Figure 13-15 Creating a Header for Messages You Send

Type the name of the header here.

Choose Expert from the pop-up list at
the top of the panel.

Type text to be displayed with the
header here, and press Return.
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If you type a value for the header, the headers are displayed with that value in
all messages you send. To send a different value in a message, choose the
header in the Send Options panel when you send the message and type
another value for it there.

If you leave the Value field empty, you must choose the header from the Send
Options panel and type a value for it to include it in a message.

Your headers are displayed at the top of your message in each recipient’s
mailbox window.

Note – You open the Send Options panel by choosing Send Options from the
Compose menu.

Tailoring Headers in Messages You Receive
You can choose which headers normally are displayed in messages you
receive. You do this in the Headers view of Mail’s Preferences panel, shown in
Figure 13-16 on page 13-24 and Figure 13-17 on page 13-25.

♦ To display a header that is normally hidden in messages you receive,
remove it from the hidden resources list in the panel.

♦ To prevent a header from being displayed in your messages, add it to the
Hidden Headers list.
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Figure 13-16 Displaying a Header in Your Messages

Choose Headers from the pop-up list
at the top of the panel.

Select a header that you want to be
displayed in your messages.

Click on Remove to remove it from the list
of hidden headers.

Click on Set to display it in your
messages.
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Figure 13-17 Preventing a Header From Displaying in Your Messages

General Preferences
The Preferences panel has options for managing what is displayed in mailbox
windows, for hiding Mail after starting it up automatically, and for showing
the number of unread messages in the Mail icon. To set these options, choose
Preferences from the Info menu and then choose General from the pop-up list
at the top of the panel, as shown in Figure 13-18 on page 13-26.

To hide a header that currently is
displayed in your messages, type the
header name here exactly as it is
displayed in your messages.

Click on Add to add it to the
list of hidden headers.

The header appears in the list.

Click on Set to hide it in your messages.

Choose Headers from the pop-up list
at the top of the panel.
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Figure 13-18 General Preferences

Show Message Totals Check this box to have all your mailboxes display the
total number of messages in them.

Show Message Sizes Check this box to have all mailboxes display the size of
each message and the total size of messages in the mailbox.

Show Deleted Messages Check this box to open all mailboxes with dimmed
summaries of deleted messages showing (messages deleted since you last
compacted the mailbox).

Use Fixed Pitch Font for Plain Text Check this box to type all plain text messages
using a fixed-width font, such as Courier.

Hide on Auto-Launch If you have used the Workspace Manager to have Mail
start up automatically, check this box to have Mail start up hidden.

Show Unread Count in Icon If you do not want to see the number of unread
messages displayed in the Mail icon, uncheck this box.
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Preferences for All the Messages You Send
You can set options for all messages you send using the Compose view of the
Mail Preferences panel, shown in Figure 13-19. Choose Preferences from the
Info menu and then choose Compose from the pop-up list at the top of the
Preferences panel.

Figure 13-19 Compose Preferences

Use the panel to choose any of the following options.

Format Press the Format button to choose a format—MIME Mail or Plain
Text—for all your compose windows to open in.

Indent New Lines When you check this option, pressing Return in a Compose
window indents the next paragraph the same as the previous one. This option
is useful for typing UNIX® code.

Emacs Key Bindings Check this option to use Emacs text editor commands in a
Compose window. (Emacs commands are popular among UNIX developers.)
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Reply in Same Format Check this option to reply to messages in the same
format as the original messages. When you click Reply in a Compose window,
the window selects the format for you.

Remove Self from Replies Check this option if you do not want to receive
replies you send using the Reply All button. If you are “carbon copied” in a
message and you click Reply All in a Compose window to reply to that
message, Mail does not copy your address from the message’s Cc field into
your Compose window. For this option to work, Mail must recognize your
address in the message as being you. You can make Mail recognize an address
if it does not already (see “Other Addresses for Self” on page 13-29).

Reply-To You can have all replies to your messages go to someone other than
yourself. Type one or more addresses in the Reply-To field. When anyone uses
the Reply button to respond to one of your messages, the To field of his or her
Compose window is filled with the addresses you type here. (To also have
replies go to you, type your address, too.)

Request Read Receipt Check this option to receive a notification message when
each OpenStep recipient reads any message you send.

Archive Outgoing Mail Check this option to collect copies of all messages you
send in the Outgoing mailbox. Mail creates this mailbox for you, if it does not
already exist. You can instead archive individual messages when you send
them (see “Addresses and Some Options for Entering Them” on page 12-11).

Expand Private Groups You can make it easy for recipients of messages you
send to a private group address to reply to others in the group. When you
check this option, individual addresses in the group, rather than the group
address, are listed in each recipient’s message. Recipients can then click Reply
All to reply to everyone in the group. For information on creating a private
group, see “Creating Your Own Group Address” on page 13-8.

Send MIME Alternatives Check this option to send contents of MIME messages
in plain text as well as using formatted text. You might do this if you are not
sure which formats recipients’ computers can display. For information on
sending MIME messages, see “Sending a Message” on page 12-8.
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Expert Preferences
The Preferences panel has options for how Mail manages messages in the
Expert view, shown in Figure 13-20 on page 13-30. Choose Expert from the
pop-up list at the top of the panel to type in these fields:

Other Addresses for Self If you are known by addresses that Mail does not
recognize as you, type them in this field. For example, Mail already recognizes
your user name and your full name in the format Jason_Starr . But it does
not recognize addresses used from other networks, like jstarr@blues.com ,
or ones you create in the Addresses panel, until you type them here.

When you reply to a message sent to an address entered here, Mail can remove
you from that reply. For information, see “Remove Self from Replies” on page
13-28.

If you send a message to one of these addresses, To: followed by recipients'
addresses is displayed in your mailbox window rather than your address.

System administrators can modify how Mail stores, retrieves, and delivers
messages. They can replace the path names in the following fields:

• Mail Dir: The folder where Mail keeps your mailboxes. Normally this is
Mailboxes in your home folder.

• Spool Dir: The “post office” folder that collects incoming messages. If your
system administrator is using a folder other than the one currently named
here, you should specify that folder here instead.

• Mailer: The program Mail uses to deliver mail. You might want to use
another program, such as one that tracks statistics.

Line Length This value is the maximum number of characters per line in
messages you send in Plain Text format. You might want to change this value
to send messages through a gateway to a network that supports fewer than 70
characters per line. For information on sending a plain text message, see “What
Is Plain Text Mail?” on page 12-11.

Send Limit You can set a size limit for messages you send. Type the number of
kilobytes in this field. If you compose a message that is larger than this size, a
panel tells you so when you click on Deliver in the Compose window. To send
the message anyway, click on Deliver Anyway in the panel.
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Figure 13-20 Expert Preferences

Type a maximum size, in kilobytes, for
messages you send.

Only your system administrator should
edit these fields.

You can type a new line length, in
characters, for plain text messages here.

Click here to put the new settings into
effect.

Choose Expert from the pop-up list at
the top of the panel.

Type addresses you are known by on
other networks or that you created
yourself. Separate addresses with a
comma.
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Use the information in this chapter when you want to print your work.
The following topics are discussed:

• Preparing a file for printing
• Printing a file
• Saving your pages as a PostScript file

Preparing a File for Printing
Before you print a file, you can change its paper size and orientation. You can
also scale your pages to enlarge or reduce them. You use the Page Layout
command to choose what your pages will look like on paper, as shown in
Figure 14-1 on page 14-2.

1. Open the file and choose Format from the application’s main menu.

2. Choose Page Layout from the Format menu.

3. Choose a paper size from the Paper Size pop-up list. Or type custom
dimensions in the Width and Height fields.

4. Click on Portrait or Landscape.

5. Click on OK.
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Figure 14-1 Page Layout Panel

You can make the size of the pages in your file match the size of the paper in
your printer with the Paper Size pop-up list. When you choose a paper size, its
dimensions are displayed in the Width and Height fields.

If your paper size is not included in the list, you can type custom dimensions
in the Width and Height fields in inches, centimeters, picas, or points. (Picas
and points are commonly used to measure typographical material. A point is
1/72 of an inch, and a pica is 12 points, or 1/6 of an inch.) You can choose the
units of measurement you want to use from the Units pop-up list.

You can print your pages upright or sideways on the paper by clicking on the
Portrait or Landscape button respectively.

The Page Layout command may not be in the Format menu in your
application. See the user’s guide for your application.

Printing a File
When you are ready to print a file, select a printer, the pages you want to print,
and the number of copies, as shown in Figure 14-2 on page 14-3.

1. Open the file and choose Print from the application’s main menu.

2. Click on the name of the printer you want to use.

The miniature page changes size and
orientation to reflect your settings.

Select the layout options you
want and click on OK.
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3. Type the number of copies in the Copies field.

4. Click on All to print the whole file. Or type page numbers in the From
and To fields to print part of the file.

5. Choose Paper Feed and Resolution options.

6. Click on Options to set any special options for your printer.

7. Click on Print.

Figure 14-2 Print Panel

The name of the current printer appears at the top of the Print panel. It remains
the current printer until you select a different one. If only one printer is
available, the scrolling list is not displayed in the panel.

Select the printer you
want to use.

Type the number of
copies and range of
pages you want to
print.

Choose the other
options you want and
click on Print.
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Type the range of pages you want to print in the To and From fields (see
Figure 14-3). You can type 0 or even a negative number in the From field if you
want to print pages that come before page 1.

Figure 14-3 Specifying a Page Range

When you click on Print, your pages are prepared for printing. A temporary
file is created and sent to the print queue for the printer you selected. If no
other files are in the queue, your file is printed immediately.

You can preview on screen what your pages will look like on paper with the
Preview button. See “Previewing Pages” on page 11-3.

Print Panel Options

Different printers offer different options in the Print panel. You choose the
options you want from the pop-up lists in the Print and Printer Options panels.

Paper Feed

This option lists the sources of paper available to your printer. Some common
sources are as follows:

Cassette Uses the paper in the printer’s cassette.

Manual Uses envelopes, acetate, or other stationery you feed into the printer
by hand. (For instructions on feeding paper manually, see the owner’s guide
for your printer.)

Upper, Lower, or another named cassette Uses paper from a specific cassette, if
your printer has more than one.

If you type a starting page number,
the To field is set to last .

If you type an ending page, the
From field is set to first .



Printing 14-5

14

Any Tray Automatically uses paper from the cassette that matches the size of
your pages.

Split Uses multiple cassettes. The paper in the second cassette is used for the
first page, and the paper in the first cassette is used for the second and
following pages in the file. This option is commonly used to print cover sheets
on letterhead or other special paper.

Resolution

This option lists the resolutions your printer can print at, expressed in dots per
inch (dpi). You can print sharper lines and smoother gradations of shading by
choosing a higher resolution. High-resolution printing may take longer than
low-resolution printing.

Options

If your printer offers options beyond those shown on the Print panel, you can
click on the Options button in the Print panel to set them. The Printer Options
panel displays the special settings for your printer in a series of pop-up lists.
For example, a printer might offer several printing modes for different paper
stocks and ink coverages. For more information about the options offered by
your printer, see its owner’s guide.

Saving Your Pages as a PostScript File
You can prepare a file for printing and then save the prepared file instead of
printing it, as shown in Figure 14-4 on page 14-6. The prepared file is a
PostScript™ file.

1. Choose Print from the main menu.

2. On the Print panel, select a printer, the page range, and other options you
want.

3. Click on the Print panel’s Save button.

4. On the Save panel, type a name for the file and select the folder in which
you want to save it.

5. Click on OK.
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Figure 14-4 Saving Your Pages as a PostScript File

What Is a PostScript File?

A PostScript file is a description, in the PostScript language, of a graphic image
or pages.

PostScript is a standard programming language for describing text, images,
and pages. PostScript is most commonly used to describe pages for a printer. It
is also the language used to describe what you see on the OpenStep desktop.

Different types of PostScript files are designed for different purposes. For
example, the PostScript files you create with the Print panel describe whole
pages, and may include options for working with a variety of printers or
features specific to a single kind of printer. They have a .ps  extension. You
can open them with the Preview application, as described in Chapter 11,
“Working With Graphics.”

Some applications, such as illustration applications, use image-oriented
encapsulated PostScript (EPS) files for displaying graphics. These files have an
.eps  extension.

Press to choose the kind of
PostScript file you want.

Type the name under which you want
to save the file.

Select the folder in which you want
to save the file.
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The files you create in the Print panel are not EPS files, so you should not try to
open them in page layout and graphics applications.

Why Save PostScript Files?

You can use the PostScript files you create with the Print panel to:

• Take a “snapshot” of your pages. Sometimes, page layout and other options
you choose in an application change the way a page is printed. You can save
a version as a PostScript file so that in the future, you can print it exactly as
you saved it, regardless of other changes you make to the file, to your
application, or to your system software.

• Create a version of your pages that anyone with a PostScript printer can
print, exactly as you intended, even if they do not have the same system,
application software, and fonts as you have.

• Prepare a file for a printer you do not own, such as a high-resolution
imagesetter or film recorder. For example, you may want to take a copy of
the PostScript file to a service bureau for printing.
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Personalizing the Workspace 15

Individual applications have Preferences commands that you can use to tailor
the applications to your needs. But if you want to set preferences that apply to
all your applications—or if you just want to set the date and time—use the
Preferences application.

This chapter describes how to do the following:

• Start the Preferences application
• Hide menus
• Set a password
• Set the date
• Set the time
• Choose an application locale
• Change the units of measurement
• Choose a paper size
• Customize the Services menu
• Create keyboard alternatives
• Change the fonts on the screen
• Choose a font for applications
• Set permissions on your files and folders
• Display large file systems
• Display UNIX® files
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Starting the Preferences Application
You use the Preferences application to choose a wide range of options for
personalizing your workspace, managing your hardware, and controlling
access to your computer. The Preferences application normally starts when you
start Solaris™ OpenStep™ and is hidden automatically. It is displayed in the
dock as an icon that shows the time and date (see Figure 15-1).

♦ Double-click on the Preferences icon in the dock.

or

♦ Open the /usr/openstep/Apps  folder in the File Viewer and then
double-click on Preferences.app .

Figure 15-1 Preferences Icon Shows Application Status

The Preferences icon
shows the date and
time when Preferences
is hidden.

It looks like this when
Preferences is not running.
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When you start Preferences or unhide it, the window shown in Figure 15-2
opens.

Figure 15-2 Preferences Window

You can rearrange the buttons in the Preferences window—hold down the
Control key and drag one button at a time.

Some of the settings you choose with Preferences take effect immediately.
Others take effect only after you start an application or restart OpenStep.

Note – If you do not want Preferences to start automatically when you start
OpenStep, see “Starting an Application Automatically” on page 4-10.

Note – Some applications may add their own Preferences buttons to this
window. For information about these custom preferences, see the user’s guide
for the application.

Click on one of
these buttons for the
type of preference
you want to set.

Scroll to see more
Preferences
buttons.

The options for the
type of preferences
you click on are
displayed here.
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Hiding Menus
You can hide application menus and use your mouse to display them only
when you need them, as shown in Figure 15-3 on page 15-5.

1. Start Preferences.

2. Click on the button for Menu Preferences.

3. Drag the Preferences menu (the one in your workspace) off the lower
right corner of the screen.

4. Click on the button for Mouse Preferences.

5. Click on Left or Right to choose the mouse button that will display
hidden menus.

6. Log out of OpenStep and restart it.
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Figure 15-3 Hiding Menus

When you restart OpenStep or start a new application, all the menus will be
hidden, and you must press the mouse’s MENU button (normally the right
button) to display them.

Menu Preferences
button

When you drag the
Preferences menu off
the screen, this
minimenu
disappears.

You can click
anywhere in this box
to restore the
Preferences menu.

Mouse Preferences
button

Choose the left or right
button for displaying
menus.
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Selecting a Standard Location for Menus
You can choose a standard location for all your main menus in two ways. First,
you can click on the button for Menu Preferences and drag the Preferences
menu to the new location in the workspace. Or you can drag the minimenu in
the Menu Preferences.

The next time you start an application, its main menu is displayed in the new
standard location—unless you have moved the menus in your application. If
you have, the menu is displayed where you left it.

Setting a Password
If you work on a network, you have a user name and a password that you use
every time you log in. A system administrator usually assigns both of these
names initially, but you should change your password at least once a month, as
shown in Figure 15-4 on page 15-7, Figure 15-5 on page 15-8, and Figure 15-6
on page 15-9.

Note – Setting or changing your password in OpenStep has the same effect as
using the UNIX passwd  command or yppasswd  command. It changes the
password associated with your user login name and stored in /etc/passwd .
And if you have a network password, it changes the network password
associated with your username in the network information service (NIS)
database.

1. Start Preferences and click on the Password button.

2. Type your current password and click on OK.

3. Type your new password and click on OK.

4. Type the new password again to verify it and then click on OK.

5. Click on OK in the confirmation panel.
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Figure 15-4 Typing Your Current Password

For security, your password is never displayed on the screen as you type it.
The pointer follows the progress of your typing, but no characters are
displayed. If you make a mistake, press the Back Space key and type the letter
again.

Password Preferences
button

Type your current
password here.
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Figure 15-5 Typing Your New Password

After you type your new password, the application asks you to type the new
password again to make sure that what you typed the first time was what you
wanted to type.

Type your new
password here.
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Figure 15-6 Verifying Your New Password

If you type the same word a second time, a panel confirms that the new
password is set. When you click on OK in this panel, the original password
field redisplays, ready for the next time you want to change your password. If
you make a mistake when you are verifying the password, you must start over.

What Makes a Password Secure

Passwords should be easy to remember but difficult for others to guess. Here
are some guidelines:

• Avoid names of your children, pets, or other obvious personal favorites.

• Choose a password with at least eight characters. The shorter a password is,
the easier it is for someone to decode.

• Combine lowercase and uppercase letters, numbers, symbols, and spaces in
your password.

Type your new
password again.
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Here are some examples of good passwords:

*a*l*l*a
a#bcd ef
W$Bridge
bARnEgt!

Setting the Date
OpenStep has an internal clock that displays the date and time in your
workspace. It is also used to create a date and time stamp for changes to your
files and folders. You can use this internal clock to set the date, as shown in
Figure 15-7 on page 15-11.

1. Start Preferences and click on the button for the Date & Time Preferences.

2. Click on the month arrows to change the month.

3. Click on the year arrows to change the year.

4. Click on a date in the calendar area.

5. Click on Set.

6. Unless you have previously set the date or time since starting Preferences,
a panel asks you for your root password (see Figure 15-8 on page 15-11).
After you type the correct root password, the new date value is set.
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Figure 15-7 Setting the Date

Figure 15-8 User Authentication Panel

If the Preferences panel is displayed without the date and time options, your
system administrator has probably disabled the date and time preferences. If
you have questions, see your system administrator.

Date and Time
Preferences button

You can check here to
choose a 24-hour clock.

You can click here to
choose a different time
and date display.

When you click on Set,
the new date is
displayed in the dock.

Type your root password here.
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Setting the Time
OpenStep has an internal clock that displays the date and time in your
workspace. It is also used to create a date and time stamp for changes to your
files and folders. You can use this internal clock to set the date, as shown in
Figure 15-9.

1. Start Preferences and click on the button for Date & Time Preferences.

2. Click on the arrows to change the time. Or type a new time.

3. Click in the map to select a time zone.

4. Select the hours, minutes, or seconds in the time field.

5. Click on Set.

6. Unless you have previously set the date or time since starting Preferences,
the User Authentication panel asks you for your root password (see
Figure 15-8 on page 15-11). After you type the correct root password, the
new time value is set.

Figure 15-9 Setting the Time

Change the time here.
You can select hours,
minutes, or seconds.
Then click on the
arrows or type to
change the time.

Date and Time
Preferences button

Click here to specify
regional differences
within a time zone.

Click anywhere in the
map to select a time
zone.

When you click on Set,
the new date is
displayed in the dock.
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When you select a time zone, the button above the map shows the difference,
in hours, between your time zone and Greenwich Mean Time (GMT). When
you press this button, a pop-up list shows regional variations within your time
zone. You can select the one that applies to you. Select the time zone before
you set the date and time. Otherwise, your settings are lost.

If the Preferences panel appears without the date and time options, your
system administrator has probably disabled the date and time preferences. If
you have questions, see your system administrator.

Choosing an Application Locale
Some applications can display the text in their windows, menus, and panels in
the languages of more than one locale. You can specify the locale you want to
use in these applications, as shown in Figure 15-10 on page 15-14.

1. Start Preferences and click on the button for Localization Preferences.

2. Drag your preferred locale to the top of the Locale list.

3. Drag the remaining locales into the order you want.

4. Restart your applications.
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Figure 15-10 Choosing an Application Locale

When you start an application, it checks your order of preference and displays
text in the language of the first locale it has available. The C locale is the
default Solaris locale, which displays text in English.

Note – You may also need to specify a different keyboard arrangement for the
locale you are using. See “Choosing a Keyboard Arrangement” on page 16-6.

Changing Units of Measurement
In some applications, you can specify the size of objects or pages. For example,
in Edit and Mail, you can specify the width of the page. With Preferences,
you can set a standard unit of measurement for all your applications that
specify sizes, as shown in Figure 15-11 on page 15-15.

1. Start Preferences and click on the button for Localization Preferences.

2. Choose the unit of measurement you want from the Measurement Units
pop-up list.

Localization
Preferences button

Drag the locales into
the order you want.



Personalizing the Workspace 15-15

15

3. Restart your applications.

Figure 15-11 Changing the Units of Measurement

The new unit of measurement takes effect for an application the next time you
start it.

Note – You can change the units of measurement in some applications
independently. For example, you might choose inches in Preferences but then
work with picas and points in your page layout program. For details, see the
user’s guide for your application.

Choosing a Paper Size
You can use the Localization Preferences to set a standard paper size you
prefer to work with in all your applications, as shown in Figure 15-12 on
page 15-16.

1. Start Preferences and click on the button for Localization Preferences.

Localization
Preferences button

Click to select a
standard unit of
measurement for all
applications.
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2. Choose the paper size you want from the Paper Size pop-up list.

3. Restart your applications.

Figure 15-12 Choosing a Paper Size

The paper size you set in your individual application may override the paper
size you set here.

The new paper size takes effect for an application the next time you start it.

Customizing the Services Menu
When you are working in applications, you can request some of the services of
other applications from the Services menu, as shown in Figure 15-13 on
page 15-17. If you have many services, you may choose to display some of
these services and not others.

Localization
Preferences button

Select a standard
paper size for all
applications.
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1. Start Preferences and click on the button for Services Preferences.

2. Select the service you want to enable or disable.

3. Click on the Enable or Disable button.

Figure 15-13 Customizing the Services Menu

The next time you use an application, its Services menu lists only the services
that are enabled.

Note – For information about using services, see “Requesting Services From
Other Applications” on page 4-11. See also the list of OpenStep application
services in “Standard Commands” on page A-1.

Services
Preferences button

When a service is
disabled, it is dimmed.

This button switches
from Disable to Enable
when you disable a
service.
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Creating Keyboard Alternatives
Most applications include keyboard alternatives for some or all of the
commands in their menus. A keyboard alternative is a combination of the
Command key and other keys that you can use instead of choosing a command
from a menu. If a command has no alternative, you can create your own, as
shown in Figure 15-14. You can also change existing keyboard alternatives.

1. Start Preferences and click on the button for Menu Preferences.

2. Click in the Command field and type the name of the command.

3. Click in the Key Alternative field and type a character.

4. Click on Add.

5. Restart your applications.

Figure 15-14 Creating Keyboard Alternatives

Menu Preferences
button

Keyboard alternatives
you create are listed
here.

Type the name of the
command exactly as it
is displayed in the
menu.

Type an uppercase
or lowercase letter
here.
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When you type the command name, be sure to match the capitalization,
spaces, and ellipses in the menu. The keyboard alternative can be any character
except a space. Case makes a difference. For example, if you type a lowercase c,
the keyboard alternative is Command-c. If you type an uppercase C, the
keyboard alternative is Command-Shift-C.

When you set a keyboard alternative, it is added to all applications that have
the command (unless the application overrides Preferences). If you choose
an alternative that is already in use, it is removed from the current command
and added to the one you specify.

To remove a keyboard alternative that you have created, select it from the list
in the Menu Preferences and click on Remove. Or to modify it, type another
character in the Key Alternative field and click on Add.

New keyboard alternatives take effect in an application the next time you start
it. They take effect in Workspace Manager menus the next time you log in.

To find out your keyboard’s Command key, see “Keyboard Basics” on page 9-5.

Changing the Fonts on the Screen
You can change fonts that are displayed in menus, window titles, prompts, and
other objects on the screen, as shown in Figure 15-15 on page 15-20.

1. Start Preferences and click on the button for General Preferences.

2. Choose the type of font you want to change from the pop-up list under
Fonts.

3. Click on the Font Panel button.

4. Select a font family, typeface, and size from the Font Panel.

5. Click on Set.

6. Log out of OpenStep and restart it.
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Figure 15-15 Changing the Bold System Font

When you choose a type of font and click on Font Panel, the Font Panel opens
(see Figure 15-16 on page 15-21). You use it to select a font family, typeface, and
size.

These three types of
fonts are displayed on
the screen—you
choose the one you
want to change.

General Preferences
button

Current font setting

Example of where
the type of font is
displayed
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Figure 15-16 Previewing a Font

The fonts you choose are displayed on the screen the next time you log in.

Note – For more information about setting fonts, see “Setting a New Font” on
page 9-12.

Choosing a Font for Applications
You can choose a default font for your applications, as shown in Figure 15-17
on page 15-22. The default font is the one the application uses when you first
type text in a new document or anytime you do not specify a font.

1. Start Preferences and click on the button for General Preferences.

2. Choose Application Font from the pop-up list under Fonts.

3. Click on Font Panel.

4. Select a font family, typeface, and size from the Font Panel.

5. Click on Set.

Click on Preview to display
the font here.

Click on Set to use the selected font.

You can click here to revert to
the last font you selected.
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Figure 15-17 Changing the Application Font

The Font Panel displays all the available font families, typefaces, and sizes (see
Figure 15-16 on page 15-21).

Applications use the new font the next time you start them. However, some
applications may not use the font you set. Some have their own options for
setting a default font that overrides the font you set here. Also, some
applications preset their own default font family, typeface, or size. This preset
font overrides your choice.

Setting Global File and Folder Permissions
You can grant others permission to read and change your files and to run
programs that you own—or you can deny permission. You can make this
choice for individual files and folders with the Inspector, but you can also set
global permissions with the Expert Preferences panel, as shown in Figure 15-18
on page 15-23.

1. Start Preferences and click on the button for Expert Preferences.

2. Check the permissions you want.

Choose Application
Font from this pop-up
list.

General Preferences
button

Current font setting

Example of the
current font
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3. Log out of OpenStep and restart it.

Figure 15-18 Setting Global File and Folder Permissions

The permissions you set here take effect the next time you log in. They apply to
all new files and folders that you create, unless your application has built-in
permission settings that override the global settings. In any case, you can
change permissions for individual files and folders with the Inspector.

Note – For information about using the Inspector to check and set permissions,
see “Changing Permissions for a File or Folder” on page 7-9.

Note – Permissions affect many file operations. For an overview, see
“Permissions Granted” on page 6-2.

Displaying Large File Systems
If you are working with disks and folders that contain several hundred files
and folders, you can optimize the File Viewer to display them more quickly, as
shown in Figure 15-19 on page 15-24.

Expert Preferences
button

If you check here,
people in a group set
up by your system
administrator can
change your files.

If you check here,
anyone outside your
group can change
your files.
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1. Start up Preferences and click on the button for Expert Preferences.

2. Check Large File System.

3. Log out of OpenStep and restart it.

Figure 15-19 Displaying Large File Systems

When you check Large File System, the File Viewer, the Open panel, and the
Save panel can all open large folders faster than normal. Scrolling through
large folders, however, may take a bit longer than normal.

This option takes effect the next time you log in.

Displaying UNIX Files
Your system uses many files that are not normally displayed in the File Viewer.
Some of these are UNIX system files. Some are files called dot files—their names
begin with a period. If you are a system administrator or developer, you may
want to use these files. Otherwise, it is best to leave them hidden. You can
display these files in the File Viewer (see Figure 15-20 on page 15-25).

1. Start Preferences and click on the button for Expert Preferences.

Expert Preferences
button

Check here to display
large numbers of files
and folders more
quickly.
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2. Check UNIX Expert.

Figure 15-20 Displaying UNIX FIles

The UNIX and dot files are immediately displayed in the File Viewer, as shown
in Figure 15-21 on page 15-26. They are also displayed in Open and Save
panels as well as in any other panel that displays the contents of disks and
folders.

Expert Preferences
button

Click here to display
all UNIX system files
and dot files.
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Figure 15-21 UNIX System Files Displayed in the File Viewer

Note – When naming a file, do not use a name that starts with a period. If you
do, the file will be hidden with the other dot files when UNIX Expert is not
checked.

UNIX files
and files
whose
names
begin with a
period are
hidden until
you check
UNIX
Expert.
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The Preferences application not only helps you custom-fit your workspace,
as described in Chapter 15, “Personalizing the Workspace.” It also helps you
manage your hardware—from the keys on your keyboard to the speed of your
mouse.

This chapter describes how to do the following:

• Set the screen saver
• Change the background color of the display
• Choose system beeps and warnings
• Adjust sound volume
• Set the rate for repeating characters
• Choose a keyboard arrangement
• Change the responsiveness of the mouse

Setting the Screen Saver
To protect your display, a screen saver automatically starts when you are not
using it. The screen saver normally starts if you do not press a key or move the
mouse for 30 minutes. You can change this delay or even turn off the screen
saver completely, as shown in Figure 16-1 on page 16-2.

1. Start Preferences and click on the button for Display Preferences.

2. Use the Automatic Screen Saver slider to set the delay for the screen saver.
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Figure 16-1 Setting the Screen Saver

You can set a delay from 5 to 59 minutes. You can turn off the screen saver
completely by dragging the slider all the way to the right. The new setting
takes effect immediately.

Changing the Background Color of the Display
You can choose the background color of your workspace, as shown in
Figure 16-2 on page 16-3. It may be a color from the Sun color list, a color that
you pick from the screen, or a color that you choose from one of three color
models.

If you work on both a color display and a monochrome display, you set the
background colors separately for each display.

1. Start Preferences and click on the button for Display Preferences.

2. Click on the Colors button.

3. Select a color from the Colors panel.

4. Drag the color from the Colors panel to the Background Color well.

Display Preferences
button

You can also type the
delay here.

Drag to set the delay
in minutes.
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Figure 16-2 Changing the Background Color of Your Display

Note – If you want to save the current background color while you experiment
with new colors, you can click in the color well and drag a color swatch to the
row of swatches at the bottom of the Colors panel.

The color well
displays the current
background color.

Display Preferences
button

Click here to display
the Colors panel.

Drag the selected
color from this well to
the Background Color
well.

Drag or click on the color
wheel to select a color.

Or drag one of these
swatches to the
Background Color
well.
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Choosing System Beeps and Warnings
The OpenStep™ applications have several ways to alert you when something
requires your attention. A system beep may sound when you make a mistake
typing. A panel may alert you to a problem or request additional information.
You can tailor these system beeps and warnings to your needs, as shown in
Figure 16-3.

1. Start Preferences and click on the button for General Preferences.

2. Click on Audio for a sound beep or Visual for a warning flash.

3. If you clicked on Audio, select a type of system beep from the list.

4. Click on Use Voice Alerts if you want spoken notices and warnings.

Figure 16-3 Choosing System Beeps and Warnings

Some applications have spoken versions of some panels. If you prefer to hear
these messages rather than read them, you can check Use Voice Alerts to hear
the spoken versions.

If you click on Visual, the Sun icon at the top of the application dock flashes
whenever something needs your attention. No beeps sound.

Click on the General
Preferences button.

Select a system beep
from this list.

Click here for a visual
warning instead of a
system beep.

Check here for
spoken alerts.

Use the Display
Preferences to adjust
the volume of sounds
you choose in this
panel.
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These choices take effect immediately.

Note – You can add your own sounds to the list of possible system beeps by
adding a sound (.snd ) or (.au ) file to the /Library/Sounds  folder in your
home folder.

Note – You can use voice alerts or a custom system beep only if your computer
can play sounds.

Adjusting Sound Volume
You can adjust the volume of your system beeps and warnings in the Display
Preferences panel, as shown in Figure 16-4.

1. Start Preferences and click on the button for Display Preferences.

2. Use the Volume slider to set the sound volume of your system.

Figure 16-4 Adjusting the Sound Volume

Drag the slider to
change the volume of
the sounds your
computer makes.

Click on the Display
Preferences button.
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To turn off the speaker on your system, drag the slider all the way to the left.

The volume setting takes effect immediately.

Setting the Rate for Repeating Characters
Sometimes you need to repeat characters in a long string. Typical repeating
characters are periods and asterisks, but you can repeat any character on the
keyboard by holding the key down. The Back Space and Tab keys also repeat,
as does the space bar.

You do not want the characters to begin repeating too quickly when you press
a key, or will have double and triple characters scattered throughout your text.
You may also want to control how quickly the character repeats (see
Figure 16-5).

1. Start Preferences and click on the button for Keyboard Preferences.

2. Click on a setting for the initial key repeat.

3. Click on a setting for the key repeat rate.

4. Test your settings by pressing any character key.



Managing Hardware 16-7

16

Figure 16-5 Setting the Rate for Repeating Characters

Keyboard Preferences
button

Click here to set the
longest delay before a
character starts
repeating.

Click here to set the
fastest repeat rate.

Press any character
key and watch the
initial delay and
repeat rates here.
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Choosing a Keyboard Arrangement
The standard arrangement of keys on keyboards differs from country to
country. If you are accustomed to working on a particular type of keyboard,
you can choose its arrangement regardless of which keyboard you are actually
using, as shown in Figure 16-6.

1. Start Preferences and click on the button for Localization Preferences.

2. Select a type of keyboard from the list.

Figure 16-6 Choosing a Keyboard Arrangement

The new keyboard arrangement takes effect immediately.

Changing the Responsiveness of the Mouse
You can make the mouse more responsive to your movements in two ways.
FIrst, you can change the mouse speed—which is how fast and how far the
pointer moves when you move the mouse. Second, you can change the double-
click delay—the setting that determines when the system responds to two
clicks as a double-click as opposed to two distinct clicks. See Figure 16-7 on
page 16-9.

Localization
Preferences button

Select a keyboard
arrangement from
this list.
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1. Start Preferences and click on the button for Mouse Preferences.

2. Click on the mouse speed you want.

3. Click on the double-click delay you want.

4. Test the delay by double-clicking in the Test field.

Figure 16-7 Changing the Responsiveness of the Mouse

You should choose the shortest double-click delay that works for you. You can
test it by double-clicking on the word Test. Double-click at your normal speed.
If Test is highlighted, you are double-clicking fast enough for the delay you
have chosen.

The new mouse settings take effect immediately.

Mouse Preferences
button

Slowest—the pointer
moves in direct
proportion to the
mouse.

Accelerated
settings—the pointer
moves farther when
you move the mouse
faster.

If you double-click
slowly, choose a
longer delay.
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Although you can run standard UNIX® programs and commands on your
system, such programs cannot be run directly from the workspace, which does
not include traditional UNIX constructs such as standard input and standard
output.

To run these programs, you can use the Terminal application. Terminal offers a
number of useful features:

• Scrollers let you scroll backward to text that is no longer displayed in the
window.

• Text can be copied and pasted within a Terminal window, between
windows, or to and from other applications that support cutting and
pasting, such as Mail and Edit.

• Terminal has a Print command to enable you to print the contents of a
window, and a Find command to let you search for text.

• Terminal’s Services menu enables you to make interapplication requests.
You can also define your own Terminal services for use in other
applications.

• Terminal’s Preferences command enables you to change the size, title bar
text, emulation characteristics, and font properties of one or more Terminal
windows.

• Terminal provides strict VT100 terminal emulation. Every UNIX program or
utility you run (such as Emacs or vi) should work as intended.
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The rest of this chapter describes Terminal in more detail.

Introduction to Terminal
A UNIX shell is a program that functions as an intermediary between you and
the UNIX operating system. As the shell runs, it prompts you for commands,
interprets what you type, and passes the commands to the operating system
for execution. For more information about the two most common UNIX shells,
the Bourne Shell and the C Shell, see their UNIX manual pages (sh (1) and
csh (1)).

You start Terminal in the workspace as you would any other OpenStep™
application, by double-clicking its icon in the dock or locating it with the File
Viewer (in /usr/openstep/Apps ) and double-clicking. You can use the
Workspace Manager’s Preferences command to make Terminal start when
OpenStep starts.

Terminal runs in its own window, in which you can type commands and run
UNIX programs and scripts. Figure 17-1 shows a typical Terminal window.

Figure 17-1 Typical Terminal Window

You can create additional Terminal windows as you need them with the New
Shell command. To change a window’s characteristics, select the appropriate
settings in the Preferences panel as described in “Setting Terminal Preferences”
on page 17-3.

This Terminal window ran a
login script when it was
opened; it shows the shell
directory in its title bar; these
and other characteristics can
be changed with Terminal
Preferences.
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Setting Terminal Preferences
The Preferences command in the Info menu displays the Terminal Preferences
panel, shown in Figure 17-2. The Preferences panel lets you change values and
set new default values for various Terminal options. For example, you can set
the font properties of a particular window, or specify different default font
properties to be used for new windows. The figures in this section show the
settings you start out with the first time you use the Terminal application. As
you click in shell windows, the Preferences panel shows the settings for the
main window.

Figure 17-2 Terminal Preferences Panel

Type values and click on buttons to specify new preferences. You may need to
click on Set Window to set the new preferences (or, click on Set Default to
make the new settings be the default settings or Show Default to show the
currently defined default settings). New settings remain in effect until you
change them. However, some settings affect only new windows while others
affect existing Terminal windows as well. Specifically, when no buttons are
displayed at the bottom of the panel, settings are global and apply to all
Terminal windows.

Press here to
choose the group of
Terminal
Preferences you
want to set from the
pop-up list.
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Note – If you open Terminal Preferences when more than one Terminal
window is open, it will display preferences for the current main window (the
Terminal window in which you last clicked).

Terminal Preferences are divided into the following seven groups:

• Window preferences
• Title Bar preferences
• VT100 Emulation preferences
• Display preferences
• Activity Monitor preferences
• Shell preferences
• Startup preferences

Each group of options is displayed in its own view in the Preferences panel.
Select the view you want by clicking on the button labeled Window at the top
of the panel and dragging.

Window Preferences

You can use the Window Preferences panel to set the size and font of one or
more Terminal windows, as shown in Figure 17-3 on page 17-5. If you click on
Set Window, the settings are applied to the Terminal window that is currently
the main window. If you want the settings to apply to new windows, click on
Set Default.
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Figure 17-3 Terminal Window Preferences

The Columns and Rows fields specify values for the number of columns and
rows. Even after setting the number of columns and rows, you can still resize
the window, thereby changing the number of columns and rows for that
window.

The When Shell Exits field lets you specify what you want to have happen to a
window when the shell running in it exits. In some special situations, a
window might not obey the default setting. For example, double-clicking on a
command in the workspace results in a window that stays open even after the
command finishes running.

Use the Font field to specify a font for one or more Terminal windows as
follows:

• Click on the Set button to open the Font panel.

• In the Font panel, select a font (note that only fixed-width fonts are listed)
and font size. Click on the Set button in the Font panel to type the settings in
the Font field of the Preferences panel.

• Click on Set Window in the Preferences panel to set the font for just the
main window, or click on Set Default to make this font the default for new
windows.
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Title Bar Preferences

You can use the Title Bar view of the Preferences panel to configure the title bar
of one or more Terminal windows, as shown in Figure 17-4. If you click on Set
Window, the new settings you specify are applied to the Terminal window that
is currently the main window. If you want the settings to apply to new
windows you create, click on Set Default.

Figure 17-4 Terminal Title Bar Preferences

The Include these Elements field provides a number of elements that you can
include in the title bar of Terminal windows, including a “custom title”
element that you define yourself. Any combination of elements can be used. If
no elements are selected, the title that is used is simply Terminal.

To specify a custom title, type it in the Custom Title field. The custom title is
used in the title bar, however, only if you click on the Custom Title box in the
Include these Elements field.

As you experiment with various combinations of elements, the sample title bar
displayed in the Preferences panel is updated to show the effect of the current
settings.
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VT100 Emulation Preferences

The VT100 Emulation view is used to set the VT100 characteristics of Terminal
windows (see Figure 17-5).

Figure 17-5 Terminal VT100 Emulation Preferences

“Translate new lines to carriage returns when pasting” should normally be
checked. It is required by some other operating systems, and it works correctly
for most UNIX programs.

If “Generate VT100 codes from the keypad” is checked, the keys on the
numeric keypad generate VT100 keypad sequences. Otherwise, the keys on the
numeric keypad generate the characters shown on the keys. Holding down
the Alt key while pressing a key on the numeric keypad toggles the
interpretation temporarily.

If “Perform strict VT100 emulation” is checked, some additional (and normally
undesirable) aspects of VT100 emulation are strictly enforced:

• If you type a Delete character at the left edge of a Terminal window, the
command-line cursor will not wrap around to the end of the previous line.
This may make it difficult to edit long command lines that wrap.
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• Strict DECCOLM handling is enforced. Otherwise, the DECCOLM escape
code to change the window’s size is obeyed only if the new size is larger
than the old size.

• The + key on the numeric keypad generates a comma (,) character.

When “Alternate key generates Escape sequences” is selected, typing a
character while you hold down the Alt key causes a two-character sequence to
be generated—an Escape character followed by the character you typed. (This
is useful when running Emacs, so you can use the Alt key as a Meta key.) Click
“Alternate key generates special characters” if you want Alt key combinations
to generate a single character with the high bit set. Some programs interpret
special characters in their own way, so this does not always work as expected;
Emacs, for example, simply strips out the high bit from special characters.

Note – If necessary, you can specify a character other than Escape as the first
character in a two-character sequence. To do so, use the dwrite  shell
command to set the value of the Terminal Meta  variable to the decimal value
of the desired character.

Display Preferences

The Display view of the Preferences panel is used to set various display
characteristics of one or more Terminal windows (see Figure 17-6 on
page 17-9). If you click on Set Window, the new settings you specify are
applied to the Terminal window that is currently the main window. If you
want the settings to apply to new windows you create, click on Set Default.



Using the Terminal Application 17-9

17

Figure 17-6 Terminal Display Preferences

If the Enabled box is checked, windows retain text that scrolls off the top of the
window in a scrollback buffer, allowing text that is scrolled off the window to
be scrolled back into view, copied, or printed. Otherwise, text that scrolls off
the top of the window cannot be retrieved.

If you enable the scrollback buffer, you can choose to let it grow without limit
or you can specify the maximum number of lines that you want saved.
Whichever you choose, you can use the Edit menu’s Clear Buffer command at
any time to clear the buffer.

Although it is often useful, the scrollback buffer adds to the amount of
memory that is used by the Terminal program, and is unnecessary in some
Terminal windows (for example, one that is running a text editor such as
Emacs rather than a UNIX shell).

If the “Wrap lines that are too long” box is checked, characters that would
extend beyond the right edge of the window wrap around to the beginning of
the following line. Otherwise, each line of text occupies only one line in the
window—the last character that fits on a line is overwritten by subsequent
characters that are displayed on that line.
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If the “Scroll to the bottom of the window when input is received” box is
checked, typing in the Terminal window causes the window to scroll to the end
of the buffer and display the insertion point (of course, if the insertion point
happens to be already visible and positioned at the end of the buffer, no
scrolling occurs). Otherwise, typing never causes the window to scroll
automatically.

Activity Monitor Preferences

Normally, Terminal tries to determine whether your Terminal windows are in
active use (busy) by monitoring the processes inside them. If Terminal finds
something interesting happening inside a window, it marks the window
with a broken “X”. As with unsaved document windows in other applications,
you will be prompted for confirmation before closing a busy window or
quitting Terminal when there are busy windows.

To determine whether a window is clean (not busy), Terminal looks at
information about processes it considers relevant. For example, Terminal
considers shells and a few other processes such as su  to be innocuous and, in
general, will not mark windows busy on account of them. Occasionally
Terminal may be wrong about whether a window is clean.

In the Activity Monitor view of the Preferences panel (see Figure 17-7 on
page 17-11), you can designate additional clean command names in the Clean
Commands list (likely candidates are rlogin  and telnet ). Commands you
specify in this list are not used in determining whether a window is busy or
clean.

Click on the “Activity monitor enabled” button if you want to enable or
disable activity monitoring. When activity monitoring is off, Terminal always
asks for confirmation before letting you quit.

Click on the “Background processes are ‘clean’” button if you want to specify
whether background processes are considered relevant in determining whether
a window is clean. For example, a window running a background process
could be considered clean, as long as the process is running without problems
in the background. (The current process or one that you have explicitly
suspended with Control-z will always cause the window to be classified as
busy.)
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Figure 17-7 Terminal Activity Monitor Preferences

Note – Terminal cannot respond to processes running on other machines, so
you should not rely on Terminal’s process monitor when logged into a remote
system.

Shell Preferences

The Shell view of the Preferences panel (see Figure 17-8 on page 17-12) is used
to specify a shell or other program to be run in Terminal windows.

Use the Shell field to specify the absolute path name of a shell or program to
run on startup. Possible values include /bin/csh , /bin/sh , and
/usr/ucb/vi .

Note – You must press the Return key after typing the path name in order for
the new value to be set.
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Figure 17-8 Terminal Shell Preferences

If the “Read login script” box is checked (and you are using csh ), Terminal
runs your .login  file for each new Terminal window you open. Otherwise,
the .login  file is ignored.

Startup Preferences

The Startup view of the Preferences panel, shown in Figure 17-9 on page 17-13,
lets you specify what happens when Terminal starts.

When Terminal starts you can have it do nothing (that is, create no windows),
create one new shell window, or open a startup file (that is, a configuration file
that specifies a collection of windows to open). If you select “Open the startup
file,” you need to make sure a startup file is specified in the Startup File
portion of the panel.

Note – For information about how to create a startup file, see “Saving a
Terminal Configuration for Later Use” on page 17-14.”
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Figure 17-9 Terminal Startup Preferences

Click on the Auto-Launch check button if you auto-launch the Terminal
application and want it to be hidden initially. This button has no effect if you
do not auto-launch Terminal.

Although you can have any number of Terminal configuration files in your
~/Library/Termina l directory, you can specify only one as the startup file.
To specify a particular Terminal configuration file as the startup file, type its
path name in the Path field or click on Set to open an Open panel in which to
select the path name.

Note – The path name you type must be an absolute path name beginning
with a slash (/); characters such as tilde (~) do not work.
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Color Preferences

The Colors view of the Preferences panel, shown in Figure 17-10, lets you choose
several options for the appearance of the Terminal windows.

Figure 17-10 Terminal Colors Preferences

Saving a Terminal Configuration for Later Use
Information about a window or set of windows can be saved to a file, enabling
you to save your preferred configurations for later use, as shown in
Figure 17-11 on page 17-15. Everything about each window is saved except the
contents of the scrollback buffer—this includes the shell, the size and location
of the window on the screen, the title bar and font characteristics, and whether
or not the window is miniaturized. To save a configuration, choose Save (or
Save As) in the Shell menu. Terminal appends a .term  file extension to the file
name you specify. Since Terminal looks for configuration files in your
~/Library/Terminal  directory, this is where you should save them.
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Figure 17-11 Saving a Terminal Configuration

When you first save the configuration (or whenever you choose Save As), you
can choose whether you want just the main window or all windows saved to
the file.

Once a window is associated with a file, you can use the Save command to
flush the settings out again without seeing a Save Panel, just as with other
documents. However, if more than one window belongs with that file, all the
relevant windows will be resaved (the menu item indicates this by changing to
Save Set). This allows you to open your favorite set of files, rearrange the
windows, then just choose Save to save them all back into the file. There is no
way to select a subset of the currently open windows to go into a new file.

To open a configuration file, choose Open in the Shell menu. To have a
configuration file open automatically each time you start Terminal, either
check the box in the Save or Save As panel, or specify the file name in the
Startup view of the Preferences panel.



17-16 Using the OpenStep Desktop—September 1996

17

Printing the Contents of a Terminal Window
To print all or part of the text in a Terminal window, open the Print panel by
choosing Print in the main menu (see Figure 17-12).

Figure 17-12 Terminal Print Panel

Finding Text in a Terminal Window
The Find panel lets you search for text in the main Terminal window. To open
the Find panel, choose Find Panel in the Find menu (see Figure 17-13 on
page 17-17).
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Figure 17-13 Terminal Find Panel

The Find panel locates the next occurrence of a specified string, and can search
either forward or backward. In the Find field, type the string to search for.
The controls in the Find panel have the effects shown in Table 17-1.

If the end of the text is reached, Find continues searching from the beginning
(conversely, when searching backward, if the beginning of the text is reached,
Find continues searching from the end).

If no instance of the Find string is located, Terminal beeps and the message
“Not Found” is displayed in the Find panel.

Commands in the Find menu (which is in the Edit menu) provide alternatives
and shortcuts to using the Find panel. There is also a Jump to Selection
command for scrolling the insertion point into view. For more information, see
“Terminal Commands” on page A-33.

Table 17-1 Find Panel Controls

Control Effect

Next Selects the first occurrence of the Find string following the current
selection or insertion point. (Pressing the Return key has the same
effect, but with one difference: If you have used the keyboard
alternative to display the panel, pressing Return causes the panel
to disappear instead of remaining on the screen.)

Previous Selects the first occurrence of the Find string, searching backward
from the current selection or insertion point.

Ignore Case Makes the find operation case-insensitive (that is, capitalization is
ignored when determining a match). If this box is unchecked, the
search is case-sensitive.
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Defining Services for Use in Other Applications
Although by default Terminal does not make services available to other
applications through the Services menu, Terminal does contain a Terminal
Services
panel that you can use to define any services you want Terminal to provide.

To open the Terminal Services panel, choose Terminal Services in the Info
menu. If no Terminal services are defined, you will see a panel asking if you
want to load a set of example services (see Figure 17-14). You may find it useful
to load and examine this set of examples, and then remove those you do not
want to keep.

Figure 17-14 Terminal Services Panel

Currently defined services are listed at the top of the panel. You can
add services, as well as redefine or delete existing commands.
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• To add a service, click on the New button. A new entry named New Service
#1 is added to the service list. Type the name that you would like to see in
the Services menu, and then configure the service using the controls in the
Terminal Services panel. When you are finished, click on OK.

• To delete a service, select it and click on the Remove button.

• To modify a service definition, select its name and then redefine the service
using the controls on the Terminal Services panel. When you are finished,
click on OK.

The Accept field lets you specify what type of data the service accepts. Click on
one or more of these buttons as appropriate.

The Use Selection field lets you specify whether the selected text should be
used as a command-line argument, or as input to the service. Click on one or
the other as appropriate.

The Execution field lets you specify various options that affect the running of
the service, such as whether the output is returned or discarded.

When defining the service, you can use the tokens %s and %p to refer to the
locations where the selection and prompted input are inserted, respectively.
Prompted input is not requested unless %p appears in the definition.
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A-1

Command Reference A

This appendix summarizes the menus, commands, and buttons that are
available in each Solaris™ OpenStep™ application.

Standard Commands
These are standard commands that are common to most OpenStep
applications.
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Main Menu

Info Menu

Table A-1 Main Menu Commands

Command Action

Info Lists commands for getting information about the application and
setting preferences. See “Info Menu”.

Document Lists commands for opening, creating, and saving files. The name of this
command depends on what you create and save in the application. See
“Document Menu” on page A-3.

Edit Lists commands for editing text, graphics, or whatever you work with
in the application. See “Edit Menu” on page A-3.

Format Lists commands for setting fonts, aligning text, choosing ruler settings,
and changing page layout options. See “Format Menu” on page A-5.

Windows Lists commands for managing windows in the application. See
t“Windows Menu” on page A-8.

Services Lists commands that request the service of another application. See
“Services Menu” on page A-9.

Print Opens a panel that you can use to print the contents of the main
window. See Chapter 14, “Printing.”

Hide Hides the application, removing all its windows from view without
closing them. You can unhide the application by double-clicking its
icon. See “Hiding an Application” on page 4-5.

Quit Quits the application, closing all its windows and any files they contain.
See “Quitting an Application” on page 4-12.

Table A-2 Info Menu Commands

Command Action

Info Panel Displays general information about an application, such as which
version you are using and who wrote it.

Help Opens a panel where you can get step-by-step instructions for using
the application. See “Getting Help by Topic” on page 1-14.
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Document Menu

Edit Menu

Table A-3 Document Menu Commands

Command Action

Open Opens a panel you can use to open a file in the application. See
“Opening a File” on page 5-3.

New Opens an empty window where you can create a file. See
“Creating a File” on page 5-1.

Save Saves changes you have made to the file you are working in, or
opens a panel that you can use to save a new file. See “Saving
Changes” on page 5-7 and “Saving a New File” on page 5-4.

Save As,
Save To

These commands each open a panel that you can use to save a
new version of the file you are working in. See “Saving
Another Version of a File” on page 5-8.

Save All Saves changes in all files that are open in the application. See
“Saving Changes” on page 5-7 and “Saving a New File” on
page 5-4.

Revert To Saved Discards changes you have made to the current file since you
last saved it.

Close Closes the main window. If the current file is displayed in more
than one window, this command closes all its windows.

Table A-4 Edit Menu Commands

Command Action

Cut Removes the current selection and puts it on the pasteboard. See
“Moving and Copying Text” on page 9-8.

Copy Makes a copy of the current selection and puts it on the
pasteboard. See “Moving and Copying Text” on page 9-8.

Paste Inserts the contents of the pasteboard at the insertion point or in
place of the current selection. See “Moving and Copying Text” on
page 9-8.

Delete Deletes the current selection without putting it on the
pasteboard. See “Deleting and Replacing Text” on page 9-7.
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Find Submenu

Undo Reverses your last editing operation, such as typing or choosing
the Delete command. Choosing Undo again redoes the operation.
Sometimes this command is called Undelete, and it reverses and
redoes only a deletion.

Find Lists commands for locating text. See “Find Submenu”.

Link Lists commands for working with linked information. See “Link
Submenu” on page A-5.

Spelling Opens a panel where you can check the spelling in the document
you are working in. See “Checking Your Spelling” on page 9-21.

Check Spelling Finds and selects the next misspelled word in the main window.
Choosing the Check Spelling command has the same effect as
clicking on Find Next in the Spelling panel.

Select All Selects the entire contents of the window or the section of the
window that you are working in. This command selects not only
what is showing but also contents you can scroll to see.

Table A-5 Find Submenu Commands

Command Action

Find Panel Opens a panel that you can use to search for text. See
“Finding Text” on page 9-9.

Find Next Finds the next occurrence of the text in the Find field of the
Find panel. This command does the same thing as the Next
button in the Find panel. You can use this command even if
the Find panel is not open. See “Finding Text” on page 9-9.

Find Previous Finds the previous occurrence of the text in the Find field of
the Find panel. This command does the same thing as the
Previous button in the Find panel. You can use this command
even if the Find panel is not open. See “Finding Text” on
page 9-9.

Enter Selection Copies selected text from the main window into the Find field
of the Find panel, whether it is open or not. You can then
choose Find Next or Find Previous to search for the text.

Jump To Selection Scrolls to display the insertion point or current selection in
the main window.

Table A-4 Edit Menu Commands (Continued)

Command Action
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Link Submenu

Format Menu

Table A-6 Link Submenu Commands

Command Action

Paste and Link Inserts the contents of the pasteboard at the insertion point
and links it to the original.

Paste Link Button Inserts a diamond-shaped button in the document. The button
is linked to the last item you copied.

Publish Selection Opens a panel where you can create and name a file that is a
link to the selection in the main window.

Show Links Highlights each link in a document window with a chain-link
pattern. If links are already shown, the command changes to
Hide Links and removes the highlighting.

Link Inspector Opens a panel that you can use to update and get information
about links.

Table A-7 Format Menu Commands

Command Action

Font Lists commands for changing the appearance of text. See “Font
Submenu” on page A-6.

Text Lists commands for aligning text and choosing ruler settings. See
“Text Submenu” on page A-7.

Page Layout Opens a panel that you can use to choose basic page layout options
for printing documents. See “Preparing a File for Printing” on
page 14-1.
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Font Submenu

Table A-8 Font Submenu Commands

Command Action

Font Panel Opens a panel that you can use to change the font of text or preview
a font before using it. See “Setting a New Font” on page 9-12 and
“Previewing a Font” on page 9-16.

Bold Makes text bold. This command sets or removes the standard bold
typeface for text you type at the insertion point or for selected text. If
the current font is already bold, the command changes to Unbold and
removes bold.

Italic Makes text italic. This command sets or removes the standard italic
typeface for text you type at the insertion point or for selected text. If
the current font is already italic, the command changes to Unitalic
and removes italic.

Underline Underlines selected text or text you type at the insertion point. If text
is already underlined, the command removes underlining.

Superscript Moves selected text up slightly in relation to the baseline. You can
choose the command again to move the text higher.

Subscript Moves selected text down slightly in relation to the baseline. You can
choose the command again to move the text lower.

Unscript Returns superscripted or subscripted text to a normal position.

Colors Opens a panel that you can use to change the color of text or graphics
you are working with. In some applications, this command is in the
Tools menu. See Chapter 10, “Working With Color.”

Copy Font Copies the font at the insertion point or at the beginning of the text
selection so you can apply the font elsewhere with the Paste Font
command. This command does not copy text, so it does not change
the contents of the pasteboard.

Paste Font Applies the font you copied with the Copy Font command to the
selected text or text you type at the insertion point.
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Text Submenu

Table A-9 Text Submenu Commands

Command Action

Align Left Aligns text in a paragraph with the left margin, leaving the right
margin ragged. This command aligns the paragraph where you last
clicked or made a selection. If the selection spans more than one
paragraph, all of them are aligned.

Align Right Aligns text in a paragraph with the right margin, leaving the left
margin ragged. This command aligns the paragraph where you last
clicked or made a selection. If the selection spans more than one
paragraph, all of them are aligned.

Center Centers text in a paragraph between the left and right margins. This
command centers the paragraph where you last clicked or made a
selection. If the selection spans more than one paragraph, all of them
are centered.

Show Ruler Displays a ruler at the top of the document window you are working
in. See “Setting Margins, Indentation, and Tabs” on page 9-17.

Copy Ruler Copies the ruler settings of the paragraph that begins the current
selection or contains the insertion point. You can the apply the ruler
settings to other paragraphs with the Paste Ruler command. The
Copy Ruler command does not copy text, so it does not change the
contents of the pasteboard. You do not need to show the ruler to use
Copy Ruler.

Paste Ruler Applies ruler settings you copied with the Copy Ruler command to
the paragraph that contains the insertion point or the current
selection. If the selection spans more than one paragraph, all of them
are centered.
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Windows Menu

The Windows menu lists the names of all standard windows that are open in
the application. Choosing a name brings the window forward.

The Windows menu also lists the commands shown in Table A-10.

Table A-10 Windows Menu Commands

Command Action

Arrange in Front Neatly stacks all standard windows that are open in the
application.

Miniaturize Window Changes the key window to a miniwindow at the bottom of
the screen, if the key window has a miniaturize button. See
“Miniaturizing a Window” on page 2-16.

Close Window Closes the key window if it has a close button. See “Closing a
Window” on page 2-17.

An X marks a window
that contains no
unsaved work.

A partial X means the
window contains unsaved
work.
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Services Menu

The exact commands in this menu depend on which applications you have.
Services provided by OpenStep applications are listed in Table A-11. See also
“Requesting Services From Other Applications” on page 4-11 and
“Customizing the Services Menu” on page 15-16.

Table A-11 Services Menu Commands

Command Action

Edit Replace Selection Provides a quick way to insert the contents of an Edit file
in the document you are working in. When you choose
this command, an Open panel appears in the Edit
application. Opening a file from this panel inserts the
contents of the file in your document at the insertion
point or in place of the current selection.

Edit Save Selection Opens a new document window in the Edit application
and inserts the current selection in the window. This
command also opens a Save panel that you use to save
the selection in an Edit file. See “Saving a New File” on
page 5-4.

Mail Document Opens a Compose window in Mail and inserts the current
file in it as an attachment. The current file can be the one
you are working in or the file or folder selected in the File
Viewer. For information on attachments, see “Attaching a
File or Folder” on page 12-12.

Mail Selection Opens a Compose window in Mail and inserts text you
have selected in it. For more information, see “Sending a
Message” on page 12-8.

Open in Workspace Opens the file or folder with the selected path name. See
“Opening a Folder” on page 3-5 and “Opening a File” on
page 3-7.
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Workspace Manager Commands

Workspace Menu

Table A-12 Workspace Menu Commands

Command Action

Info Lists commands for getting information and setting preferences. See
“Workspace Manager Info Menu” on page A-11.

File Lists commands for working with files, folders, and on-line address
books. See “Workspace Manager File Menu” on page A-11.

Edit Lists standard editing commands. See “Workspace Manager Edit Menu”
on page A-12.

Disk Lists commands for working with disks. See “Workspace Manager Disk
Menu” on page A-13.

View Lists commands for changing the way you view the contents of folders.
See “Workspace Manager View Menu” on page A-13.

Tools Lists commands that open panels and windows you can use as tools in
the Workspace Manager. See “Workspace Manager Tools Menu” on
page A-14.

Windows Lists commands for managing Workspace Manager windows. See
“Windows Menu” on page A-8.

Services Lists commands that request the services of other applications. See
“Services Menu” on page A-9.

Hide Hides the Workspace Manager application, removing its windows and
menus from view. You can double-click the Sun icon at the top of the
dock to restore the windows and menus to view.

Log Out Quits all running applications. This command also shuts down the X
server unless the TerminateWindowManager  user default is set to NO.
See “Ending Your Work Session” on page 1-16.
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Workspace Manager Info Menu

Workspace Manager File Menu

Table A-13 Workspace Manager Info Menu Commands

Command Action

Info Panel Displays information about the Workspace Manager application and
your system in general.

Preferences Opens a panel that you can use to personalize your workspace. You
can set applications to start up automatically (see “Starting an
Application Automatically” on page 4-9); customize the arrangement
of icons and columns in the File Viewer (see “Personalizing Your File
Viewer” on page 3-32); and choose how disks are displayed (see
“Creating a Folder Window for a Disk” on page 8-4.

Help Opens a panel where you can get step-by-step instructions for using
the Workspace Manager. See “Getting Help by Topic” on page 1-14.

Table A-14 Workspace Manager File Menu Commands

Command Action

Open Opens the selected file or folder.

Open as Folder Opens the selected folder in a separate window or displays the
contents of a file package. See “Opening a Folder in Its Own
Window” on page 3-25.

New Folder Creates an empty folder and puts it in the current folder. See
“Creating a Folder” on page 6-3. When you are working in an
address book, this command changes to New Address.

Duplicate Creates a copy of the selected file or folder and puts it in the
current folder. The copy is labeled CopyOf. You can rename it. If
you select more than one file or folder, Duplicate creates a copy
of each one. When you are working in an address book, the
command changes to New Group.
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Workspace Manager Edit Menu

Compress Compresses the selected file or folder into a format that requires
less space on the disk. When you select a compressed file or
folder, the command changes to Decompress and it returns the
selection to its original format. See “Compressing and
Decompressing a File or Folder” on page 6-16.

Destroy Permanently deletes one or more selected files or folders. A
panel asks you to confirm the deletion or cancel it.

Empty Recycler Permanently deletes all files and folders in the recycler so you
cannot retrieve them. Emptying the recycler frees disk space.

Table A-15 Workspace Manager Edit Menu Commands

Command Action

Cut,
Copy,
Paste,
Delete

These are standard commands for moving, copying, or deleting text. In
the Workspace Manager, you can use these commands when renaming a
file or folder or when typing in a panel. See “Moving and Copying Text”
on page 9-8 and “Deleting and Replacing Text” on page 9-7.

Select All Selects the entire contents of the section of a window you are working
in. In the File Viewer, this command can select the contents of the
current folder. If you are editing a file or folder name, the name is
selected. If you are typing in a text field, the text you have typed is
selected. The Select All command selects not only what is showing but
also what you can scroll to see.

Table A-14 Workspace Manager File Menu Commands (Continued)

Command Action
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Workspace Manager Disk Menu

Workspace Manager View Menu

Table A-16 Workspace Manager Disk Menu Commands

Command Action

Eject Removes the contents of a floppy disk from your file system so
you can safely eject the disk from its disk drive. See“Ejecting a
Disk” on page 8-9.

Initialize Opens a panel that you can use to erase a disk you want to reuse.
You can also rename the disk and choose a format for storing files
and folders. See “Reusing a Disk” on page 8-8.

Check for Disks Detects any floppy disk you have inserted so it appears in the File
Viewer. See “Inserting a Floppy Disk” on page 8-1.

Table A-17 Workspace Manager View Menu Commands

Command Action

Browser Changes the current view in the main window to the browser
view. See “Browsing Files and Folders” on page 3-13.

Icon Changes the current view in the main window to the icon view.
The icon view is the standard view. It represents files and folders
as icons. File and folder names appear under the icon.

Listing Changes the current view in the main window to the listing view.
See “Listing Files and Folders” on page 3-15.

Sort Icons Sorts the icons in the current folder according to the category you
choose with the Inspector command. This command applies only
to the icon view. See “Sorting Files and Folders” on page 7-4.
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Workspace Manager Tools Menu

Clean Up Icons Lines up icons in the current folder to remove empty spaces. This
command applies only to the icon view.

New Viewer Opens a duplicate of your File Viewer. You can use multiple File
Viewers to view different parts of your file system at the same
time. Unlike your original File Viewer, the duplicate has a close
button you can use to get rid of it.

Update Viewers Updates the contents of folder windows to include changes made
elsewhere. This command can show the correct icon for files
associated with a newly installed application, if the correct icon
does not appear automatically. Choosing Update Viewers gives the
files their correct icon so they can open in the right application.
Update Viewers can also show changes made to the file system
with a UNIX command in the Terminal application. For example, if
you change the permission of a file in Terminal, you may need to
choose Update Viewers in order for the change to appear in the
File Viewer.

Table A-18 Workspace Manager Tools Menu Commands

Command Action

Inspector Opens a panel where you can get information about the selected file or
folder and specify some options for using it. See Chapter 7, “Inspecting
Files and Folders.”

Finder Opens a window that you can use to find files and folders. See “Finding
Files and Folders” on page 3-28.

Processes Opens a panel where you can track and manage processes—such as
copying a file—that are going on in the background. You can also use
this panel to quit an application if you have a software problem. See
“Managing Several File Operations” on page 6-23 and “When the Quit
Command Fails” on page 4-14.

Console Opens a special UNIX window that shows you the version of the
system software you are using and error messages or other status
messages that may occur.

Table A-17 Workspace Manager View Menu Commands (Continued)

Command Action
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Edit Commands
These are the basic Edit application commands. For information on other
commands that are available in developer mode, see OpenStep Development
Tools.

Edit Main Menu

Table A-19 Edit Main Menu Commands

Commands Action

Info Lists commands for getting information and setting preferences.
See“Edit Info Menu” on page A-16.

File Lists commands for opening, creating, and saving Edit documents. See
“Document Menu” on page A-3.

Edit Lists standard editing commands. See “Edit Menu” on page A-3.

Format Lists commands for setting fonts, aligning text, and changing page
layout options. See the “Format Menu” on page A-5. See also “Edit Text
Submenu” on page A-16.

Windows Lists commands for managing Edit windows. See “Windows Menu” on
page A-8.

Print Opens a panel where you can print an Edit document. See Chapter 14,
“Printing.”

Services Lists commands that request the services of other applications. See
“Services Menu” on page A-9.

Hide Hides the Edit application, removing its windows and menus from
view without closing them. You can double-click the Edit application
icon to restore the windows and menus to view.

Quit Quits the Edit application, putting all its windows away. If a document
window contains unsaved changes, a panel asks if you want to save
them before quitting.
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Edit Info Menu

Edit Text Submenu

Table A-20 Edit Info Menu Commands

Command Action

Info Panel,
Help

These are the standard commands for getting information. See “Info
Menu” on page A-2.

Preferences Opens a panel that you can use to personalize the Edit application. If
you are an application developer, you can choose to start Edit in
Developer mode, which provides features for working with
programming code. Just select the Developer Mode option.

You can also have new documents open as plain text files rather than
RTF files. Select the Plain Text (ASCII) option. You can choose a default
font for RTF or plain text files—that is, the font that is displayed when
you first type in a document. Click the Set button for the type of file.
Then set a font in the Font Panel. For plain text files, you must choose
a fixed-width font family, such as Courier. See “Setting a New Font” on
page 9-12.

Table A-21 Edit Text Submenu Commands

Command Action

Align Left,
Center,
Align Right

These are the standard commands for aligning text. See “Text
Submenu” on page A-7.

Show Ruler,
Copy Ruler,
Paste Ruler

These are the standard commands for making ruler settings in a
document. See “Text Submenu” on page A-7.

Make ASCII Changes the document you are working in from RTF to plain text
format. All formatting is lost, and text is displayed in a fixed-width
font. When you choose this command, it changes to Make RTF. You
can then choose the command again to set fonts and formatting in the
document.
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Mail Buttons and Commands

Buttons in a Mailbox Window

Up Arrow, Down Arrow These buttons open the previous or next message
listed in the summary area of a mailbox window. See “Opening Messages”
on page 12-3.

Delete Deletes selected messages from a mailbox window. See “Deleting
Messages” on page 13-1.

Compose Opens a window that you can use to compose and deliver a
message. See “Sending a Message” on page 12-8.

Mailboxes Opens a panel that you can use to create and manage your
mailboxes. See “Creating a Mailbox” on page 13-10 and “Moving Messages
to Another Mailbox” on page 13-12.

Find Opens a panel that you can use to search for text in a message or
messages in a mailbox. See “Finding Text” on page 9-9 and “Finding
Messages” on page 13-14.

New Mail Retrieves all new messages and puts them in your Active
mailbox. This button appears in place of the Find button if you have used
the Preferences command to retrieve messages manually. “Tailoring How
You Receive New Messages” on page 13-18.

Buttons in a Compose Window

Deliver Sends the message displayed in the Compose window to the
recipients listed in the To and Cc fields. See “Sending a Message” on
page 12-8.

Lip Service Opens a panel that you can use to listen to a recording you
receive or to include a recording in a message. See “Listening to a
Recording” on page 12-5, “Recording and Inserting Sound in a Message” on
page 12-17, and “Editing Sound” on page 12-19.



A-18 Using the OpenStep Desktop—September 1996

A

Addresses Opens a panel with addresses of other people who are on your
network or share your computer. You can also use this panel to create group
addresses or even your own address book. See “Looking Up Mail
Addresses” on page 13-5, “Creating Your Own Group Address” on
page 13-8, and “Creating a Mail Address Book” on page 13-7.

Reply, Reply All Automatically enters addresses in your Compose window
so you can quickly reply to the current message in your mailbox window.
This button alternates between Reply and Reply All when you click it. See
“Replying to a Message” on page 12-16.

Forward Copies the current message into your Compose window so you
can quickly forward it to other addresses. See “Forwarding a Message” on
page 12-14.

No Receipt, Receipt Gives you the option of receiving a notification
message when your message has been read by each recipient using
OpenStep mail. The button alternates between No Receipt and Receipt when
you click it.

MIME Mail, PlainText Prepares a message for people using a computer
that is not running OpenStep. The button alternates between MIME Mail
and Plain Text when you click it. See “Sending a Message” on page 12-8.
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Mail Menu

Table A-22 Mail Menu Commands

Command Action

Info Lists commands for getting information about Mail and setting
preferences. See “Mail Info Menu” on page A-20.

Mailbox Lists commands for working with mailboxes. See “Mail Mailbox Menu”
on page A-21.

Message Lists commands for sending and managing messages. See “Mail
Message Menu” on page A-22.

Compose Lists commands that open panels and windows for tools you can use in
Mail. See “Mail Compose Menu” on page A-24.

Edit Lists the standard editing commands. See “Mail Edit Menu” on
page A-26.

Format Lists standard commands for changing fonts, ruler settings, and page
layout options. See “Mail Format Menu” on page A-27.

Windows Lists commands for managing Mail windows. See “Windows Menu” on
page A-8.

Print Opens a panel you can use to print messages.

Services Lists commands that request the services of other applications. See
“Mail Services Menu” on page A-29.

Hide Hides the Mail application, removing its windows and menus from
view. You can double-click the Mail icon in the dock to restore the
windows and menus to view.

Quit Quits the Mail application, putting all its windows away. If a Compose
window contains an undelivered message, a panel asks if you want to
deliver it.
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Mail Info Menu

Table A-23 Mail Info Menu Commands

Command Action

Info Panel,
Help

These are standard commands for finding out about the Mail
application. See “Info Menu” on page A-2.

Preferences Opens a panel that you can use to personalize the Mail application.
You can decide whether you want to receive messages automatically or
retrieve them yourself (see “Tailoring How You Receive New
Messages” on page 13-18) and get a sound announcement of new
messages (see “Setting a Sound to Announce New Messages” on
page 13-20).

You can set Mail to start hidden. If you have already used the
Workspace Manager to have Mail start automatically, you check the
“Hide on Auto-Launch” box to have Mail start hidden.

You can have replies to all your messages go to someone other than
yourself. You type one or more addresses in the Reply To field. When
anyone uses the Reply button to respond to one of your messages, the
To field of his or her Compose window is filled with the addresses you
type here.

You can check the Request Read Receipt option to receive a notification
message from OpenStep recipients of all messages you send. Mail
delivers the notification messages to your Active mailbox.

You can check the Send MIME Alternatives option to have all your
Compose windows open in the proper format for sending messages to
people not running OpenStep Mail.

You can check the Archive Outgoing Mail option to create a special
mailbox that collects outgoing messages. Mail creates a mailbox named
Outgoing.mbox , and puts copies of all messages you send in it. You
can open this mailbox using the Mailboxes panel.

You can set preferences for developers and system administrators. See
“Expert Preferences” on page 13-29.
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Mail Mailbox Menu

Table A-24 Mail Mailbox Menu Commands

Command Action

Mailboxes Opens Mailboxes panel.

Get New Mail Retrieves all new messages and puts them in your Active
mailbox—just like the New Mail button in a mailbox window.
You use this command if you have used the Preferences
command to retrieve messages manually. See “Tailoring How
You Receive New Messages” on page 13-18.

Sorting Lists commands for sorting messages in a mailbox window.
See “Mail Sorting Submenu” on page A-22.

Focus

Unfocus

Focuses on a group of messages and lists only their summaries
in the mailbox window you are working in.

Lets you see all your messages again after focusing on a group
of messages; lists all message summaries in the mailbox
window you are working in.

Show Sizes

Hide Sizes

Lets you see the size of each message and the total size of all
messages in the mailbox window you are working in.

Hides the size of each message and the total size of all
messages in the mailbox window in which you are working.

Show Deleted

Hide Deleted

Lets you see dimmed summaries of messages you have
deleted since you last compacted the mailbox you are working
in.

Hides dimmed summaries of deleted messages.

Compact Permanently removes from the disk all messages you have
deleted from the mailbox you are working in. See
“Compacting a Mailbox to Free Disk Space” on page 13-3.
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Mail Sorting Submenu

Mail Message Menu

Table A-25 Mail Sorting Submenu Commands

Command Action

Sort by Date Sorts messages in the order they were sent. This order may
differ from the order in which they were received.

Sort by Name Sorts messages alphabetically by the sender’s name, with
uppercase letters preceding lowercase letters.

Sort by Number Sorts messages sequentially, in the order they were received.

Sort by Size Sorts messages by their sizes, listing the smallest message first.

Sort by Subject Sorts messages by their subject titles. You can use this
command to collect messages on a certain topic, for example, to
delete them or move them to another mailbox.

Table A-26 Mail Message Menu Commands

Command Action

Mark as Unread

Mark as Read

Marks a selected message in the mailbox you are
working in with an unread symbol.

Removes the unread symbol from the selected
message in the mailbox you are working in.

Show All Headers

Show Filtered Headers

Displays all headers in the current message in the
mailbox in which you are working.

Displays original set of headers in the current
message in the mailbox in which you are working.

Undelete Undeletes the last message you deleted. Repeated
use of the Undelete command restores previously
deleted messages up to the last time the mailbox
was compacted.
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Mail MIME Submenu

MIME Opens the MIME submenu.

Decode Foreign Attachments Decodes any files encoded with the UNIX
uuencode  command in the current message in your
mailbox. Opens a Workspace Manager folder
window that contains a temporary copy of each file.

Add Private User Adds the sender’s address from the current message
in your mailbox window to the Private Users list in
the Addresses panel. This command adds the
address even if the panel is not open. See “Creating
a Mail Address Book” on page 13-7.

Table A-27 Mail MIME Submenu Commands

Command Action

Show First Alternative Displays a MIME message in its first available format,
which is usually the plainest format.

Show Best Alternative Displays each part of a MIME message in its richest format.

Show All Alternatives Displays all versions of each part of a MIME message. If
parts of the message are included in multiple formats, those
parts may appear multiple times.

Combine Messages Combines pieces of a MIME message into one message. Use
this command to see the original message when you receive
a MIME message that has been split into multiple messages.

Table A-26 Mail Message Menu Commands (Continued)

Command Action
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Mail Compose Menu

Table A-28 Mail Compose Menu Commands

Command Action

New Opens a Compose window.

Reply Copies the address of the person who sent the current message
into the To field of a Compose window. If the sender used the
Send Options or Preferences command to specify a return
address, choosing Reply copies that address to the To field.

Reply All Copies addresses from the Cc field of the current message into
the Cc field of your Compose window.

Forward Forwards the current message in a mailbox window to the
people you name in the To and Cc fields. When you choose
Forward, the current message is copied into your Compose
window following any text that is already there.

Addresses... Opens the Addresses panel; performs the same operation as the
Addresses button in a Compose window. You can use the
Addresses panel to define group addresses for groups of
people to whom you frequently send messages and to create
your own address book.

Send Options... Opens a panel where you can type a long list of addresses and
choose message destinations. See “Addresses and Some
Options for Entering Them” on page 12-11.

Lip Service... Opens the Lip Service panel; performs the same operation as
the Lip Service button in a Compose window. You can use the
Lip Service panel to create and edit sound recordings in your
messages. You can also use this panel to listen to a recording
you have received in a message.
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Mail Drafts Submenu

Make ASCII Converts all text in the message area of a Compose window to
plain text. If the message contains any graphic images, sound
icons, or file or folder attachments, a panel asks you to remove
them. You should remove them and choose Make ASCII again.
The Make ASCII command does not enforce a line length,
change text to a fixed-width font, or add returns to the ends of
lines, as does the MIME Mail/PlainText button in a Compose
window. You use that button rather than Make ASCII to send a
message to a computer that is not running OpenStep.

Drafts Opens the Drafts submenu. Creates the Drafts mailbox if it
does not already exist.

Deliver Delivers the message in the Compose window to the people
named in the To and Cc fields.

Table A-29 Mail Drafts Submenu Commands

Command Action

Save in Drafts Saves the contents of your Compose window as a message in
the Drafts mailbox. Each time you save a draft of the same
message, Mail saves another version of the message—it does
not replace the last version you saved.

Restore Draft Restores the last draft of a message you saved.

Table A-28 Mail Compose Menu Commands (Continued)

Command Action
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Mail Edit Menu

Table A-30 Mail Edit Menu Commands

Command Action

Cut,
Copy,
Paste

These are standard commands that you can use to move or copy
text, graphic images, icons, or segments of a waveform in the Lip
Service panel. You can also use these commands to move or copy
messages from one mailbox to another by selecting the messages in
one mailbox window and choosing Cut or Copy. Then you can click
in the summary area of another mailbox window and choose Paste.
See “Edit Menu” on page A-3.

Delete Deletes the current selection. In a Compose window, you can use
the Delete command to delete text, graphic images, icons, or
segments of a waveform in the Lip Service panel. In a mailbox
window, the Delete command deletes selected messages—just like
the Delete button in the window.

Undo Restores the last text you deleted from the message in a Compose
window. Repeated use of Undo inserts copies of the last deleted
text. Undo does not reverse any other editing actions.

Undelete Restores the last message you deleted.

Find Lists commands for locating text and messages. See “Mail Find
Submenu” on page A-27.

Spelling,
Check Spelling

These are standard commands you can use to check spelling in a
message in a Compose window. See “Edit Menu” on page A-3.

Select All Selects the entire contents of the last area you clicked in. This can be
the summary area of a mailbox window, a message in a mailbox or
Compose window, a text field, or a waveform in the Lip Service
panel.
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Mail Find Submenu

Mail Format Menu

Table A-31 Mail Find Submenu Commands

Command Action

Find Panel Opens a panel you can use to find text in a message and find
messages in a mailbox. See “Finding Text” on page 9-9 and
“Finding Messages” on page 13-14.

Find Next,
Find Previous,
Enter Selection

These are standard commands you can use to find text in a message
or in a summary area of a mailbox. See “Find Submenu” on
page A-4.

Table A-32 Mail Format Menu Commands

Command Action

Font Lists the standard Font submenu commands. See “Mail Font
Submenu” on page A-28.

Text Lists commands you can use to align text in a message. See “Standard
Commands” on page A-1.

Page Layout Opens a panel where you can define how a message looks on the
printed page. See “Preparing a File for Printing” on page 14-1.
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Mail Font Submenu

Mail Text Submenu

This menu lists the standard commands for aligning text in a message. You can
use these commands in a message you are composing or one opened in a
mailbox window. See “Text Submenu” on page A-7.

Table A-33 Mail Font Submenu Commands

Command Action

Font Panel Opens the standard panel for setting and previewing fonts. In a
Compose window, settings in the Font Panel apply to text you type or
select in a message. In a mailbox window, they apply to all the text in
the summary area or all the text in the message area—wherever you
clicked last. The font you set in the message area of a mailbox window
also becomes the font you get automatically in Compose windows.
See “Setting a New Font” on page 9-12 and “Previewing a Font” on
page 9-16.

Bold,
Italic

These are the standard Font menu commands for changing the
typeface of text. In a Compose window, these commands apply to text
you type or select in a message. In a mailbox window, they apply to
all text in the summary area, or all text in the message area—wherever
you clicked last. See “Font Submenu” on page A-6.

Underline Adds or removes underlining from selected text or text you are about
to type. The Underline command works only in a message you are
composing.

Superscript,
Subscript,
Unscript

These are the standard commands for moving selected text up or
down in relation to the baseline, and for returning it to normal. These
commands work only in a message you are composing.

Colors Opens a panel you can use to set the color of text in a message you are
composing. See Chapter 10, “Working With Color.”

Copy Font,
Paste Font

These are standard commands for copying the font of selected text
and applying it to other text. See “Font Submenu” on page A-6.
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Mail Services Menu

This menu lists the standard commands that request services from other
applications. (See “Services Menu” on page A-9.) In addition, it lists two
commands that are available only in the Mail application.

Preferences Buttons and Commands

Preferences Buttons

Mouse Preferences Displays options for setting the responsiveness of the
mouse. You can also choose a mouse button to display hidden menus. See
“Changing the Responsiveness of the Mouse” on page 16-7 and “Hiding
Menus” on page 15-4.

Keyboard Preferences Displays options for setting and testing the
responsiveness of the keyboard for repeating characters. See “Setting the
Rate for Repeating Characters” on page 16-6.

Display Preferences Displays options for setting the delay for the
automatic screen saver. You can also choose a background color for your
display. See “Setting the Screen Saver” on page 16-1 and “Changing the
Background Color of the Display” on page 16-2.

Localization Preferences Displays options for choosing an application
language, choosing a paper size for printing files, and setting units of
measurement. See “Choosing an Application Locale” on page 15-13,

Table A-34 Mail Services Menu Commands

Command Action

Edit Open Message Provides a quick way to insert the contents of an Edit file
into a message you are composing. When you choose this
command, an Open panel appears in the Edit application.
Opening a file from this panel inserts the contents of the file
into a Compose window.

Edit Save Message Opens a new document window in the Edit application and
inserts the current message in the window. This command
also opens a Save panel that you use to save the message in
an Edit file. For more information, see “Saving a New File”
on page 5-4.
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“Choosing a Paper Size” on page 15-15, and “Changing Units of
Measurement” on page 15-14. See also “Choosing a Keyboard
Arrangement” on page 16-8.

General Preferences Displays options for choosing the fonts that are
displayed on the screen and in applications, selecting a system beep,
choosing visual warnings, and requesting voice alerts. See “Changing the
Fonts on the Screen” on page 15-19 and “Choosing a Font for Applications”
on page 15-21. See also “Choosing System Beeps and Warnings” on
page 16-4.

Date & Time Preferences Displays options for setting the date and time,
changing time zones, and choosing a display for the date and time. Your
system administrator may disable these options entirely. See “Setting the
Date” on page 15-10 and “Setting the Time” on page 15-12.

Password Preferences Displays options for setting a new password or
changing your current password. See “Setting a Password” on page 15-6.

Menu Preferences Displays options for hiding your menus, choosing a
standard location for menus, and creating your own keyboard alternatives.
See “Hiding Menus” on page 15-4 and “Creating Keyboard Alternatives” on
page 15-18.

Expert Preferences Displays options for displaying large file systems and
UNIX files. You can also set options for controlling access to new files and
folders. See “Displaying Large File Systems” on page 15-23, “Displaying
UNIX Files” on page 15-24, and “Setting Global File and Folder
Permissions” on page 15-22.

Services Preferences Displays options for you to choose the services you
want to be displayed in the Services menu for all applications. See
“Customizing the Services Menu” on page 15-16.
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Preferences Menu

Preview Commands

Preview Menu

Table A-35 Preferences Menu Commands

Command Action

Info Lists standard commands for getting information about the application.
See “Info Menu” on page A-2.

Edit Lists standard editing commands. See “Edit Menu” on page A-3.

Windows Lists standard window management commands. See “Windows Menu”
on page A-8.

Hide Hides the Preferences application, removing its windows and menus
from view. You can double-click the Preferences icon in the dock to
restore the windows and menus to view.

Quit Quits the Preferences application, closing all its windows and panels.

Table A-36 Preview Menu Commands

Command Action

Info Lists commands for getting information about Preview. See “Preview
Info Menu” on page A-32.

File Lists commands for opening and saving graphic files. See “Document
Menu” on page A-3. See also “Previewing Pages” on page 11-3 and
“Previewing Graphic Images” on page 11-5.

Edit Lists standard editing commands. See “Edit Menu” on page A-3.

Format Lists the Page Layout command. See “Format Menu” on page A-5.

Display Lists commands for switching pages in multiple-page files and for
changing the way the current page is displayed in the window. See
“Preview Display Menu” on page A-32.

Windows Lists commands for managing Preview windows. See “Windows Menu”
on page A-8.

Print Opens a panel where you can print the image in the main window. See
“Printing a File” on page 14-2.
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Preview Info Menu

Preview Display Menu

Services Lists commands that request the services of other applications. See
“Services Menu” on page A-9.

Hide Hides the Preview application, removing all its windows and menus
from view without closing them. You can double-click the Preview
application icon to restore the windows and menus to view.

Quit Quits the Preview application, putting all its windows away.

Table A-37 Preview Info Menu Commands

Command Action

Info Panel Displays the version number, author, and copyright notice for the
Preview application.

Help Opens a window with information about the Preview application.

Table A-38 Preview Display Menu Commands

Command Action

Page Backward Displays the previous page in a page-oriented PostScript
file.

Draw Page Redraws the page in the main window.

Page Forward Displays the next page in a page-oriented PostScript file.

Cancel Stops Preview from drawing or redrawing the image in the
main window. This command is useful when the image is
complicated and takes a long time to display.

Zoom In Increases the magnification of the image in the main
window.

Zoom Out Decreases the magnification of the image in the main
window.

Disable Image Caching Changes the method Preview uses to redraw pages. If
image caching is already turned off, the command changes
to Enable Image Caching, and you can choose it to switch
Preview back to the original drawing method.

Table A-36 Preview Menu Commands (Continued)

Command Action
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Terminal Commands
The following sections summarize the menus and commands available in
Terminal.

Terminal Main Menu

Terminal’s main menu contains the standard Windows, Print, Services, Hide,
and Quit commands. The other commands and the submenus they open are
described in the sections that follow. Several standard commands are discussed
here only in terms of their particular use in Terminal.

Terminal Info Menu

Terminal’s Info menu provides the standard Info Panel command, plus the
commands listed in Table A-39.

Terminal Shell Menu

Terminal’s Shell menu provides the commands listed in Table A-40.

Table A-39 Terminal Info Menu Commands

Command Description

Preferences Opens the Preferences panel. See “Setting Terminal
Preferences” on page 17-3.

Terminal Services Opens the Terminal Services panel. See“Defining Services for
Use in Other Applications” on page 17-18.

Table A-40 Terminal Shell Menu Commands

Command Description

Open Opens an existing shell window or set of shell windows that
have previously been saved in a file using the Save (or Save As)
command.

New Opens a new shell window, using the default settings.



A-34 Using the OpenStep Desktop—September 1996

A

Run Command Displays a panel in which you type a UNIX command to be
run. The command is run in a new Terminal window. (The
command is displayed as the title of the window; when the
process running in the window has completed, the title
changes to “Dead Terminal.”)

Save, Save As Saves a window or set of windows to a file, allowing you to
save and reuse your preferred configurations. See “Saving a
Terminal Configuration for Later Use” on page 17-14.

Set Title Displays a panel for you to edit and set the current title of the
window. The Preferences panel allows greater control over
this—you can combine your own text with Terminal’s
automatically updated information. See “Title Bar Preferences”
on page 17-6 for more information.

Steal Keys Allows you to effectively debug an application from a shell
window in which the debugger is running. The debugging
process frequently involves alternately activating Terminal (to
type debugger commands) and the other application (to test
the application being debugged). However, clicking to
alternatively activate and deactivate the application being
debugged causes the application to change its state in
unpredictable ways.

To let you avoid this problem, the Steal Keys command puts
Terminal in a special debugging mode. In this mode, Terminal
can be activated or deactivated simply by moving the pointer
into or out of the Terminal shell window. Therefore, you can
easily activate Terminal whenever you want to type a debugger
command, without clicking and thus affecting the state of the
application you are debugging.

When you are ready to exit debugging mode, click in the
Terminal window to make the Terminal main menu redisplay,
and then choose this command again (its name will have
changed to Yield Keys).

Page Layout Displays the standard Page Layout panel, which lets you
choose among various paper sizes, scaling factors, and
orientations for text printed from the main window.

Table A-40 Terminal Shell Menu Commands (Continued)

Command Description
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Terminal Edit Menu

Terminal’s Edit menu provides the standard editing and text-searching
commands listed in Table A-41, which can be used for finding and editing text
in a Terminal window.

Table A-41 Terminal Edit Menu Commands

Command Description

Cut, Copy, Paste These commands let you copy or move text, either between
Terminal windows or between a Terminal window and another
window that supports copying and pasting. To duplicate text,
select the text and choose Copy. To insert the most recently cut
or copied text at the Terminal window’s command-line pointer
location, choose Paste.

Copy puts a copy of the selected text onto the pasteboard, from
where it can be pasted with the Paste command. The
pasteboard holds just one selection; each Copy operation
overwrites the previous contents of the pasteboard.

Note: Cut is always disabled. The only way to remove text
from a Terminal window is to use the Clear Buffer command.

Find Displays a submenu that contains commands for finding text,
as described in “Terminal Find Submenu” on page A-36.

Clear Buffer Removes text from the scrollback buffer, leaving just the
current command line.

Select All Selects all the text in the main window. This is useful, for
example, when you want to copy the entire range of text to
another application, such as Edit.
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Terminal Find Submenu

The Terminal Find submenu contains the commands listed in Table A-42 that
let you search for text in the main Terminal window.

Table A-42 terminal Find Submenu Commands

Command Description

Find Panel Opens the Find panel, which enables you to locate the next
occurrence of a specified string. For more information, see
“Finding Text in a Terminal Window” on page 17-16.

Find Next, Find
Previous

These are the standard Find menu commands. The Find Next
command performs the same function as the Next button in
the Find panel, and Find Previous is the same as the Find
panel’s Previous button.

Enter Selection Copies the selected text in the main window into the Find
panel’s Find field, even if the Find panel is not open or the key
window.

Jump to Selection When the insertion point or current text selection is not
showing in the main window, the Jump to Selection command
scrolls it into view. If there is no insertion point or current text
selection, this command scrolls to the end of the buffer.

Note: Clicking in a Terminal window positions the insertion
point where you clicked. However, the insertion point is not
visible since it is not possible to perform any copy or paste
operation on it. This may cause some confusion, since the
Jump to Selection command may sometimes jump to a location
that does not appear to have any selected text associated with
it.
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Terminal Font Submenu

The Terminal Font submenu contains the standard Font menu commands
described in “Font Submenu” on page A-6 and listed in Table A-43. However,
these commands apply to the entire contents of the Terminal window, not just
to selected text.

Table A-43 Terminal Font Submenu Commands

Command Description

Font Panel Displays the standard Font panel, which lets you choose
among various fonts, typefaces, and font sizes. However,
only fixed-width fonts, such as Courier, can be used in
Terminal.

Bold, Italic Makes the text in the main Terminal window become bold
or italic.

Larger, Smaller Makes the text in the main Terminal window become
larger or smaller.

Copy Font, Paste Font Copy Font copies the font settings of the main window so
that you can paste them into another window with the
Paste Font command.

Colors Displays the standard Colors panel.
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active application
The application that you are currently working in. It is the only application
with any menus showing. The key window belongs to it.

application
A program with a graphical user interface that you can start from the
workspace, such as Edit, Mail, or Preferences.

application dock (or dock)
A column along the right edge of the screen that contains application icons you
can use to start applications. The dock also contains the recycler.

arrow keys
Four keys, labeled with arrows, that cause movement (usually of the insertion
point) in the indicated direction.

ASCII characters
A standard set of the characters that can be used in plain text files.

attention panel
A panel where you must perform an action before you can continue to work in
an application. An attention panel cannot be covered by any other window or
icon.

Back Space key
A key used to remove individual characters, words, graphics, or other items.
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browser
A multiple-column area of a window in which you can browse through
hierarchically organized information by clicking on names in the columns.

button
A graphic object that you click on to make something happen or press for a
continuous action. Buttons are labeled with text, graphics, or both.

byte
A unit of information in the computer. In a plain text file, for example, each
character occupies one byte.

CD-ROM
Compact disk read-only memory, which is a removable disk that is physically
identical to an audio CD but holds computer files.

click
To position the pointer on something and, without moving the mouse, quickly
press and release a mouse button. See also double-click.

close
To remove a window from the workspace when you are finished using it.
When you close a window, you usually have a chance to save changes first.

close button
A button in a window’s title bar that, when clicked on, closes the window.
When the close button is partially drawn, it means that the window contains
unsaved changes or that its contents aren’t up to date.

CMYK color model
A method of specifying colors by simulating a mix of cyan, magenta, yellow,
and black inks.

command
A word or phrase in a menu that describes something you can do or a panel
that you can open in an application.

current folder
The folder in which you are currently working. If you are working in a file, the
current folder is the one that contains that file. In the File Viewer, the current
folder is usually the rightmost folder in the icon path.
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current font
The font of either the text you are about to type at the insertion point or the
first character in the selected text.

current message
The message that is currently open in a mailbox window in the Mail
application.

cursor
See pointer.

depth
A measure of how much color information there is for each pixel in an image.

detach
To drag a submenu away from its associated menu.

dimmed
Gray, faded, or otherwise made to recede into the background. You cannot
choose a command or operate a button when it is dimmed.

disk
A magnetic medium on which the computer stores information. See also floppy
disk and hard disk drive.

dock
See application dock.

dot file
A file or folder whose name begins with a period and which typically contains
information that you do not need to access. Dot files are normally hidden from
view in the File Viewer and folder windows.

double-click
To click on an object twice in quick succession. A double-click often extends
the action of a click. See also click.

drag
To press and hold down a mouse button, move the pointer by sliding the
mouse, and then release the mouse button.

EPS
Encapsulated PostScript, which is a standard format for storing graphics.
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Ethernet
An industry-standard physical medium for transmitting network signals
between computers.

extension
The last period in a file name and all characters that follow. A file’s extension
indicates the type of information in it and the applications that can open it.

file
A collection of related information stored on a disk, such as a document,
graphic image, or application.

file package
A special folder containing files that are not normally shown in folder
windows. Instead, a file package looks and behaves like a file (when you open
it by double-clicking on it, for example).

file system
The collection of all the files you can access through your computer. See also
hierarchical file system.

File Viewer
A Workspace Manager window that you can use to view and open the files in
your file system.

floppy disk
A plastic disk, encased in a protective cartridge, that holds information you
can access with a floppy disk drive.

floppy disk drive
A mechanism that can store and retrieve information on a floppy disk.

folder
A place in the file system that contains files and other folders. Opening a folder
displays the names of the files and folders it contains.

folder window
A Workspace Manager window that displays the contents of one or more
folders and that you use to locate, open, and organize files.

font
A set of properties that describe the appearance of text: font family (such as
Times), typeface (such as bold or italic), and size (in points). See also point.
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font family
A collection of characters with a consistent design, such as Helvetica and
Times.

group
A class of users for whom permissions are assigned for a file or folder. A group
is set up by a system administrator.

group address
A shorthand address used in the Mail application to identify a single user or a
group of users.

hanging indent
First-line indentation to the left of the subsequent lines of a paragraph. A
hanging indent is useful for bulleted or numbered items.

hard disk drive
A device that can store and retrieve information from metal disks permanently
encased within it. A hard disk drive is usually installed inside your computer.

hide
To temporarily remove the windows of a running application from view.

hierarchical file system
A file system in which folders can contain other folders. See also folder.

highlight
To make something—such as a command, text, icon, or title bar—stand out
visually. Highlighting usually indicates that something has been chosen to
perform an action or selected to receive an action.

home folder
Your home base in the file system. Your home folder holds your personal files.
Its name is the same as your user name.

host name
The name by which a computer on a network is known to the other computers
on the network. The host name is assigned by the system administrator. It is
displayed as the name of your root folder.

HSB color model
A method of specifying colors by adjusting hue, saturation, and brightness. See
also hue and saturation.
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hue
The quality of a color that distinguishes its class, such as red, green, or blue.

icon
A small pictorial representation of an application, file, folder, disk, or other
item.

icon path
An area in the File Viewer that displays the selected file or folder and the
folders along its branch of the file system hierarchy.

initialize
To prepare a disk so it can hold information. When you initialize a disk, any
information already on it is destroyed.

insertion point
The place where text and graphics may be entered, usually represented by a
blinking vertical bar.

ISDN
Integrated services digital network, which is an alternative physical medium
for transmitting network signals over phone lines.

justify
To adjust all the lines of a paragraph (except the last line) so that they are
aligned with both the left and the right margins.

key window
The standard window or panel that currently receives keystrokes. Its title bar is
highlighted in black. You make a window the key window by clicking in it.

keyboard alternative
A combination of keys, including the Command key, that you can use instead
of the mouse for choosing a command.

kilobyte
A unit of measurement equal to 1024 bytes. See also byte.

link
A special file that looks and acts like an ordinary file or folder. When you open
it, however, you actually access the contents of a file or folder that is
somewhere else in the file system.

log in
To gain access to a computer by providing a user name and a password.
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log out
To quit all running applications and (if you had to log in to use the computer)
return to the login window.

Mail address book
A list of Mail addresses that you can compile in the Private Users list in the
Mail application’s Addresses panel.

mailbox
A file package (in the Mailboxes folder in your home folder) in which the Mail
application stores messages. Everyone has an Active mailbox where all
incoming messages are delivered.

main menu
The menu that is displayed in your workspace when an application is active.
Its title bar displays the application’s name (or an abbreviation).

main window
The standard window that you are currently working in. If it is not also the key
window, it has a dark gray title bar. Actions you perform in a panel usually
apply to the main window.

menu
A list of commands.

miniaturize button
A button in a window’s title bar that, when clicked on, shrinks the window
into a miniwindow.

miniwindow
An icon that represents a miniaturized window.

mouse buttons
The two buttons on the mouse that you use for clicking and dragging.

network
Two or more computers connected electronically so that people using them can
share files and devices (such as printers), and exchange electronic mail. See
also server.

nonbreaking space
A space you can type between words so that they will always be on the same
line. You type a nonbreaking space by holding down the Alt key and pressing
the space bar.
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open
To display a window in your workspace. Opening a file or folder displays a
window with the contents of the file or folder.

owner
The person (represented by a user name) who created a file or folder. The
owner may also be a class of users for whom permissions are assigned for a file
or folder.

panel
A window that typically appears in response to a command and that you use
to control what the application does or to get information about
the application.

password
A secret sequence of characters that you must type along with your user name
when logging in. It can consist of three or more letters, numbers, symbols, and
spaces.

pasteboard
The place where the computer stores what you last cut or copied with the Cut
or Copy command.

pathname
A name—or a sequence of names separated by slashes (/)—that specifies a file
or folder in the file system.

permissions
Characteristics of a file or folder that determine what certain users can do with
the file or folder—for example, whether they can view a file’s contents or
remove a file from a folder.

pixel
The smallest unit of light on a computer’s screen.

plain text
A data format consisting solely of characters from the ASCII character set.
These include text characters (with no font properties) and control characters.

point
A unit of measurement equal to 1/72 of an inch.
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pointer
The image on the screen that moves as you move the mouse. It is usually an
arrow.

pop-up list
A list of options that you can choose from. You open the list by pressing a
button with a  on it.

press
To position the pointer on something and, without moving the mouse, hold
down a mouse button and keep it down until the desired effect is achieved.

program
A set of coded instructions that a computer follows to perform a specific task.

public window server
A workstation running Solaris™ OpenStep™ that can display the windows of
an application that is running on another computer on a network.

pull-down list
A list of commands that you can choose from to cause an action. You open the
list by pressing a button with a  on it.

read-only
A file that has read permission, but not write or execute permission, for one or
more classes of users. Those users can see the file’s contents, but they cannot
save changes to it.

read permission
A characteristic of a file or folder that allows certain users to view its contents.
See also permissions.

recycler
An icon that you use to delete files and folders from the file system. It is either
in the dock or at the lower left corner of the screen.

resize bar
The narrow strip at the bottom of a window that you can drag to change the
size of the window.

resolution
The number of dots per inch of images on a computer screen or in printed
output. The higher the resolution, the clearer the image.
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Return key
A key used to start a new line or paragraph. You can also press Return to
operate a button with a  on it.

RGB color model
A method of specifying colors by blending red, green, and blue lights.

root folder
The folder at the top of the file system hierarchy. This folder is represented by
a slash (/). It is physically located on the startup disk.

RTF
Rich Text Format, a standard text format that includes font and formatting
properties. See also plain text.

ruler
The numerical scale you can use to change the format of a paragraph (for
example, its indentation and tab stops).

saturation
The intensity of a color—how much of a particular hue is in the color. See also
hue.

save
To store information on a computer’s disk.

scroll
To move the information in a window or section of a window when there is
more than can be displayed at one time, so that a different part of the
information is visible.

scroll button
A button, usually in a scroller, that you click on or press to scroll by small
increments. You can Alt-click on a scroll button to scroll by a windowful.

scroll knob
A box in a scroller that moves as you scroll and that you can drag to scroll. Its
length varies to indicate how much of the scrollable contents are currently
displayed, and its position indicates what part of the contents are displayed.

scroller
A dark gray vertical or horizontal bar that contains a scroll knob and scroll
buttons. Scrollers are displayed along the left side or bottom of an area that
you can scroll through.
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server
A computer on a network that contains files and folders that many people on
the network can use.

shelf
An area at the top of the File Viewer where you can keep files and folders that
you access frequently.

Shift key
The key used to produce the uppercase letters on letter keys and the upper
character on keys labeled with two characters.

slider
A control that lets you set a value in a range by dragging a knob within a bar.

standard window
A window where you do the primary work of an application.

startup disk
The disk that contains the system files that your computer needs in order to
operate. It is usually a hard disk inside your computer.

submenu
A menu that is opened by a command in another menu.

system administrator
The person who sets up and maintains a computer network or of a computer
used by more than one person.

system files
Files that the computer needs in order to operate and that must be loaded into
the computer after it is turned on.

Tab key
A key used to move to the next stopping point in a sequence, such as a tab stop
in a document or a text field in a panel.

text field
A box where you can type text. A text field is usually labeled with text that
identifies what information should go in it.

TIFF
Tag image file format, a standard format for storing graphics.
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title bar
The bar at the top of a window that contains its title and possibly buttons for
manipulating the window. It is highlighted in black if it is the key window or
in dark gray if it is the main window but not the key window.

typeface
A variation of a font family, such as Bold, Italic, or Bold Italic.

user name
The name by which the computer identifies you. This is the name you log in
with, the name used to identify you as the owner of files and folders, and the
name of your home folder.

volume keys
The two keys that control the volume of your computer speaker. The upper key
increases the volume, the lower key decreases it.

window
A rectangular area in which information is presented on the screen. See
standard window and panel.

word
Any sequence of characters between spaces or punctuation marks. You can
select a word by double-clicking on it.

word wrap
The automatic breaking of lines between words. With word wrap, you can type
without having to press Return to end each line.

workspace
The screen environment in which you do your work in OpenStep applications.

write permission
A characteristic of a file or folder that allows certain users to change its
contents. See also permissions.
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A
access to files and folders 6-2, 15-22
active application 4-3
Active mailbox 12-1
Add Private User command in Mail A-23
address book, creating a Mail 13-7
addresses

creating a group 13-8
entering in messages 12-11, 13-5
looking up in Mail 13-5–13-6
type of Mail 13-6

Addresses button A-18
Addresses command in Mail A-24
Align Left command A-7

in Edit A-16
Align Right command A-7

in Edit A-16
Alt key

on Sun keyboard 2-7, 2-13, 9-5
on x86 keyboard 9-5

application dock 1-2, 3-8
covering 4-8
customizing 4-7–4-10
starting applications from 4-1

application locale, choosing 15-13
applications 1-2, 4-1–4-15

active 4-3

adding to the dock 4-7
changing the startup, for files 7-6
choosing fonts for 15-21
determining which opens a file 3-10
hiding 4-6
locating docked 4-9
quitting 4-13
removing from the dock 4-7–4-9
reordering in the dock 4-7
requesting the service of 4-11
running several at once 4-3
starting automatically 4-10
starting from the dock 4-1
switching to another 4-4

Arrange in Front command A-8
arrow pointer 1-3
attention panel 2-3

B
Back Space key 9-5
background color, changing 16-2
Backspace key 9-7
Bold command A-6
browser 3-13
Browser command in Workspace Manager

A-13
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browser view in the File Viewer 3-13
adjusting column width in 3-32

buttons 1-6–1-8
dimmed 1-8

C
Cancel command A-32
Center command A-7

in Edit A-16
changes, saving 2-18, 5-7–5-8
Check for Disks command 8-1–8-2, A-13
Check Spelling command A-4
Clean Up Icons command in Workspace

Manager A-14
clicking 1-6
Close command A-3
Close Window command A-8
CMYK color model 10-10
color models 10-9–10-13
color palettes

adding an image to a list of 10-15
using images as 10-14

color swatches, creating 10-4
color wheel 10-5
colors 10-1–10-21

creating a list of 10-17–10-20
layers of 10-16
mixing custom 10-9–10-13
opacity of 10-16
printing 10-7
removing from a list 10-20
selecting from an image 10-14
selecting from the color wheel 10-5
selecting from the screen 10-7
transparency of 10-16
using in a document 10-2

Colors command A-6
locating 10-1

Combine Messages command in Mail
A-23

Command key
on Sun keyboard 2-7, 9-5

on x86 keyboard 9-5
using to choose commands 1-11

commands 1-2, 1-10
choosing 1-10–1-11
choosing from a pull-down list 1-8
dimmed 1-10

Compact command in Mail A-21
Compose button 12-8, 12-14, 12-16, A-17
Compose menu in Mail A-24
Compress command in Workspace

Manager A-12
Console command A-14
Copy command

in Edit 9-8, A-3
in Mail A-26
in Terminal A-35
in Workspace Manager A-12

Copy Font command A-6
copy pointer 1-3
Copy Ruler command A-7

in Edit A-16
copying

file 6-5
files to or from a disk 8-5
folder 6-5
graphic images 9-8
links 6-15, 6-25
text 9-8

creating
color list 10-17–10-20
color swatch 10-4
file 5-1–5-2
folder 6-3
group address in Mail 13-8
keyboard alternative 15-18
link 6-12
Mail address book 13-7
mailbox 13-10

current folder 3-4
current view in the File Viewer 3-6
Cut command A-3

in Edit 9-8
in Mail A-26
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Cut command (Continued)
in Terminal A-35
in Workspace Manager A-12

D
Date & Time Preferences button A-30
date, setting 15-10
Decode Foreign Attachments command in

Mail A-23
Delete button A-17
Delete command 9-7, A-3

in Mail A-26
in Workspace Manager A-12

deleting
file 6-18
folder 6-18
graphic images 9-7
Mail messages 13-1
mailbox 13-11
text 9-7

Deliver button 12-8, A-17
Destroy command in Workspace Manager

A-12
dictionary, spelling, options for 9-23
Disable Image Caching command A-32
Disk menu A-13
disks

copying files to and from 8-5
creating folder windows for 8-4
DOS 8-1
ejecting 8-9

disks, floppy
inserting 8-1, 8-1–8-3
opening and saving on 8-10
reusing 8-8

Display menu in Preview A-32
Display Preferences button A-29
Document menu A-2
documents

adding graphic images to 11-1–11-2
using color in 10-2

dot files 15-24

double-clicking 1-6
down arrow button 12-3, A-17
Drafts command in Mail A-25
Drafts submenu in Mail A-25
dragging 1-6
Draw Page command A-32
Duplicate command A-11

E
Edit application 4-15

how it saves a backup file 5-8
starting 9-1

Edit main menu A-15
Edit menu A-3

in Mail A-26
in Terminal A-35
in Workspace Manager A-12

Edit Replace Selection command A-9
Edit Save Selection command A-9
editing text 9-1–9-24
Eject command 8-9, A-13
Empty Recycler command 6-18, 6-20, A-12
encapsulated PostScript format 11-3
Enter Selection command A-4
EPS file 3-10, 11-3

icon for 3-12
previewing 7-4
sending in a Mail message 12-9

Expert Preferences button A-30
extensions

of chunks 8-8
of file names 3-10, 5-6

F
File menu in Workspace Manager A-11
file names

extensions of 3-10
guidelines for choosing 5-6

file operations
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managing several at once 6-23
solving problems during 6-24–6-26

file packages 3-27, 7-3
file system

as seen in the File Viewer 3-2–3-4
displaying large 15-22
icons in 3-11

File Viewer 3-3
personalizing 3-32–3-35
using 3-1–3-36

files 1-2, 3-2
application that opens 3-10
application that opens, changing 7-6
assigning to a new group 7-8
attaching to a message 12-12
browsing 3-13
changing permissions for 7-9
compressing 6-16
copying 6-5
copying to and from a disk 8-5
creating 5-1–5-2
decompressing 6-16
deleting 6-18
distinction from links and file

packages 7-3
DOS 8-7
EPS 3-10, 11-3
finding 3-28–3-31
getting information about 7-1
guidelines for naming 5-6
handling several at once 6-21
handling when too large to fit on one

floppy disk 8-7
inspecting 7-1–7-10
moving 6-7–6-9
opening 3-7–3-9, 3-20, 5-3
opening in a message 12-6
opening temporarily in an application

7-7
organizing 6-1–6-26
plain text 3-10, 3-12
preparing for printing 14-1–14-7
previewing contents of 7-3
printing 14-2
renaming 6-4

replacing 6-9
retrieving from the recycler 6-19
RTF 3-10, 3-12
saving 5-1, 5-4–5-10
saving another version of 5-8
saving new 5-4–5-6
selecting several at once 3-22–3-25
sorting 7-4

Find button, in a mailbox window A-17
Find command

in Mail A-26
in Terminal A-35

Find menu A-4
Find Next command A-4
Find Panel command 9-9, 9-11, A-4
Find Previous command A-4
Find submenu

in Mail A-27
in Terminal A-36

Finder command 3-28–3-31, A-14
Focus command in Mail A-21
folder names, guidelines for choosing 5-6
folder window

creating for disks 8-4
opening for a folder 3-25

folders 3-2
assigning to a new group 7-8
attaching to a message 12-12
browsing 3-13
changing permissions for 7-9
compressing 6-16
copying 6-5
creating 6-3
current 3-4
decompressing 6-16
deleting 6-18
dimmed 3-13
finding 3-28–3-31
getting information about 7-1
guidelines for naming 5-6
handling several at once 6-21
home 3-4
inspecting 7-1–7-10

folders (Continued)
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merging 6-11
moving 6-7–6-9
opening 3-5–3-7, 3-20, 3-25
opening in a message 12-6
organizing 6-1–6-26
renaming 6-4
replacing 6-9
retrieving from the recycler 6-19
root 3-2
selecting several at once 3-22–3-25
sorting 7-4

font 9-15
changing in a selection 9-15
changing screen 15-19
choosing for applications 15-21
previewing 9-16
setting a new 9-12–9-15

font family 9-15
Font menu

in Mail ??–A-28
Font Panel command 9-12–9-14, 9-16, A-6
Font submenu A-6

in Mail A-28
in Terminal A-37

Format menu A-5
in Mail A-27

Forward button 12-14, A-18
Forward command in Mail A-24

G
General Preferences button A-30
Get New Mail command in Mail A-21
graphic images 11-1–11-6

adding to a list of color palettes 10-15
adding to a message 12-9
adding to documents 11-1–11-2
copying 9-8
deleting 9-7
file formats of 11-3
previewing 11-5
replacing 9-7
using as color palettes 10-14

gray scale 10-12

group address in Mail 12-11
creating 13-8

groups, assigning files and folders to 7-8

H
hanging indent, creating 9-20
hardware, managing 16-1–16-9
help

getting by clicking 1-14
getting by topic 1-15

Help command 1-15, A-2
Hide command 4-6, A-2
Hide Deleted command in Mail A-21
Hide Sizes command in Mail A-21
hiding an application 4-6
home folder 3-4

icon 3-11
notation in a path name 3-30

HSB color model 10-11
hue 10-6

I
I-beam pointer 1-3
Icon command in Workspace Manager

A-13
icon path 3-4
icon view in the File Viewer 3-6

adjusting spacing in 3-32
icons 1-2, 3-4

for OpenStep applications 4-14
in the file system 3-11

indentation
creating a hanging 9-20
setting 9-17–9-20

indentation markers 9-20
Info menu A-2

in Edit A-16
in Mail A-20
in Preview A-32
in Terminal A-33

Info menu (Continued)
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in Workspace Manager A-11
Info Panel command A-2
Initialize command 8-8
Initialize command in Workspace

Manager A-13
initializing disks 8-3, 8-8
insertion point 9-4
Inspector command in Workspace

Manager 7-1–7-10, A-14
Italic command A-6

J
Jump To Selection command A-4

K
key window 2-4
keyboard alternative 1-11

creating 15-18
keyboard basics 9-5
Keyboard Preferences button A-29

L
Link Inspector command A-5
Link menu A-5
link pointer 1-3
links in the Workspace Manager 6-14

copying 6-25
creating 6-12
inspecting 7-3
setting options for copying 6-15

Lip Service button 12-18, A-17
Lip Service command in Mail A-24
Listing command 3-15, A-13
listing view in the File Viewer 3-15, 3-16
locale, choosing for applications 15-13
Localization Preferences button A-29
Log Out command 1-16, A-10
logging in 1-2
logging out 1-16

M
Mail application 4-15, 12-1–??, 13-1–13-30

commands A-19
creating an address book in 13-7
creating mailboxes in 13-10
looking up addresses in 13-5–13-6
managing 13-1–13-30
opening messages in 12-3
starting 12-1

Mail Document command A-9
mail format button 12-10
Mail menu A-19
Mail Selection command A-9
mailbox

Active 12-1
compacting to free disk space 13-3
creating 13-10
deleting 13-10
moving messages to another 13-12
opening 13-10

Mailbox menu in Mail A-21
Mailboxes button 13-10, 13-12, A-17
Mailboxes command in Mail A-21
main menu 1-10
main window 2-5
Make ASCII command

in Edit A-16
in Mail A-25

Make RTF command in Edit A-16
margin markers 9-19
margins, setting 9-17–9-20
Mark as Read command in Mail A-22
Mark as Unread in Mail A-22
measurements, changing units of 15-14
Menu Preferences button A-30
menus 1-2, 1-10

choosing a standard location for 15-6
hiding 15-4

merging folders 6-11
Message menu in Mail A-22
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messages
adding graphic images to 12-9
attaching files or folders to 12-12
copying addresses into 13-5
deleting 13-1
deleting sound from 12-19
finding 13-14
forwarding 12-14
having replies sent to an address

other than your own 12-12
inserting sound in 12-17
listening to a recording in 12-5
moving to another mailbox 13-12
opening 12-3
opening a file or folder in 12-6
replying to 12-16
sending 12-8–12-10
sending carbon copies of 12-8
sending hidden copies of 12-12
sending to computers that do not run

OpenStep mail 12-10
setting sound to announce new 13-20
tailoring how you receive new 13-18
typing addresses in 12-11

MIME command in Mail A-23
MIME submenu in Mail A-23
Miniaturize Window command A-8
miniwindow 2-16
mouse 1-5
Mouse Preferences button A-29
move pointer 1-3

N
network 3-35
New command 5-1, A-3

in Mail A-24
in Terminal A-33

New Folder command 6-3, A-11
New Mail button 13-18, A-17
New Viewer command in Workspace

Manager A-14
No Receipt button A-18

O
Opacity slider 10-16
Open as Folder command 3-26, 3-27, A-11
Open command 5-3, A-3

in Terminal A-33
in Wrkspace Manager A-11

Open in Workspace command A-9
opening

file 3-7–3-10, 5-3
folder 3-5–3-7
folders and files by typing 3-20
folders and files on a floppy disk 8-10
mailbox 13-11
message 12-3

orientation, changing for printing 14-2

P
Page Backward command in Preview A-32
Page Forward command in Preview A-32
Page Layout command 14-1, A-5

in Terminal A-34
panel 1-10, 2-2

attention 2-3
paper size

changing 14-2
specifying custom dimensions 14-2

paragraph
selecting 9-6
typing 9-3

Password Preferences button A-30
Paste and Link command A-5
Paste command A-3

in Edit 9-8
in Mail A-26
in Terminal A-35
in Workspace Manager A-12

Paste Font command A-6
Paste Link Button command A-5
Paste Ruler command A-7

in Edit A-16



Index-8 Using the OpenStep Desktop—September 1996

path names 3-3
typing in the Save panel 5-6
using a tilde (~) in 3-30

permissions 6-2, 15-22
changing for files and folders 7-9
seeing in the listing view 3-16

pixel 10-8
plain text file 3-10

icon for 3-12
plain text message in Mail 12-11
pointer 1-3

arrow 1-3
copy 1-3
I-beam 1-3
link 1-3
move 1-3
moving the 1-5
question mark 1-3, 1-14

pop-up lists 1-7
PostScript files, description of 14-6
PostScript format 11-3

saving pages in 14-5–14-7
Preferences application 4-15

buttons A-29–A-31
commands A-29–A-31
starting 15-2
using to manage hardware 16-1–16-9
using to personalize your workspace

15-1–15-26
Preferences command

in Edit A-16
in Mail A-20
in the Workspace Manager 3-32, 4-9,

4-10, 6-15, 8-4, A-11
Preferences menu A-31
pressing 1-6
Preview application 4-15, 11-4, 11-5
Preview menu A-31
Print command A-2
printer, selecting 14-3
printing 14-1–14-7

a file 14-2
changing orientation for 14-2

preparing files for 14-1–14-2
selecting a range of pages for 14-4

Processes command 4-14, 6-23, A-14
Publish Selection command A-5
pull-down lists 1-8

Q
question mark pointer 1-3
Quit command 4-13, A-2

when it fails 4-14

R
Receipt button A-18
recycler 6-18

emptying 6-19
removing from the dock 4-9
retrieving a file or folder from 6-19

replace options in Edit and Mail 9-12
Reply All button 12-16, A-18
Reply All command in Mail A-24
Reply button 12-16, A-18
Reply command in Mail A-24
resize bar 2-1, 2-9
Restore Draft command in Mail A-25
Revert To Saved command A-3
RGB color model 10-10
root folder 3-2

icon 3-11
RTF file 3-10

icon for 3-12
previewing 7-4

ruler, use of 9-17–9-20
Run Command command A-34

S
saturation, color 10-6
Save All command 5-7, A-3
Save As command 5-8, A-3

in Terminal A-34
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Save command 5-4, 5-7, A-3
in Terminal A-34

Save in Drafts command in Mail A-25
Save To command 5-8, 5-9, A-3
saving

a new file 5-4
another version of a file 5-8
before logging out 1-17
changes to a file 2-18, 5-7–5-8
Edit documents 5-8
file as a PostScript file 14-5
files on a floppy disk 8-10
reasons for 5-10
tips for 5-8

screen
changing fonts on 15-19
selecting colors from 10-7

screen saver, setting 1-4
scroll button 2-12
scrollbar 2-1
scroller 2-11
scrolling 2-11–2-14
search options, in Edit and Mail 9-10
searching

for files and folders 3-28–3-31
for messages 13-14
for text 9-9

Select All command A-4
in Mail A-26
in Terminal A-35
in Workspace Manager A-12

selecting
colors 10-5, 10-7
locale 15-13
paragraph 9-6
several files and folders 3-22–3-25
text 9-6
window to work in 2-4
word 9-6

Send Options command 12-11, A-24
server 3-35
service, requesting from another

application 4-11

Services menu A-9
customizing 15-16
in Mail A-29

Services Preferences button A-30
Set Title command A-34
shelf 3-4

adjusting space on 3-33
enlarging 3-19, 3-34
removing files or folders from 3-18
stocking 3-17

Shell Menu in Terminal A-33
Show All Alternatives in Mail A-23
Show All Headers command in Mail A-22
Show Best Alternative in Mail A-23
Show Deleted command in Mail A-21
Show Filtered Headers command in Mail

A-22
Show First Alternative in Mail A-23
Show Links command A-5
Show Ruler command 9-17, A-7

in Edit A-16
Show Sizes command in Mail A-21
sliders 1-9
Sort by Date command in Mail A-22
Sort by Name command in Mail A-22
Sort by Number command in Mail A-22
Sort by Size command in Mail A-22
Sort by Subject command in Mail A-22
Sort Icons command in Workspace

Manager A-13
Sorting command in Mail A-21
sorting files 7-4
sorting folders 7-4
Sorting submenu in Mail A-22
sound

deleting from a message 12-19
editing 12-19
listening to in a message 12-5
recording for a message 12-17
setting for new messages 13-20

speaker, adjusting volume 1-4
special characters, using in a selection 9-15
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Spelling command 9-21, A-4
spelling, checking 9-21–9-24
standard window 2-2
Steal Keys command A-34
submenus 1-10

detaching 1-12
Subscript command A-6
Superscript command A-6

T
tab markers 9-19
tabs, setting 9-17–9-20
tagged image file format 11-3
Terminal application 4-15
text

changing font of 9-12
copying 9-8
deleting 9-7
finding 9-9
moving 9-8
replacing 9-7
replacing with the Find panel 9-11
selecting 9-6
typing 9-3

text fields 1-9
Text menu ??–A-7
Text submenu A-7

in Mail A-28
TIFF file 11-3

icon for 3-12
sending in a Mail message 12-9

time, setting 15-12
title bar 2-1
Tools menu in Workspace Manager A-14
transparency 10-16
typeface 9-15
typing text 9-1–9-24

U
Unbold command A-6
Undelete command A-22, A-26

Underline command A-6
Undo command A-4

in Mail A-26
Unfocus command in Mail A-21
Unitalic command A-6
units of measurement, changing 15-14
UNIX files, displaying 15-24
UNIX regular expressions 9-10
Unscript command A-6
up arrow button 12-3, A-17
Update Viewers command in Workspace

Manager A-14

V
View menu A-13
views in the File Viewer

browser 3-13
current 3-6
icon 3-6
listing 3-15, 3-16

volume of speaker, adjusting 1-4

W
window 2-1–2-18

closing 2-17
key 2-4
main 2-5
miniaturizing 2-16
moving 2-8
reordering 2-6
resizing 2-9
scrolling to see more 2-11–2-14
selecting 2-4
standard 2-2
types of 2-1–2-3

Windows menu A-8
word wrap 9-4
word, selecting 9-6
work session, starting and ending 1-1–??
workspace 1-2

personalizing 15-1–15-26
Workspace menu 1-16, A-10
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Z
Zoom In command A-32
Zoom Out command A-32



Index-12 Using the OpenStep Desktop—September 1996



Copyright 1996 Sun Microsystems Inc., 2550 Garcia Avenue, Mountain View, Californie 94043-1100 USA.

Tous droits réservés. Ce produit ou document est protégé par un copyright et distribué avec des licences qui en restreignent
l’utilisation, la copie, et la décompliation. Aucune partie de ce produit ou de sa documentation associée ne peuvent être
reproduits sous aucune forme, par quelque moyen que ce soit sans l’autorisation préalable et écrite de Sun et de ses bailleurs
de licence, s’il en a.

Des parties de ce produit pourront etre derivees du système UNIX®, licencié par UNIX Systems Laboratories, Inc., filiale
entierement detenue par Novell, Inc., ainsi que par le système 4.3. de Berkeley, licencié par l’Université de Californie. Le
logiciel détenu par des tiers, et qui comprend la technologie relative aux polices de caractères, est protégé par un copyright
et licencié par des fourmisseurs de Sun.

LEGENDE RELATIVE AUX DROITS RESTREINTS: l’utilisation, la duplication ou la divulgation par l’administation
americaine sont soumises aux restrictions visées a l’alinéa (c)(1)(ii) de la clause relative aux droits des données techniques et
aux logiciels informatiques du DFAR 252.227- 7013 et FAR 52.227-19.

Le produit décrit dans ce manuel peut être protege par un ou plusieurs brevet(s) americain(s), etranger(s) ou par des
demandes en cours d’enregistrement.

MARQUES
Sun, Sun Microsystems, le logo Sun, SunSoft, le logo SunSoft, Solaris, SunOS, OpenWindows, DeskSet, ONC, ONC+, NFS, et
NEO sont des marques deposées ou enregistrées par Sun Microsystems, Inc. aux Etats-Unis et dans d’autres pays. OpenStep
est une marque enregistrée de NeXT Software, Inc. UNIX est une marque enregistrée aux Etats-Unis et dans d’autres pays,
et exclusivement licenciée par X/Open Company Ltd. OPEN LOOK est une marque enregistrée de Novell, Inc. PostScript et
Display PostScript sont des marques d’Adobe Systems, Inc. Object Design est une marque deposée et le logo Object Design
est une marque enregistrée d’Object Design, Inc.

Toutes les marques SPARC sont des marques deposées ou enregistrées de SPARC International, Inc. aux Etats-Unis et dans
d’autres pays. SPARCcenter, SPARCcluster, SPARCompiler, SPARCdesign, SPARC811, SPARCengine, SPARCprinter,
SPARCserver, SPARCstation, SPARCstorage, SPARCworks, microSPARC, microSPARC-II et UltraSPARC sont exclusivement
licenciées a Sun Microsystems, Inc. Les produits portant les marques sont basés sur une architecture développée par Sun
Microsystems, Inc.

Les utilisateurs d’interfaces graphiques OPEN LOOK® et Sun™ ont été développés par Sun Microsystems, Inc. pour ses
utilisateurs et licenciés. Sun reconnait les efforts de pionniers de Xerox pour la recherche et le développement du concept des
interfaces d’utilisation visuelle ou graphique pour l’industrie de l’informatique. Sun détient une licence non exclusive de
Xerox sur l’interface d’utilisation graphique, cette licence couvrant aussi les licenciés de Sun qui mettent en place OPEN
LOOK GUIs et qui en outre se conforment aux licences écrites de Sun.

Le système X Window est un produit du X Consortium, Inc.

Ce produit incorpore la technologie licencié par Object Design, Inc.

CETTE PUBLICATION EST FOURNIE “EN L’ETAT” SANS GARANTIE D’AUCUNE SORTE, NI EXPRESSE NI IMPLICITE,
Y COMPRIS, ET SANS QUE CETTE LISTE NE SOIT LIMITATIVE, DES GARANTIES CONCERNANT LA VALEUR
MARCHANDE, L’APTITUDE DES PRODUITS A REPONDRE A UNE UTILISATION PARTICULIERE OU LE FAIT QU’ILS
NE SOIENT PAS CONTREFAISANTS DE PRODUITS DE TIERS.



CETTE PUBLICATION PEUT CONTENIR DES MENTIONS TECHNIQUES ERRONEES OU DES ERREURS
TYPOGRAPHIQUES. DES CHANGEMENTS SONT PERIODIQUEMENT APPORTES AUX INFORMATIONS CONTENUES
AUX PRESENTES. CES CHANGEMENTS SERONT INCORPORES AUX NOUVELLES EDITIONS DE LA PUBLICATION.
SUN MICROSYSTEMS INC. PEUT REALISER DES AMELIORATIONS ET/OU DES CHANGEMENTS DANS LE(S)
PRODUIT(S) ET/OU LE(S) PROGRAMME(S) DECRITS DANS DETTE PUBLICATION A TOUS MOMENTS.


